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M A G A Z I N E
SHOPPER

W elcome to the launch issue of Tech Shopper Magazine. In this new publication

from Papercut Ltd, our team of technology experts combine their many, MANY

years of experience to craft the ultimate buyers guide that covers all major formats.    

          In this first issue, we take an in-depth look at all sorts of gadgets and gismos for

your Apple gear. If it’s a head turner, for good or bad reasons and is compatible with a

Windows, Android, Samsung, iPhone, iPad or Mac, we’ve covered it inside. In fact, this

magazine is 100% reviews and previews as we devote the whole magazine to covering

the latest software, add-ons and more. And we haven’t neglected software either. We

cover a wide range of apps and games for all your tech gear.

       In the hardware section, we take a look at some top products including a couple of

AOC monitors, Google’s Chromebook, two indoor security cameras and more. 

        Talking of games, we have some amazing titles this issue. If you feel the need for

speed, there’s Street Kart Racing. For football fans, there’s Sega’s Football Manager

2022, and who doesn’t like Tetris and Minecraft? Look out too for the excellent 

XCOM 2 Collection, and BioShock 2 Remastered and a classic GTA game you 

probably haven’t played, yet!

        These are really exciting times to be a tech user. Our smartphones are going from

strength to strength, our tablets are taking on board all sorts of great desktop features,

and, of course, the desktop/laptop hardware just keeps getting better! So with that in

mind it’s a great time to read Tech Shopper Magazine. Enjoy. 
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Kanex MultiSync Aluminum Keyboard

Kanex, www.kanex.com

Price: £59.95/$59.95/59.95 €

Like Apple’s own desktop keyboards, this one’s made of 

aluminium but unlike Apple keyboards, it can sync with up to 

three Bluetooth devices and switch between them at the touch 

of a button. Just the thing if you want to type comfortably and 

quickly on your tablet, smartphone or desktop. It features a 

rechargeable battery, media keys and a full numeric keyboard. 

As it’s built with Apple devices in mind, all the familiar keys and 

shortcuts are here.

groov-e SportBuds

groov-e, www.groov-e.co.uk

Price: £39.99/$49.99/43,99 €

Do you like to watch videos or listen to music on your tablet while using your cross 

trainer, exercise bike or other such workout equipment? These sporting true 

wireless earbuds from groov-e feature an ear hook design to keep them in place 

while you work out and are rated IPX4 sweat resistant. Their carry case is a 1800 

mAh Power Bank which lets you charge other mobile equipment as well as your 

earbuds. They’re a great price too.
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Evolve2 85 Headphones

Jabra GN, www.jabra.com

Price: £398.45/$449/TBA €

Jabra has an enviable reputation for high-quality 

office-oriented audio products that are also great 

to use at home and the Evolve2 85 is no exception. 

Connecting to your tablet through Bluetooth, 

they’re ideal for video chat and conference 

meetings, as well as listening to your favourite 

music and watching videos. There’s a retractable 

boom mic for chat, a wireless charging mat to 

replenish the battery and a USB dongle for when 

you want to use them with your computer.

tomtoc Holder Case for tablet 

Pencil 

tomtoc, www.tomtoc.com

Price: £13.99/$16.99

Apple Pencil is a great tool, but it isn’t 

cheap. If you have one, you’ll want to keep 

it safe and sound. tomtoc’s Holder Case 

for tablet Pencil is inexpensive and very 

durable. A metal case wrapped in stylish 

fabric, its interior is soft and padded to 

protect your stylus from knocks and 

bumps. It can hold a 1st Generation or 2nd 

Generation Apple Pencil and is compact 

enough to fit in your tablet bag.

Eve Cam

EVE, www.evehome.com

Price: £136/$149.95/142,00 €

Eve Cam indoor camera is great for keeping an eye on your home 

when you’re out. It’s Apple HomeKit compatible, so you can use 

it directly from the Home app, and it benefits from new tabletOS 

14 features such as face recognition, which identifies specific 

individuals in your home, and activity zones, to focus the camera on 

defined areas. When triggered it sends an alert to your tablet, and it 

has a built-in microphone and speaker for two-way communication.

www.pclpublications.com



DJI Mavic Mini Drone

DJI, www.dji.com

Price: £369.95/$399.95/389,86 €

This one’s exclusively for tablet mini 

owners and it’s awesome fun. DJI Mavic 

Mini Drone is compact but powerful 

and can fly for up to 30 minutes on 

a single charge. Its vision sensors 

and GPS Precise Hover makes it 

straightforward to fly and the DJI Fly 

app for your tablet is easy to use too. 

Best of all, its stabilised gimbal camera 

supports 12MP aerial photos and 2.7K 

Quad HD, for some excellent in-flight 

snaps and videos.

HP Tango X Printer

Hewlett Packard, www.hp.com

Price: £219.19/$199.95/194,91 €

HP’s Tango X Printer is perfect for when 

you need to print. It’s Apple AirPrint-

compatible for printing from any of your 

devices, including your tablet  and it’s 

easy to set up with the HP Smart app. 

Plug it in, download the app and it’s up 

and running – no USB connection or 

driver downloads required. It’s great 

for photos, text and images and as 

the wrap-around cover doubles as an 

output tray, its space-saving design is 

ideal for taking on business trips when 

you need to print from the hotel.
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Swann Enforcer Security System

Swann, www.swann.com

Price: £279.99/$299.99/394,23 €

The Enforcer home security system features 

motion-activated, police-style red and blue 

flashing lights, spotlight and siren to deter and 

expose intruders. The 4K Ultra HD recordings and 

powerful Night2Day colour night vision makes sure 

everything’s clear whatever the conditions. It also 

includes True Detect Heat and Motion technology, 

allowing for improved accuracy and fewer false 

alarms. Two cameras are included in this pack and 

you can add two more if you wish (sold separately). 

It works with Alexa and Hey Google and, of course, 

the Swann Security App for your tablet.

FRITZ!Box 7590

AVM, https://en.avm.de

Price: £219, 249,99 € (not sold in USA)

Routers are not all alike and the one your ISP gave you might not be 

the best way to run your home network. This high-end ADSL router 

is the perfect solution to Wi-Fi woes. The FRITZ!Box 7590 is packed 

with features and can even act as a base station for up to six wireless 

landline telephones. As well as Wi-Fi, it has four LAN ports for cabled 

connections and two USB 3.0 ports you can use to network a printer or 

hard drive. Using its FRITZ!OS operating system you can set up parental 

controls and guest access, set up a media server and more. It’s a 

powerful and versatile alternative to your ISP’s router.

LG UltraFine 4K Display

LG Electronics, www.lg.com

Price: £629.00/$699.95/730,12 €

Plug a USB-C or Lightning Display AV Adapter 

or VGA Adapter into the charging port on the 

bottom of tablet and you can connect it to an 

external display, such as the LG UltraFine 4K 

Display. It has a 23.7-inch screen with a 3840-

by-2160 resolution, a P3 wide colour gamut, 

and 500 cd/m2 of brightness. And with over 8 

million pixels, it has four times more than a 

typical 1080p HD display. 
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moshi Otto Q Wireless Charging Pad
URL: https://www.moshi.com

Price: £44.95, $39.95, 44,40 €

If you’re looking for a desktop Qi charger for your smartphone, this one’s 

definitely worth consideration. It’s stylish, robust and it’s been described as 

‘the fastest wireless charger in the world’. It’s compatible with all Qi-enabled 

smartphones, including the iPhones.

Oral-B iO toothbrush
URL: https://io.oralb.com/en-us/

Price: TBA

Just when you thought 

connected gadgets had gone as 

far as they could go, here comes 

this smartphone-compatible 

toothbrush. It uses 3D tracking 

to make sure you cover all your 

gnashers, has a pressure sensor 

to stop you pressing too hard and 

smiles at you when you’ve done 

the job correctly. It should be on 

the shelves in August 2020.

Mezzo Backpack
URL: www.sfbags.com

Price: Mezzo Laptop Backpack: £229, $299, 269,50 €

Complimentary Tech Pocket: £37.50, $49, 44? €

The Mezzo Laptop Backpack is a sophisticated mid-sized 

everyday rucksack built to carry office and leisure gear in 

comfort and style. It’s secured by a self-finding, magnetic 

Fidlock clasp, or a performance-grade paragliding buckle 

(you choose), and there’s an optional tech pouch to hold 

your cables and chargers too.
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ScanWatch
URL: http://www.withings.com

Price: 42mm: £279, $299, 299 €   38mm: £229, $249, 249 €

If you want a smartwatch but don't like Apple's creation, this might better suit 

your needs. According to manufacturer Withings, it's the world's first clinically 

validated hybrid smartwatch to detect both risk of arrhythmia and sleep apnea. 

It looks great and has an impressive 30-day battery life. It will be available later in 

the year.

Paperlike tablet Screen 
Protector
URL: https://paperlike.com

Price: £29, $38, 34 €

This one does more than protect your tablet's 

screen. When drawing on the screen with the Apple 

pencil, it makes it feel more natural and erm – 

paper-like. Its anti-glare finish makes it easier to use 

your tablet in the sunshine too. Just the thing for 

watching Netflix in the garden.

Presidio for AirPods
URL: www.speckproducts.eu

Price: £19.99, $29.95

Presidio Pro for AirPods is a one-piece, protective 

case that’s built to house your headphones and keep 

them with you at all times. Available for both AirPod 

and AirPod Pro, it features an aluminium carabiner 

for secure attachment to belts, bags or purses and is 

compatible with wireless chargers.
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GripTight ONE Micro Stand
https://joby.com

£37.95, $34.95, 39,90 €

Available in black or white, this tiny mobile phone holder 

folds away so small it can fit in that tiny pocket in your jeans 

(that no one knows what it’s for). You snap your iPhone 

in and out using a spring-loaded mount and a machined 

aluminium mini-ball head provides precise angle control. 

It’s great for selfies and timer shots.

GripTight ONE 
Magnetic Impulse
https://joby.com

£55.95, $59.95, 59,90 €

Is this the most versatile tripod 

ever? You can wrap its legs 

around a beam or branch, twist 

it into all sorts of shapes and 

stick it to metal surfaces using 

its magnetic feet. A clamp to 

hold your iPhone is included 

and there’s even a Bluetooth 

trigger to control your shutter 

remotely. It’s one of the best 

tripods available.

Compass Pro
www.twelvesouth.com

£49.99, $59.99, 59.99 €

Compass Pro is a very versatile iPad stand. In its vertical mode, it 

makes a great way of displaying your photo art on your iPad. The 

back leg is adjustable too, so you can set it at the angle you wish. 

Alternatively, set it up in Sketch mode while you work, to keep 

your tablet at a comfortable angle when editing your photos.

Canon PIXMA TS705 Inkjet Printer
www.canon.co.uk

£59.99, 79,00 €

When you’ve created some amazing photo images, you might want to print 

them out. This Canon printer is low cost, Wi-Fi and Ethernet capable and 

has a capacity of 350 sheets. It uses five single ink tanks, so you only have to 

replace the one that’s empty and you can print from your iPhone, using the 

Canon iOS app.

/
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CamKix Wireless Bluetooth Camera 
Shutter Remote Control 
https://camkix.com

£5.79, $7.99 , 7,29 €

This low-cost device has one job and one job only. To remotely 

trigger your iPhone’s camera shutter. You can place your phone 

then stand back and take the photo without being near it. This 

model can trigger iOS and Android devices and comes with a 

handy wrist strap so you don’t lose it.

PowerPic Wireless Charger
www.twelvesouth.com

£79.99, $79.99, 89.99 €

This Qi-charger is more than just a pretty frame. Made from New 

Zealand pine, it’s available in black or white, holds any printed 5x7-

inch photo and even charges your Qi-compatible phone when you 

place it on the picture. It’s a great way of displaying your favourite 

photograph while also providing a useful charging solution.

Zhiyun Smooth 2 Gimbal
www.zhiyun-tech.com

£239, $190, 289 €

There’s nothing worse than wobbly 

video footage or shaky photographs. 

That’s where a gimbal such as the Zhiyun 

Smooth 2 comes in. This three-axis 

device keeps your iPhone steady even if 

you wobble the stick. There’s a Bluetooth 

trigger built into the handle, so you can 

take a photo without actually touching 

your phone.
PencilSnap
www.twelvesouth.com

£24.99, $29.99, 34.99 €

Available in black, or camel brown genuine cowhide, PencilSnap is a neat caddy for 

your iPad pencil. The hidden magnets inside PencilSnap keep it attached to most 

iPad cases, so your Apple Pencil is where you need it, when you need it. Just the thing 

if you like to use an Apple Pencil when you edit your photographs on your iPad.
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I
t’s amazing how far display prices have fallen, 

while their quality continues to rise. Take this 

one, for example. It’s a specialist, quad hi-

definition (QHD) gaming monitor with a giant 31.5-

inch screen. It runs at 165Hz, has a 1ms response 

time and a 300 nits rating, yet it costs well south of 

400 notes. 

The AOC CQ32G2SE Gaming Monitor features a 

tool-free setup. You can get it up and running out 

of the box in five minutes flat, without having to 

root around for the right spanner or screwdriver. 

Just snap the display onto the stand and fit the foot 

using a finger-turned screw. It’s no hassle at all. 

Around the back of the display are two HDMI 

ports and a DisplayPort. There’s no Thunderbolt 

connectivity (though you can use a Thunderbolt 

port with an adapter, of course). There’s no built-in 

USB hub either, but at this price, you wouldn’t 

expect one. 

The monitor is Quad HD, with a pixel resolution 

of 2560 x 1440. That’s an impressive pixel density 

of 94 pixels per inch. The screen is mildly curved, 

so the sides of the viewing area aren’t further away 

from the viewer than the centre. It has six pre-

configured game settings, with presets available 

for first-person shooters, real-time strategy games 

racers and more, though switching between them 

using the under-screen buttons is a little fiddly. Its 

165Hz refresh rate and 1ms response time keeps 

things smooth and accurate, even when your 

game’s moving fast; and at 300 nits, the brightness 

is acceptable if unremarkable.

Naturally, the display is perfect for gaming. Colours 

are rich and vibrant and there’s not a hint of ghosting 

or lag, even when things get intense. If you’re used 

to using a regular display, which might not run your 

games as smoothly, upgrading to a CQ32G2SE really 

does add a new dimension to your gaming.

AOC CQ32G2SE 
Gaming Monitor
Because desktops just want to have fun...

Info//
AOC

https://www.aoc.com

£329, $340, 389 € 

Games look impressively 

rich and detailed on this 

31.5-inch screen.
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The monitor performed admirably in our 

benchmarking tests too. When displaying a series 

of gradients ramps, the colours blended smoothly, 

with very little banding. Text proved clear and 

readable even at the smallest point sizes and 

photographs are beautifully realised. The speakers 

are terrible, but anyone sufficiently into video 

games to buy a gaming monitor really ought to use 

external speakers too. It’s also great for watching 

movies and web videos but the large screen and 

high resolution are very unforgiving to shoddy 

footage.

Overall, the CQ32G2SE is an excellent gaming 

monitor that also serves you very well as a general 

display. If you want to take your gaming to the next 

level without hampering your general, day-to-day 

desktop use, it’s well worth a look. IO

Verdict//
PROS AND CONS:

+ Easy to put together

+ Vivid colours

+ Fast refresh rate

- Fiddly controls

LAST WORD

A very competent monitor 

at an excellent price. 

Definitely recommended.

RATING: 4/5

It’s curved, so the whole 

screen is the same distance 

from the viewer.
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T
his wireless charger powers three of your Apple devices at once. The vertical stand on 

the left holds – and charges – your Apple Watch. The charger is built-in. You don’t have 

to use the one that came with your watch like you do with some charging stands, so 

you can keep that for travel. In front of it is a recessed area where you place your AirPods (2nd 

gen or Pro). On the right of the unit is a regular wireless charger for your smartphone, as long 

as it’s wireless-charging compatible. Three chargers in one. Unfortunately, there’s no USB port 

around the back for cabled charging.

The charger is available in both black and white. The black 

model has a premium Ultrasuede fabric finish, while 

the white one boasts a glass surface. It delivers just the 

right amount of power to charge each device, up to 7.5W 

in total and it supports fast charging. It can charge your 

smartphone through cases up to 3mm thick and as it’s an all 

in one device, it only needs one plug socket. It’s just the thing 

for your bedside table. DA

Verdict//
PROS AND CONS:

+ Charges three Apple 

devices

+ Fast charging

+ Great build quality

- Relatively large footprint

LAST WORD

Solid, robust and attractive, 

this is a great companion for 

your mobile Apple devices.

RATING: 4/5

Mophie 3-in-1 
Wireless Charging Stand
Do you use three separate chargers for three different Apple devices? Then this is for you...

Info//
mophie

www.zagg.com

£129.99, $139.95, 59,00 € 

If you own all three Apple devices, 

a 3-in-1 charger is a must.
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U
nlike most of AVM’s range of wireless routers, 

the FRITZ!Box 4060 lacks a built-in modem. 

This means regardless of how your network 

interacts with the Internet, you can use the 4060 by 

connecting it to your existing modem, which was 

probably supplied by your ISP. Whatever your type 

of Internet connection (be it ADSL, fibre, cable or 

mobile data), even if your Internet Service Provider 

forces you to use their own modem hardware, you 

can switch off the router section of your ISP-supplied 

device and connect the FRITZ!Box 4060 instead. But 

what advantages does this bring?

As you’d expect, the router’s wireless capabilities 

include compatibility with the new Wi-Fi 6 protocol, 

which gives faster speeds, and is much better at 

dealing with multiple, simultaneous connections. If 

you’re working on your home office Mac, while the 

kids are on their phones, Netflix is streaming in the 

living room and multiple devices are playing Spotify 

or Apple Music, Wi-Fi 6 is definitely worth having.

Super speeds
The FRITZ!Box 4060 is tri-band-capable, meaning 

it can operate on the 2.4GHz band and also two 

5GHz bands. This further boosts its capabilities 

with multiple connections, as well as allowing 

speeds of up to 2400 Mbit/s on the 5GHz channels, 

and 1200 Mbit/s on the 2.4GHz band. As well as 

wireless connectivity, the device has three gigabit 

LAN ports for cabled Ethernet connections, 

offering rock-solid 1000 Mbit/s speeds, and a 2.5 

gigabit WAN port for connection to wide area 

networks. There’s a USB 3.0 port, so you can 

plug in a storage drive or a printer to make that 

device available over your network. It’s also DECT-

capable, so you can connect up to six wireless 

phones; and it has an integrated answer machine 

and fax facility.

So who would benefit from a FRITZ!Box 4060? 

Without a doubt, many people would be better 

off with one of AVM’s routers with integrated 

modems, but those who are forced to use their 

ISP-supplied hardware will benefit from this 

feature-packed, high-performance router. IO

Verdict//
PROS AND CONS:

+ Wi-Fi 6 compatible

+ Tri-band

+ Great DECT features

- No modem

LAST WORD

An excellent option for 

those who have no choice 

but to use their ISP’s 

equipment. Switch off the 

router and use a FRITZ!Box 

4060 instead.

RATING: 4/5

Info//
AVM

www.avm.de

£TBA, 259 € (not sold in USA)

The FRITZ!Box 4060 has three LAN 

ports, a WAN port and a USB port for 

networking USB peripherals.

FRITZ!Box 4060 
Internet router
Tied to your ISP’s hardware? There’s a better router solution.
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I
f you’re serious about your gaming, you have 

to get a decent controller. A joypad that feels 

comfortable in the hands, with all its buttons 

and inputs within easy reach. Something with a 

full range of controls, including four face buttons, 

a D-pad, two analogue sticks and twin shoulder 

buttons; a now-standard setup as used by recent 

Xbox and PlayStation consoles. A joypad like the 

GameSir G4 Pro. 

You can connect your G4 Pro to a Windows PC 

using a dongle that fits in the back of the joypad 

when not in use or via the USB-C charging cable 

supplied. Unfortunately, it’s not Mac-compatible 

and nor can it be used with an Apple TV set-top box. 

You can use it with your smartphone or tablet over 

Bluetooth and even with a Nintendo Switch (but 

not the Xbox or PlayStation). For smartphone users, 

there’s an optional fold-out stand so you can let 

your phone sit on top of the joypad.

The face buttons are held in place magnetically, 

so you can lift them off and swap them around if 

your game platform uses a different configuration 

to the default one offered. There’s a Turbo button 

for fast attacks and a Screenshots button if you 

want to grab a game screen. Make sure you boot it 

in the correct mode when you switch it on though; if 

you pair it as a Bluetooth controller instead of using 

its MFi mode, for example, you’re likely to get very 

frustrated with MFi-compatible titles.

The G4 Pro feels just right in the hands. It’s 

weighty enough to feel solid but not so heavy it 

becomes difficult to hold straight after a few hours’ 

GameSir G4 Pro 
Gaming Controller
Is this the gaming gadget you’ve been waiting for?

GameSir

www.gamesir.hk

£49.98, $49.99, 49,99 € 

The face buttons can be 

rearranged to match a 

game’s layout.
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gaming. There’s no noticeable lag. When battling 

through an old-school shooter like R-Type or the 

Raiden titles, your craft follows your inputs precisely 

and the fire button keeps up with your attacks 

impeccably. Switch to a driver such as Street Kart 

Racer or Asphalt 8 and the extra sensitivity offered 

by the analogue stick and trigger buttons come to 

the fore; and are equally responsive and lag-free.

The best game controllers are the ones you 

forget you’re holding during the game, leaving all 

your attention focused on what’s happening on-

screen. The GameSir G4 Pro certainly achieves this 

lofty goal. We just wish it worked with the whole of 

Apple’s range. IO

PROS AND CONS:

+ Feels great in the hands

+ Excellent feature set

+ Very responsive

- Not Mac or Apple TV 

compatible

LAST WORD

An excellent joypad for 

smartphones, tablets and 

Apple Arcade. Comfortable,

responsive and robust.

RATING: 4/5

You can mount your 

smartphone in the GameSir 

G4 Pro’s in-built stand.
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Y
ou can’t fault the price. For less than 60 

notes, the Kami Indoor 360 Smart-Home 

Camera offers 340° rotation and 90° tilt, dual 

band wi-fi, two-way audio, night vision and 1080p 

high definition recording. It’s not at the expense 

of quality either. It’s robust and stylish, with an 

understated profile that sits discreetly wherever 

you wish to position it; and its recordings are sharp 

and smooth. It has to be used indoors, of course. 

The camera is not weatherproof or waterproof, so 

it cannot be set up outside. It has to be reasonably 

close to a plug socket too. A long USB lead is 

supplied so you can power it from the mains plug 

provided or a computer’s USB port but there’s no 

battery option. 

The Kami Indoor 360 Smart-Home Camera is 

easy enough to set up. Using a mobile phone, you 

simply download the Kami Home app and follow 

the instructions to set up an account and get the 

camera onto your wi-fi network. There’s an app for 

Macs and PCs too but for the initial setup, you have 

to use a mobile app. It’s compatible with Amazon 

Alexa and Google Assistant but unfortunately, not 

Apple HomeKit.

When you’re up and running, you can control 

your camera directly from your smartphone or 

Mac. It can be rotated, raised or lowered via a 

virtual joystick controller. There’s a mic and speaker 

for two-way voice communication and you can 

record video footage at the tap of a button. Toggle 

between Home and Away settings depending 

on whether or not you’re in. Away Mode lets you 

receive alerts when motion is detected. You can 

activate motion tracking to keep tabs on a moving 

Kami Indoor 360 
Smart-Home Camera
I spy, with my rotating eye...

Info//
YI Technology

https://kamihome.com

£54.99, $59, 59 €
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target, use infra-red light for night vision and set it to ‘auto cruise’, so it scans back and 

forth keeping an eye on a wide area of coverage. These are all high-end features you 

wouldn’t normally get from a camera of this price. 

Unfortunately, cloud storage for recorded footage is a little more expensive than 

some of its rivals. You get a year for free and after that there’s a range of paid-for options 

available. If you don’t subscribe, you get free six-second clips which are stored for 24 

hours, which might be enough if it’s mainly the alerts you’re after. Unfortunately, there’s 

no means of recording to local storage like an SD card.

The Kami Indoor 360 Smart-Home Camera is excellent value for money and is 

packed with features more usually associated with higher-end security cameras. Just 

make sure the cloud-subscription – or lack of one – suits your needs before you buy. 

AF

Verdict//
PROS AND CONS:

+ Excellent features

+ Great value for money

- Not HomeKit compatible 

- No SD Card support

LAST WORD

A quality product that’s 

excellent value for money 

but make sure there’s a 

cloud subscription to suit 

your needs first.

RATING: 4/5

You can operate the camera 

from your smartphone.

Its minimalist, discrete 

design looks good in 

any room.
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Verdict//
PROS AND CONS:

+ Well built

- Overpriced 

- Cable not included

- A little pointless

LAST WORD

Well constructed but 

arguably pointless. There 

are better ways to spend 

your money.

RATING: 2/5

TimePorter 
for Apple Watch
A useful carry case or an expensive paperweight?

Info//
Twelve South

http://twelvesouth.com

£44.99, $49.99, 41.62 € 

T
welve South has a reputation for making 

excellent Apple peripherals that are both useful 

and decorative. Unfortunately, TimePorter is 

not such a device.

An accessory travel case and charging stand for your 

Apple Watch, TimePorter is the same size and shape as 

a spectacle case but with a hole on the top for you to fit 

your watch’s charging cable. You have to supply your 

own – there’s no Apple Watch cable in the box. So what 

you’re left with is a metal case with space for your spare 

watch bands and a rubber interior frame for wrapping 

your charger.

Is this enough to justify the price? Not really. You 

could just as easily keep your cable and watch straps in 

a real spectacle case (who doesn’t have a spare?) and 

stand your charging watch on your bedside table. A rare 

misfire for Twelve South. 

IO

The plug, charging cable and 

watch straps are not included.

You can use TimePorter 

as a watch stand for when 

it’s charging.
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Verdict//
PROS AND CONS:

+ Looks great

+ Very robust

+ Good range of styles

- Expensive

LAST WORD

This is a notebook bag that’s 

built to last. Stylish and 

robust, it will appeal to those 

who appreciate quality.

RATING: 4/5

Zoom Crossbody 
Laptop Bag
The comfortable way to carry your notebook.

W
aterField Designs makes deluxe bags for 

connoisseurs. They’re not cheap, but the 

quality is outstanding. You could use a 

WaterField bag every day of your working life, then 

give it to your grandchild and it would still be in 

good condition.

This particular WaterField Designs product, the 

Zoom Crossbody Laptop Bag, is available in two sizes. 

The Compact version fits devices up to 11 x 8 inches, 

and is ideal for your tablet Pro and a Magic Keyboard. 

The Tall version can handle notebooks up to 12.75 x 

8.75 inches such as Apple’s 13-inch range, including the 

new M1-powered MacBook Pros.

It’s available in a range of colours, and sports a 

comfortable shoulder strap that holds your Apple 

gear in a portrait position. The main body of the bag is 

made from waxed canvas, ballistic nylon, or red or blue 

forza, with all versions trimmed with black or chocolate 

leather. Zips are sturdy and robust, the protected area 

will keep your gear safe and sound, and the detachable 

strap is solidly padded so it won’t hurt your shoulder. 

The usual pockets for various nick-knacks are there, 

including a document pocket on the back for easy 

access. It also has a through-strap so you can slide it 

over your suitcase handle when travelling. All in all, it’s 

an excellent notebook bag. AH

The Zoom Crossbody comes in an impressive range of styles.

Info//
WaterField Designs

www.sfbags.com

Compact: £154, $209, 170.7 €

Tall: £168.79, $229, 187.13 € 
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Razer Kishi 
Universal Gaming Controller 
A better way to blast the baddies...

Info//
Razer Inc.

www.razer.com

£99.99, $99.99, 109.99€

Y
our brand-new smartphone might well be the pinnacle of 

mobile phone gaming but is your controller up to speed? Do 

you even have a controller? If not, this amazing, pocket-sized 

add-on could be just what you’re looking for. 

The Kishi folds down when not in use for easy storage and 

portability. When opened up it stretches out to accommodate 

smartphones of all sizes. A Lightning connector plugs into your 

phone and a through-port lets you plug in your Lightning cable and 

charge while you play. There’s no need to cut your gaming short 

because your smartphone’s battery is almost drained. There’s a free 

app too but this is just for firmware updates and information; there’s 

no heavy setting up to do.

Its comprehensive control set will prove familiar to anyone that’s 

used a modern console such as an Xbox or PlayStation. There’s two 

clickable analogue joysticks (left and right), augmented by an eight-way 

D-pad and four face buttons. Atop the device are four shoulder buttons, 

two on each side.  

Out of the box, the Kishi is a great snug fit for the Max/Plus-sized 

smartphones. If you own a regular-sized model, just swap out the rubber 

grips with the other set provided. It holds your smartphone tightly, with the 

phone and the controller feeling like they belong together. If you use your 

phone in a case, you’ll probably have to remove it before you fit the Kishi but 

this is inevitable.

When you’re ready to start gaming, the Kishi is plug-and-play for 
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games that benefit from buttons and joysticks, 

though you might have to tap the screen to choose 

options. It’s fully compatible with Apple Arcade too, 

so subscribers can really take their smartphone 

gaming to the next level.

Using a Lightning connection rather than relying 

on wireless Bluetooth connectivity means there’s no 

noticeable lag. Button response is instant, giving your 

games a fluid, natural feel. It feels good in the hands 

too, with all the controls easy to reach and intuitively 

Verdict//
PROS AND CONS:

+ Sturdy and well built

+ No latency; lag-free 

action

+ Apple Arcade compatible

- Have to remove your 

smartphone’s case

LAST WORD

Sturdy, comfortable and 

almost latency-free, this 

takes smartphone gaming

to the next level.

RATING: 5/5

It folds neatly away 

when not in use.

As it uses a Lightning 

connection instead 

of Bluetooth, latency 

is negligible.

placed. Many devices have claimed to turn your 

smartphone into a handheld console but the Kishi 

actually achieves it. After a minute or two on the Kishi, 

you’re forgetting you’re playing iOS games; it’s like 

you’re using the handheld Xbox Microsoft never made.

If you’re serious about smartphone gaming, a 

decent controller is a must and this one puts in 

a top-drawer performance. With cross-platform 

gaming on the rise, the Kishi lets you pick up 

your smartphone and battle it out with computer 

users without being at a massive disadvantage. 
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I
f you’re lucky enough to have a FRITZ!Box router 

with DECT compatibility, you can connect up to six 

wireless phones and position them anywhere in 

the house. They connect to the phone line through 

your router, so they don’t need to be plugged into a 

telephone socket. FRITZ!Fon C6 is such a phone and 

it’s had an impressive makeover.

The body of the phone is pleasingly ergonomic 

and although it’s pretty minimalist in design, a 

clever interface makes it easy to access its unique 

features such as Internet radio, answer machine, 

email, podcasts, RSS feeds and even a baby monitor. 

If you have more than one FRITZ!Fon in the house, 

you can make internal calls between them. The new 

C6 model has an excellent hi-res colour screen and 

you can customise the display for when it’s not in 

use too. It has a long battery life, though as it sits in 

its charging cradle when idle, this is rarely an issue 

anyway. High-definition sound makes for crystal 

clear calls and there’s a headphones socket for when 

you want to listen to your podcasts or online radio.

We’ve only scratched the surface of what the 

FRITZ!Fon C6 can do here. Advanced users might 

want to configure it through the router to only react 

to certain numbers, for example, or use different 

telephone books stored within the router. It’s an 

excellent device and a must for DECT-compatible 

FRITZ!Box users. IO

Verdict//
PROS AND CONS:

+ Ergonomic design

+ Great colour screen

+ Feature packed

+ High-definition sound

LAST WORD

A great phone that’s packed 

with features. Top banana!

RATING: 5/5

FRITZ!Fon C6 
Phone system
Wireless landline telephony for the 21st Century.

Info//
AVM Computersysteme 

Vertriebs GmbH

https://en.avm.de

£81.07, 79 € (not sold in USA) 

FRITZ!Fon C6 has some great features; 

it’s not just a pretty screen.
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PROS AND CONS:

+ Well made

+ Attractive

+ Good fit for Mac mini

- Not cheap

LAST WORD

A neat way to save space on 

your desk and reduce neck 

ache when looking at your 

screen.

RATING: 4/5

Twelve South Curve Riser 
Mac or Screen Riser
Is your computer screen giving you neck ache? This could be just what you need.

R
isers for your computer or monitor aren’t 

exactly thin on the ground but as you’d 

expect, this model from Twelve South goes 

that extra yard with careful planning and design. 

As well as raising your iMac or external display to a 

more comfortable height, it features a handy space 

underneath for all your bits and pieces. The shelf, 

which is perforated for airflow, is the perfect size and 

shape for a Mac mini too. If you use Apple’s small form 

factor Mac with a monitor, Curve Riser is the ideal way 

to keep them tidy on your desk; saving space.

The Curve Riser’s 

shelf is the perfect 

size for a Mac mini.

Alternatively, use it for a USB optical drive, 

Thunderbolt hub, audio interface or just about anything 

else you can think of. The space underneath the riser 

is a good fit for the smaller Apple keyboard, when you 

want to push it out of the way and use your desk for 

something else; although if you have a keyboard with a 

numerical keypad, it’s too long.

Well made and strong., at 25.5cm wide and 24.5cm 

deep, it’s the perfect size to seat most monitors (and of 

course the iMac), and its shelf capacity is 25.5 x 24.5 x 

4.45cm. It’s the ideal desktop space saver. AF

Give your iMac 

a lift and bring 

it to a more 

comfortable 

height.

Info//
Twelve South

www.twelvesouth.com

£79.99, $79.99, 89.99 €
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I
f you remember the review we did of the devolo 

Magic 2 Wi-Fi Starter Kit back in Issue 2, you 

know that powerline adapters are a great way 

of extending the reach of your cabled and wireless 

network using your house's electrical wiring. A 

powerline setup consists of at least two plugs, 

which fit in your household mains sockets. By 

connecting one of them to your router using a 

supplied Ethernet cable and plugging the other into 

any mains socket in the house, you create a cabled 

connection between your router and the second 

adapter. This unit can offer a wireless access 

point for your network, Ethernet ports for cabled 

connectivity, or both.

devolo’s Magic 2 LAN Triple powerline adapter 

starter set doesn’t offer Wi-Fi access, but it does have 

three Ethernet ports built into the second plug. Meaning 

you can connect your desktop computer, games 

console, networked printer, NAS drive or any device 

with Ethernet connectivity, giving you a fast, reliable 

data connection with your router. The Magic 2 adapters 

are super-speedy. Based on the latest G.hn protocol, 

they can reach speeds of up to 2,400mbps, which is 

twice as fast as was possible with the older HomePlug 

AV standard. It’s an excellent option for 4K video 

streaming or lag-free online gaming. It’s secure too, 

with 128-bit AES (Advanced Encryption Standard), and 

the latest WPA3 protocols. There’s no chance of your 

neighbours jumping onto your network through your 

powerline adapters. You can add more adapters to your 

powerline setup if you wish too. So, if you need one in 

the kid’s bedroom, one in the attic and one in the living 

room, buy individual units to go with the starter-kit 

setup you already have. You can also add a Wi-Fi access 

point powerline adapter in this way.

But the best thing about using powerline adapters 

to extend your network is it's easy, very easy. While all 

this information might sound very techie (and indeed 

it is), devolo powerline adapters are really simple to set 

up and use. Just follow the instructions, and you're up 

and running in five minutes or so, and once installed, 

they just work.

If you’re having trouble getting your home network 

to reach distant parts of your house, powerline adapters 

are a great solution and there’s none better than 

devolo’s Magic 2. Highly recommended. IO

Verdict//
PROS AND CONS:

+ Three Ethernet ports

+ Fast data speeds

+ Through-ports for plugs

- No Wi-Fi access point

LAST WORD

An excellent solution to 

home network problems.

RATING: 4/5

devolo Magic 2 
LAN Triple
Superpower your home network.

Info//
devolo AG

https://www.devolo.co.uk

£139,99, 139.90 € (not 

available in the USA)
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SWANN Alert
Indoor Security Camera
What price peace of mind?

A
lert Indoor Security Camera is an affordable way 

to keep an eye on your home, but it doesn't lack 

in smart features. After connecting the camera to 

your Wi-Fi network and pairing it with the SWANN Security 

app on your smartphone or tablet, you can view and 

capture high-quality video in 1080p full HD. It has a passive 

infrared sensor that can detect movement at up to 32 

feet, and it can also detect loud noises and heat too. The 

camera then sends a push notification to your phone and 

starts video recording. You get free cloud storage, which 

saves clips for seven days, and they're also stored locally 

for two days. A full 110-degree viewing angle decreases 

blind spots, and there's a mic and speaker built-in for two-

way talk between your camera and your mobile device. 

It's compatible with various smart devices, but not Apple 

Home.

Its small size and extreme versatility means the Alert 

Indoor Security Camera is capable of far more than 

guarding your home against break-ins. Its heat detector 

lets you know if there's a fire, and with sound detection and 

two-way chat, it's an excellent baby monitor. Unassuming 

in appearance, it assimilates well in any room. It's a great 

all-round camera for all-round protection. IO

Info//
Swann

www.swann.com

£79.99, $89.99, TBC € 

Verdict// 
PROS AND CONS:

+ 1080p full HD video

+ Movement, noise and 

heat sensors 

+ Two-way talk 

- Not HomeKit-compatible

LAST WORD

A very versatile home 

protection device at a very 

good price.

RATING: 4/5

Somfy Indoor Camera
Keep an eye on things when you’re out.

T
his home security camera is a different beast from the 

SWANN model covered elsewhere on the page. It lacks 

heat and noise detection, but it can detect motion 

at up to 16 feet. When it does so, it records 30 seconds of 

footage and uploads them to the cloud or your Dropbox 

account. It has a 130-degree angle-view and a fixed focus 

from between just under two feet to infinity. You can watch 

live too, of course, and, unusually for a security monitor, 

there's a privacy shutter you can activate when you don't 

want the camera to record you. Video quality is excellent and 

it works well both night and day. It's designed to stand on a 

flat surface. If you want to wall-mount it, you have to buy a 

separate bracket.

It's easy to set up, using the Somfy Protect app. You can ring an 

emergency number directly from the app, but for some reason, 

it doesn't think the UK's 999 is valid. It works with several smart 

home hubs, and unlike the SWANN, is HomeKit-compatible.

Overall, Somfy Indoor Camera puts in a solid performance, 

but if you’re looking for a quality security option, there are more 

versatile cameras around at this price point. BC

Verdict//
PROS AND CONS:

+ HomeKit compatible

+ Privacy shutter 

- Expensive 

- No wall-mounting options

LAST WORD

Great video quality, but 

there are better security 

camera options for the 

money

RATING: 3/5

Info//
Somfy 

https://www.somfy.com

£139, 169 € 
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DxO PhotoLab 4
Dig our your tired old photos, they’re about to get better!

Info//
DxO Labs

www.dxo.com

Essential Edition: £112, 

$129, 129 € 

Elite Edition: £169, $199, 

199, €

H
ere at AppleUser, we’re big fans of DxO 

Labs’ PhotoLab image editing software. 

A high-end image editing suite, it’s aimed 

firmly at the high-needs user; photography 

professionals and very keen amateurs. It’s not 

for the casual snapper but those who are serious 

about photography will find it a comprehensive and 

feature-packed suite that really brings out the best 

in your photographic art.

This, the fourth version, introduces some great 

new features. The most significant is DeepPRIME, 

an artificial intelligence technology that learns 

from the millions of photos DxO’s laboratories 

have analysed over the last 15 years. This learning 

is used to better process photographs taken in the 

RAW format with regards to digital noise reduction 

and demosaicing (yes, that is a word). As a result, 

images look more natural. It’s especially useful 

when using digital zoom, snapping in low light 

conditions or when the photo was taken on an 

older camera with fewer megapixels than modern 

devices. Dig out your old family snaps from the 

late Nineties and early 21st Century and DxO 

PhotoLab 4 can really bring them to life.

Another new feature is Smart Workspace, 

which lets you personalise your working area 

to best suit your needs. You can display or 

hide tools, so you only see the ones you want 

to use. If the need arises, you can quickly and 

easily access a hidden tool; just look it up and it 

reappears instantly.

There are some minor additional features and 

improvements too. A batch renaming function 

has been added, so you can change the titles of 

a series of photos with one click. Another new 

feature, DxO Advanced History, lets you group 

edits and adjustments made to your photo and 

show or hide them as needed. It’s an excellent 

means of getting the most from a picture you’re 

editing heavily. If you’re working on more than one 

The new DxO Advanced History feature lets you group 

adjustments and display or hide corrections as required.
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Verdict//
PROS AND CONS:

+ Great new features

+ Pro-level performance

+ Good upgrade path

- Takes time to master

LAST WORD

A powerful and capable 

application that gets 

better with every release.

RATING: 5/5

picture at a time, edits made to one photograph 

can be synced to others, which is great if you took 

several snaps in similar conditions. You can add a 

watermark to your pics and check how it will look 

in preview too.

DxO PhotoLab 4 is as straightforward to use as it 

can be. The interface is intuitive and well set out and 

it’s customisable to suit your specific needs. That’s 

not to say it’s easy. A pro-level app like this is bound 

to have a learning curve. The less demanding user 

can set the app to use automatic enhancements 

and then tweak them manually, with the more 

demanding opting for optical corrections only; or if 

you’re really expert, no automatic adjustments at all. 

Naturally, features from earlier versions of DxO 

PhotoLabs are carried over, such as automatic 

image repair, local adjustments and the excellent 

colour wheel introduced with PhotoLabs 3. 

Overall, it’s an amazing application but definitely 

for serious photo editors only.

If you already own a previous release of DxO 

PhotoLab, upgrade discounts are available. IO The DxO ClearView Plus feature lets you bring out the beauty in your nature shots. with a single click.

Add a watermark to your image, and check the results immediately using DxO Instant Watermarking.

BEFORE AFTER
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Info//
Ngoc Luu

https://goodlinks.app

£4.99, $4.99, 5,49 € 

(Universal Purchase, 

unlocks Mac and  

mobile versions)

U
niversal Purchases are awesome. Rolled out 

earlier this year, the feature lets developers 

bundle iOS, tabletOS and macOS versions 

of an app into a single purchase. Instead of having 

to pay once on the Mac App Store and again on the 

Mobile App Store, a single payment unlocks the 

software on all your Apple devices. GoodLinks is a 

read-later app that syncs your links across all your 

Apple gear and being a Universal Purchase isn’t the 

only thing it gets right.

Using GoodLinks is very straightforward. When 

surfing the web in Safari or a third-party browser, 

you might come across an article you’d like to 

save for later perusal. Sure, you can bookmark it 

or add it to Safari’s Read Later list but GoodLinks 

gives a more comprehensive and flexible option. 

By tapping the browser’s Share icon and choosing 

GoodLinks, you save it in the GoodLinks app. 

Articles you’ve saved in this way are synced 

between your Macs and mobile devices using 

iCloud, so you can save a link on one device and 

pick it up on another.

Reading your saved pages is equally 

straightforward. Launch the app, and tap/click it to 

open it within the GoodLinks app. Here it’s displayed 

in a reader view, with unnecessary graphics and 

typography removed for easy reading; though you 

can open it in your default browser instead if you 

wish. The reader view doesn’t play media files such 

as videos or sound, so you need to open these in 

your browser. If your link is from a popular media site 

like YouTube or Vimeo, this is automatic.

As a reader, GoodLinks is very configurable. You 

can use the app in Light or Dark Mode, or match 

the system’s theme. On the mobile versions of the 

app, a sepia background is available for those who 

find it more comfortable than a white screen. For 

the reader, you can change the font, the text size 

and more. Saved links can be starred as favourites, 

manually marked as read or unread and tagged 

to group articles of a similar nature. Naturally, you 

can edit the URL or title before you save. Best of 

all, thanks to a clever and very Apple-like interface, 

all these functions are at your fingertips. 

GoodLinks 
for Mac, tablet and iPhone
Read-later applications as they’re meant to be done.

You can share 

saved links 

directly from 

the app.
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Verdict//
PROS AND CONS:

+ Clear, intuitive interface

+ Syncs between devices

+ Great reader view

- A couple of missing 

features

LAST WORD

A comprehensive, 

configurable and easy to

use app that’s excellent 

value for money. Highly 

recommended.

RATING: 5/5

There’s a couple of things we’d like to see in 

future releases. We wish you could manually add 

folders and drag-and-drop saved links into them 

and as the Mac app only syncs on launch, it could 

use a manual refresh button too. But as folders are 

likely to be added at a future date and a refresh 

button is already planned, we’re not going to 

deduct marks from this excellent app. IO

GoodLinks’ reader view is very comfortable on the eyes.

Customise the reader view by changing the font or adjusting 

text size, borders, tracking and more.

www.pclpublications.com



Info//
Cultured Code GmbH  

& Co. KG

https://culturedcode.com

Mac: £48.99, $49.99, 54,99 € 

ablet: £19.99, $19.99, 21,99 € 

iPhone: £9.99, $9.99, 10,99 € 

M
ultiple award-winning Things is widely 

regarded as the best task management app 

for Apple devices. Those with power-user 

needs might prefer OmniFocus but for the vast 

majority of us, ease of use and a clear, Apple-like 

interface make Things the ‘getting things done’ 

(GTD) app of choice. But what makes it so good?

Things is designed to help you organise every 

aspect of your life, from daily routines to long-term 

goals. When you first launch Things, there’s a tutorial 

project you can keep or delete. If you’re new to the 

app, it’s best to work your way through it; in ten 

minutes, you’ll have a decent understanding of how 

it all works and how to get the most from the app. 

You can then delete it when you’re done and add 

some projects and tasks of your own. These can 

include projects, which can have their own individual 

to-dos and checklists. A project can be divided into 

sections using headers and your projects list can be 

similarly organised in the sidebar. You can add due 

dates and deadlines, so entries appear in your Today 

section and there’s an Inbox section for items you 

want to keep to hand. You can also add tags, like 

those used in macOS, so you can display your to-dos 

according to how you’ve tagged them.

Clever interface design is apparent throughout. 

For example, on the iPhone and tablet, you add 

projects and to-dos by tapping a big button marked 

‘+’. So far, so obvious. But instead of simply tapping 

it, you can drag it to where it’s needed, dropping it on 

the Inbox icon for a quick note or into your Projects 

list to open a new one in a place of your choosing. 

If you have a project open, you can similarly drag 

and place a new to-do and when looking at the 

Upcoming calendar list, drop it on the day you want 

to set as its deadline.

The Things application is very well integrated 

with macOS, iOS and tabletOS. You can link Things 

3 with Calendar and have your events show up in 

the Things app. You can also sync the Reminders 

app with your Things Inbox. It’s great for keeping 

everything in one place. If you have Things 3 on more 

than one device, you can keep your data in sync 

using the free Things Cloud service. Even if you only 

use the app on one device, it’s still a good idea to set 

up a Things Cloud account as a useful backup.

Things 3 keeps your life in order and puts everything at your fingertips.

Things 3
Is this the best getting-things-done app for Apple devices?
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Verdict//
PROS AND CONS:

+ Fantastic interface

+ Integrates with OS

+ Sync across devices

- Expensive

LAST WORD

A great app for organising 

your life and getting things 

done.

RATING: 5/5

Although it has been criticised in the past for 

infrequent updates, Things 3 does not similarly 

suffer. It’s done a great job of keeping up with the 

latest macOS, iOS and tabletOS have to offer. For 

example, you can set a Things widget on your 

mobile screen or Mac Today screen, giving quick 

and easy access to your inbox, a project of your 

choice or a tag. There’s a Dark Mode for those who 

prefer a darker screen and also a Black option 

if you like things very dark. If you’ve an Apple 

Pencil, the tablet’s brand new Scribble feature 

is catered for and the Apple Watch app has new 

complications; Today lets you see your next three 

to-dos and with New To-Do you can add a new 

one directly from your watch.

When it comes to task management software 

Apple fans are spoiled for choice but we reckon 

Things 3 is the best. Great integration with OS 

apps, comprehensive features and an easy-to-use 

interface make it a joy to use. Our only concern is 

the price, which is a little steep if you want to use it 

on all three Apple devices. IO

You can organise your projects into areas, such as Work and Family, as shown here.

Organise your to-dos by date and import Calendar events too.
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B
ack in the day, you could gather your snaps 

in the Photos app, design a calendar, a book, 

greetings cards and more; and order them in 

print directly from Apple. You can’t do this any more 

but several third-party services have stepped in to fill 

the gap. Motif is one such service.

Using the free Motif app for your Mac, iPhone or 

tablet, you can use your photos to create exciting 

books and calendars directly from your Apple device. 

On a Mac you can also create and order greetings 

cards but this feature has yet to make it to the mobile 

apps. Your pictures are curated automatically so your 

favourite memories and pictures are easily to hand; 

and it’s easy to make impressive, professional-looking 

designs. There are ready-made templates and themes 

to help you along too. When you’ve finished, you can 

order a book or calendar directly from the app.

When these services and goods could be obtained 

directly from Apple, it was Motif’s parent company, RR 

Donnelley, that handled the printing and fulfilment. 

Motif uses the same facilities, presses, materials, 

and processes today; as you’d expect, the quality 

is very high. The apps for Mac and mobile devices 

are high quality too. On the Mac, it functions as a 

native extension to the photos app, so no exports, 

transfers or uploads are required. On mobile devices, 

it curates your pictures from Photos, starting with your 

favourites and recent memories.

The design process is straightforward, with some 

decent pre-built templates, though the layout and 

customisation tools aren’t as comprehensive as 

Apple’s. You can’t rotate a picture box, for example, 

or have photos overlap on the page. I became fed up 

of having a toolset appear right on top of my pointer 

when I clicked on the page too.

That said, the service and print quality is excellent. 

If Motif can polish the desktop publishing side if 

things a little more, it will be a must-

have app. AF

Verdict//
PROS AND CONS:

+ Easy to use

+ Curates your photos

+ Quality products

- Greetings cards are Mac-

only

LAST WORD

A great print service but the 

desktop publishing side of 

things needs improvement.

RATING: 3/5

Motif Photobook 
& Album Maker
Worth a thousand words?

You can add special effects to your 

photos if you wish.

Motif calendars look amazing. You can even get birthdays and 

events printed.

You can add events and photos to your calendar. It’s great 

for birthdays.

Info//
RR Donnelley

www.motifphotos.com

App is free, prints are paid for
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E
ver come across a video on YouTube and wished 

you could download it for offline viewing, or cut 

it to DVD and watch it on your living-room TV? 

Of course you have. Everybody has. With Airy, you can 

do just that. It's easy to use. Simply navigate to the 

YouTube video you want to download, then copy and 

paste the URL into the field in the Airy app, choose 

a resolution and click Download. You can download 

videos as MP4, FLV, and 3GP, with HD, 4K and 8K Ultra 

HD resolutions supported, or go for MP3 to download 

only the audio. Airy can also be integrated into most 

popular web browsers, such as Safari, Chrome, 

Firefox, Opera and Explorer too, to download directly 

from your bookmarks bar. If you've a lot to download, 

you can queue them by adding one link after another 

without waiting for the first download to finish, and 

you can even download entire playlists in one click.

There are other YouTube downloaders available, 

but sheer versatility and ease of use makes Airy one 

of the best. Definitely recommended for online video 

fans. IO

J
ustStream is an excellent alternative to AirPlay. 

It can stream video from your Mac to any 

AirPlay or Chromecast compatible device, as 

well as smart TVs from Samsung and LG, Roku boxes, 

Apple TV and Sony devices. It's great for viewing 

slideshows of photos with the family, for example, 

and as it can mirror your Mac's screen to the 

television, it's good for presentations and demos too, 

as well as playing movies and videos. You can queue 

videos and play them in sequence, no need to keep 

running to your computer room to load the next 

five-minute holiday movie. Subtitles are supported, 

and the entire app runs from a menu bar icon and is 

never in the way while you're streaming.

It's very straightforward to use. Click on the 

JustStream menulet, and compatible destinations 

are automatically detected and listed. Choose the 

one you want, add some video files and you're off. 

Non-native video formats are transcoded on the 

fly, which can take a minute or two if they're large. 

Our only complaint is that the maximum output 

resolution is 1080p HD; no 4K option here. AF

Download YouTube videos the easy way.

Stream video from your Mac to any TV in the house.

Info//
Eltima Software

https://www.airy-youtube-

downloader.com

(One Mac) £15.20, $19.95, 

17,95 € 

Info//
Eltima Software

https://www.eltima.com

£18.23, $23.94, 17,99 € 

Verdict//
PROS AND CONS:

+ Straightforward to use

+ Versatile downloads

+ Browser integration

- A little expensive?

LAST WORD

A versatile and competent 

tool that does exactly what 

it sets out to do.

RATING: 4/5

PROS AND CONS:

+ Stream to a variety of 

destinations

+ Good for demos and 

training

+ Queue a series of flicks

- Can’t do 4K

LAST WORD

An excellent streaming 

solution, especially if your 

main TV is in a different 

room to your Mac.

RATING: 4/5
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N
ow here's a useful app to have on your 

phone. It can translate typed text into and 

out of 103 languages, as long as you've got 

an Internet connection. If you're offline, it can still 

translate 59 languages. If your typing finger is getting 

tired, you can simply point your smartphone's 

camera at a piece of text and translate it between 

90 languages, or 50 languages at a higher quality if 

you use a photo. It can handle 95 languages using 

handwriting recognition and translate conversations 

in 43 languages. You can save translated words and 

phrases for future reference too. Naturally, it caters 

for all widely spoken European languages.

It's a real boon for travellers. Not only can it 

make communication easier, if you're confused 

by signage or instructions, just point your camera 

at it and read it in your own language. It's easy to 

use, and to keep the app a decent size, it works 

online but allows you to download language 

packs for offline use. It's completely free too, with 

no in-app purchases. BC

S
pam emails are the bane of everyone’s life. You 

know the sort of thing. Get rich quick schemes, 

we-know-your-password blackmail threats and 

some we won’t even describe. If you use email, you get 

spam. It’s as simple as that.

Cleanfox is a free tool that helps you clean up your 

inbox and unsubscribe from mailing lists you no longer 

wish to receive. Pick out a rogue email, and with one 

click, you can get rid of it and all those like it. You no 

longer have to trawl through your mailboxes and delete 

the messages one at a time. It's easy to use. Just swipe 

an email right to keep it, up to delete it and left to delete 

and unsubscribe. It covers all the popular web-based 

email services such as iCloud, Gmail, Hotmail, Yahoo, 

Orange and so on, but some ISPs aren't covered.

The Cleanfox team claim that each stored email 

you delete saves 10g of CO2 per year, and for each 

friend who installs and uses the app based on your 

recommendation, they plant a tree in Zambia. You can 

clean up the planet as well as your inbox. AF

Können Sie dies lesen? Que dis-tu de ça? Get translating!

Spam email? Let the fox at it...

Info//
Google LLC

https://get.google.com

Free

Info//
FOXINTEL

https://www.cleanfox.io

Free 

Verdict//
PROS AND CONS:

+ Massive range of

languages

+ Easy to use 

+ It’s free! 

- Some services online only

LAST WORD

A versatile and 

comprehensive app that 

won't cost you a bean. 

Excellent for travellers and 

holidaymakers.

RATING: 5/5

Verdict//
PROS AND CONS:

+ Helps reduce spam

+ Easy to use 

+ It’s free

- Doesn’t cover all email 

services

LAST WORD

It doesn't cover every email 

service, but if you use one of 

the many that are included, 

it's well worth a look.

RATING: 4/5
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Info//
Six to Start

zombiesrungame.com

Free

Compatibility: iOS 13.0 or Later

I
t’s always nice to come across an app that does 

something a little bit differently, or takes an 

existing idea and puts its own unique spin on it. 

Especially considering that everyone is talking about 

Netflix’s new undead action romp, Army of the Dead. 

Zombies, Run! does exactly that, and it helps you to 

get fit as well. It’s part adventure game, part fitness 

app and part interactive story. The concept might 

sound a little strange at first but it makes perfect 

sense when you start using it, so you just have to 

trust us that it works.

Zombies, Run! is an app designed to help people 

who want to run, but lack the motivation to actually 

get out there and do it. The incentive in this case is to 

turn the whole thing into a kind of interactive game. 

Based on GPS data, the app sets a run route for you. 

All you need to do is plug in your headphones, hit 

Start and off you go. 

During your run you’re regularly updated with 

news of a zombie outbreak. You need to follow a 

certain route to collect items. Every so often you’re 

alerted that the zombie horde is after you. That’s 

when you have to break into a sprint; a bit like in a 

spinning class when you do bursts at top speed. If 

you don’t go fast enough, the zombies catch you 

up and take some of the virtual ‘stuff’ that you’ve 

collected. This is important as it’s used when 

you complete your run to build a virtual zombie-

sanctuary in the app. The ultimate goal is to build up 

your sanctuary and get as many people as possible 

to join it. Each run is a different ‘mission’ with slightly 

different goals that need to be accomplished.

It’s a really cool and original way to make running a 

bit more interesting. The subscription price is very high 

for an app of this type, but if you’re willing to shell out 

the necessary cash, you’ll have a blast with it. JG

Verdict//
PROS AND CONS:

+ Inventive way to get 

outside

+ Professional production 

values

+ Easy to engage with

- Rather expensive 

LAST WORD

What better motivation could 

you have to keep moving, 

than to avoid a plague of the 

marauding undead? 

RATING: 4/5

Run off that lockdown weight and become the new special on the zombie menu!
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Life is Strange 2
The line between video games and movies is further blurred.

Info//
Feral Interactive

www.feralinteractive.com

£32.45, $39,95, 39,95 € 

I
f you've played the original Life is Strange, 

you'll be instantly at home with this sequel. 

The game mechanic hasn't changed; it's still a 

narrative-driven graphic adventure with the story 

interrupted – and guided – by regular multiple-

choice options. These choices define the path the 

storyline takes and directly affect how it plays out. 

Like the first game, it's episodic, with the story split 

into five, self-contained chapters. However, this 

Mac version bundles all five together; we don't have 

to keep waiting for the next one to be released, 

as did console and PC gamers when it came out 

on those formats. It features a protagonist with a 

supernatural ability too.

But for all its similarities, there's plenty that's 

new here too. The title no longer centres on 

college girl Max(ine) Caulfield. Instead, you control 

the brothers Sean and Daniel Diaz, as they deal 

with a personal tragedy when their father is killed, 

and they're forced to go on the run from the law. 

The small-town setting of the original is scrapped 

in favour of a forced road trip as the brothers make 

their escape, and Max's ability to reverse time 

gives way to Daniel's telekinetic powers - moving 

objects with his mind. This comes in very useful 

as you make your way south and is frequently 

essential as you tackle the puzzles and pitfalls that 

abound in this well realised graphic adventure.

But one thing that stands out in the new game 

as well as being the key strength of the first, and 

its prequel, Beyond the Storm, is the superb 

characterisation and settings; you really get to 

know the Diaz brothers and become genuinely 

invested in their fates. Set against the backdrop 

of the 2016 American election, it covers issues 

such as racism and morality with sensitivity and 

intelligence and, though the overall storyline is 

more complex than the previous games, it loses 

none of its depth. IO

Verdict//
PROS AND CONS:

+ Great characterisation 

and plot

+ Easy to get into

+ Looks amazing

- We miss Max Caulfield

LAST WORD

A beautifully realised 

game wherein the twin 

protagonists do more 

than provide an avatar 

for the player. Definitely 

recommended.

RATING: 5/5
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W
hat a lousy start to the day. You wake up 

in a strange apartment, stark naked and 

covered in blood with a wound to your 

ribs and a dead body in the bathtub. You have no 

idea where you are or how you got there. What are 

you to do?

Unmemory, the first game from a small team in 

Barcelona, offers a great new take on the text and 

graphic adventure. There’s a lot of reading to do but 

don’t let that put you off. The story is well written 

and engaging; and really draws you into the strange 

world of the protagonist. Every few paragraphs, the 

text is interrupted by a graphic of something nearby. 

You can frequently interact with these graphics, 

sometimes immediately, sometimes later in the 

story after another clue is revealed. Scroll back up 

and try again. The game is arranged in eight bite-

sized but substantial chapters, so you never have to 

scroll too far to find the object you passed earlier but 

need now.

A game you can read or a novel you can play?

Info//
Plug In Digital

https://unmemory.info

£5.99, $5.99, 6,99 € 

Verdict//
PROS AND CONS:

+ Very original

+ Engaging plot

+ Exciting and fun

- Puzzles just a little 

contrived 

LAST WORD

A great new take on the 

adventure genre that will

appeal to those who like 

their gaming cerebral.

RATING: 4/5Well written text is interrupted by interactive graphics. Can you find a clue?

An early puzzle involves finding the 

combination to a locked briefcase.

Naturally, there are puzzles to solve. How do you 

get into the briefcase with the combination lock? 

How do you open the safe? What’s the significance 

of the painting on the wall or the copy of Alice in 

Wonderland with certain letters circled? And that’s 

just the first chapter. Listen out for audio cues too, 

like the TV in the next room, someone knocking 

on the door or the telephone ringing. Because of 

the importance of these audio cues and the need 

for spotting clues, the game is best played with 

headphones on and a notebook in your hand but 

the choice is yours.

Maybe the puzzles are just a little contrived, in 

that they’re clearly deliberately set up to be solved 

rather than happened upon in the real world. As 

a result, the game feels more like a digital escape 

room than a real-life detective case. Not that this is 

a problem; it doesn’t make the game any less fun. 

It’s exciting, original and a great way to spend a few 

hours on your tablet or smartphone. IO
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Street Kart Racing
Race at 80mph, just an inch above the asphalt. 

Info//
Fat Cigar Productions Ltd

www.streetkart.me

$1.99, £1.99, 2.29 €,  

with IAP

T
his is more than just a racing game. It’s an 

entire online community. Three years in the 

making, the multiplayer-focused Street Kart 

Racing lets you race with other kart drivers from 

60 different countries and keep up with the latest 

goings-on in a very well populated Facebook group 

dedicated to the game. Just the thing if you’re 

a competitive racer who likes going up against 

human beings rather than AI drivers. That’s not to 

say you can’t race computer-controlled opponents, 

though. You build your career by racing them in 

Cadet Karts.

It’s not for the faint-hearted. Street Kart Racing 

is a serious simulation game designed with the 

help of professional kart racers to be as realistic 

as possible. Don’t expect to drop bananas on the 

track or fling turtle shells at your opponents here. 

Instead, you’re in for no-assists, no-excuses real-

time tournaments on recreations of genuine tracks. 

Battle your opponents in week-long tournaments, 

earning promotion or suffering relegation 

depending on your performance. 

To get the most from your kart you can set it up 

to suit your driving style, as well as optimising its 

performance for twisty or straight tracks, wet or dry 

conditions and hot or cold weather. Apart from this 

setup, the karts are identical; same engines, same 

equipment, same chances of winning. You won’t 

get lapped by a mediocre driver who’s spent a real-

world fortune on buying the best bits and pieces for 

his vehicle, like you do in some games.

That’s not to say there are no in-app purchases. 

You can buy ‘Aces’, an in-game currency which can 

also be won in tournaments or earned by watching 

advertising videos. You can use it to unlock items 

and generally speed up the game but they’re far 

from essential and can’t be used to give you an 

unfair advantage in races.

On the starting 

grid. Ready,  

steady, GO!
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Verdict//
PROS AND CONS:

+ Excellent driving physics

+ A very social game

+ True to life

- Confusing price structure

LAST WORD

Seat-of-your-pants driving 

on mobile devices doesn’t 

get any better than this. 

Ideal for those who like 

realism in their racing.

RATING: 4/5

Race against opponents from all over the world.

In-game weather conditions are real-time, 

based on the weather at the real-world course. If 

it’s raining at Adria, for example, it’s also raining at 

Adria in the game. Do you wait for the rain to stop 

or set a time now in case the rain gets worse?

Regarding the game as its played, as long as 

you use a recent tablet or smartphone the graphics 

are pretty good but not on a par with Forza or Gran 

Turismo. At this price, you wouldn’t expect them to 

be. Where the game really shines is in the driving 

physics. Pair up a decent joypad as a controller and 

you really feel you’re in control of an 80mph kart; 

and sitting just an inch above the track. 

Our only real complaint is it’s impossible to use 

the same account on more than one device, so you 

can’t (for example) play at home on your tablet 

and use your smartphone on the train. Apart from 

that, the game’s a must-buy for fans of real-world 

multiplayer racing.  AH
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The First Tree
Can you out-fox this curious walking sim?

Info//
David Wehle

http://www.thefirsttree.com

£4.99, $4.99, 5,49 € 

T
he First Tree had an unusual inspiration. 

Its developer, David Wehle, used it as a 

‘creative outlet’ to deal with his becoming 

a father for the first time; and also losing his own 

dad. So naturally, family ties play a large part 

in this third-party exploration game. It centres 

around two parallel stories; a fox (the playable 

character) trying to find her missing family, and 

through narration, a son reconnecting with his 

estranged father in Alaska. Along the way, you 

uncover artefacts and stories from the son's life 

as he becomes intertwined in the fox’s journey 

towards The First Tree.

Graphics are simple but enchanting, giving a 

real sense of being there when combined with the 

melancholy music. As you run through the snow-

kissed plains of Alaska, a beautiful fern forest and 

more, you gather stars liberally scattered through 

each level. You must also keep an eye out for 

patches of freshly dug earth that conceal items 

from the estranged son’s childhood. Dig them 

up for wistful commentary from the boy himself, 

now grown up and conversing with his wife as he 

recalls his early life with his father and how they 

grew increasingly apart. 

Unfortunately, the game’s excellent 

atmosphere isn’t matched by the gameplay. 

There’s simply too much traipsing around looking 

for something to do and not enough to engage 

the player. There are no enemies to fight, no 

environment hazards, no puzzles to solve and no 

secrets to uncover (the digging sites are clearly 

signposted). There’s a little platforming to be done 

but it’s very basic and unimaginative.

The First Tree is short (a couple of hours, a little 

more if you want to grab every star) but that’s a 

blessing rather than a limitation. It has a lot of 

heart and soul but not much gameplay and so is 

unfortunaltely boring. AH

Verdict//
PROS AND CONS:

+ Atmospheric

+ Good music

- Too little to do 

- Clunky mechanics

LAST WORD

Atmospheric aesthetics do 

not make up for the lack of 

gameplay. It just isn’t fun.

RATING: 2/5

Switch to Commentary Mode for 

regular observations from the author.Dig, fox. You might find something 

belonging to the boy.

Controls are a virtual joystick and 

a jump button. They work well.
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Elements is a photo editor and organiser that gives you the
control to find, catalogue, edit and share your favourite
images effortlessly.

It is very likely that in this digital age, the number of photos you have on
your computer is vast. It is very easy to take photos and deposit them
on your computer and never look at them again. It is also likely that you
have photos that you really like but that might be underexposed, badly
lit; or could be improved if you were able to remove an annoying 
background distraction. You may even want to cut your subject out, put
it into another scene entirely and create a new look for an image.

If you've ever wanted to do more with your photo collection but didn't
need the advanced power of Adobe Photoshop CC, then Elements is for
you. Now, thanks to Adobe Photoshop Elements, you have an easy and
affordable means to find all those elusive images, organise them and
manipulate your favourite ones to make them even better. It is easier
than ever to quickly and easily make your images look amazing with
just a few clicks of your mouse. From automated and guided edits to
hands-on expert modes, you can create exactly what you want. The
only thing holding you back is your imagination. Get started with
Photoshop Elements and let us show you how

www.pclpublications.com
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If you are new to Photoshop Elements, cataloguing your 
photos and digitally manipulating them may seem like 
a whole new world you have to conquer. Do not worry 
though, we will guide you through the basics and get 
you started on your way to becoming a skilled user of 
the software. We hope to have you importing, tagging, 
organising and editing your photos like a pro in no time 
at all. With that in mind, let's begin the journey and get 
you more familiar with how it all works. 
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STARTING WITH PHOTOSHOP ELEMENTS

Adobe Photoshop Elements is a 
great option for those who want 
an extensive toolset that can take 

on most of their image editing needs, 
without the requirement of highly 
advanced features such as you would 
find in Photoshop CC. It is also a great 
choice for those who only need one-
click solutions to their image editing 
needs, or perhaps want to start to 
learn how to take on the more involved 
techniques and tools that Elements has 
to offer. Another big plus point in its 
favour is that it is one of the very few 
remaining Adobe products that can be 
purchased outright, without the need 
for subscription. 

A Worthy Alternative
There was a time when, in certain 
quarters, Elements was considered a 
dumbed-down version of Photoshop 
with a limited toolset, that was 
only meant for beginners with no 
aspirations to advance to the more 
technically advanced techniques seen 
in Photoshop. However, recent versions 
of Elements have shown that it is a 
worthy standalone alternative to using 
Photoshop. It is a focused image editor 
and cataloging application that is more 
than capable of taking on any image 
editing task you care to send its way.

In its current form, Adobe Photoshop 
Elements is comprised of two main 
components. One is the image editing 
module of the software where you 
can touch up your photos or even 
manipulate and transform them beyond 
recognition. The Edit section is broken 
down into three sections. The first is 
the Quick Edit mode, then comes the 
Guided Mode section and finally there is 
the Expert mode.

Make the Most of Modules
Each module has its own set of tools 
and preset options that can quickly get 
the job done. Quick Edit, as the name 
suggests, contains the basic editing 

What is Photoshop 
Elements?
Let's take a moment to get to know a little more about the software 
and how it can help you with your day to day image editing.
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WHAT IS PHOTOSHOP ELEMENTS?

tools such as colour correction, cropping, 
quick selection, spot healing, sharpening and 
lighting fixes. You can also apply some one-
click presets such as Smart Fix, Exposure  
and Lighting. 

Helping Hand
The Guided module is also fairly self-
explanatory. Here you can make any number 
of popular image adjustments to your 
photos, with guided step-by-step tutorials, 
such as altering brightness and contrast, 
resizing photos, rotating and straightening 
your images and adding vignettes. It also 
has a number of specialised and fun options 
for restoring old photos, creating your own 
frames and replacing backgrounds. 

More Advanced Options
Finally comes the Expert mode. This has 
more of the feel of its big brother, Photoshop 
to it. It has a toolbar ranged down the left 
hand side of the workspace and on the right 
is the layers panel that behaves much in the 
same way as Photoshop's layers palette. Here 
you also have access to a number of photo 
colour presets such as Faded Photo, Glow 
and Monotone Color. There are also a number 
of filters for more artistic effects such as 
coloured pencils, watercolours, distortion 
effects and sketch filters. You can also add 
Bevels, Patterns, Strokes, Photographic 
Effects and much more by accessing the 
icons in the lower right of the taskbar at the 
bottom of your workspace. Expert mode 
is the most hands-on of the three modes 
you can employ and gives you access to 
all the tools, so you can apply all your own 
advanced edits to your photos.

Getting Organised
The second main component of the latest 
Adobe Photoshop Elements is the Elements 
2019 Organiser. At its heart, this is a 
cataloguing and photo organising program 
that lets you import, sort, tag and rate your 
photos. If you wish, you can create albums 
and use names, locations, date, time and GPS 
data to sort them. The program can even 
employ face recognition to find and sort 
photos of people and tag them much as you 
would in Facebook. Indeed, you can actually 
import your list of Facebook friends as an 
aid to tagging the people in your photos. If 

it detects a similar name being entered 
as a tag, it will display those existing 
names similar enough as a match to be 
an option for tagging.

The two components of Photoshop 
Elements and Elements Organiser 
are separate programs, which can be 
a bit of nuisance if you need to keep 
switching between them but you have 
at your disposal a set of powerful 

editing tools that will keep beginner and 
expert happy.

Over the page we'll begin to delve 
deeper into the workspaces offered by 
the Editor and Elements Organiser. It is 
best to consider the Editor module as your 
digital darkroom and design studio and to 
think of Elements Organiser as your library, 
where you keep all your media items such 
as photos and videos.

The Adobe Photoshop Elements and Organiser interfaces are 
designed to be as intuitive as possible with plenty of options 
for beginners and experienced users alike.
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Search Option
From the home page you can can search 
for things you need to learn more about. 
If you want to learn how to make a 
calendar for instance, type that in the 
search bar and it will show you links to 
help files that can tell you more.

Featured Guides
Ranged along the top of the home page 
are a number of clickable guides and 
inspirational media that gets you into the 
heart of what Photoshop Elements 2019 
is all about. There are several themes 
you can access. Try This are guided 
tutorials that help you create exciting 
media and art. What's New highlights all 
the step-by-step features that are new 
to this version. Inspiration is a collection 
of stories and articles to get you in a 
creative mood.

1

2

3

The Elements 
Home Screen
We start the journey by becoming more familiar with all the module 
environments you will be working with.

1

STARTING WITH PHOTOSHOP ELEMENTS

Welcome Home
When you open Adobe Photoshop 
Elements 2019, you are presented with a 
Home screen. This simple screen is your 
gateway to the Photo Editor program or 
the Organiser. The third option available 
is to activate the Adobe Premiere 
Elements Video Editor, if you have 
purchased that as well. If not, it will ask 
if you want to download a trial version.

You also have the option at the 
top of the Home screen to search for 
help on things you want to achieve in 
the programs or to click on any of the 
featured Try This guides and What's New 
items and Inspiration articles ranged 
across the screen.

On the extreme top right of the page 
are buttons for Facebook and Twitter 
and a Help button that takes you to 
Adobe Customer Support.

2

4
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For those who are in need of more guidance, or just 
some creative inspiration, go ahead and click on any of 
the featured guides and articles to explore more of the 
online world of features Adobe Photoshop Elements has 
to offer.

Explore the Guides

THE ELEMENTS HOME SCREEN

Auto Creations
When you open the home page for the 
first time, you will be prompted to add 
media for Auto Creations to make a 
series of personalised creations, such as 
slide shows that use your own photos 
and videos.

Add Media
Auto Creations are created with media 
(photos or videos) that you've imported. 
If you haven't imported any media yet, 
click Add media under Auto Creations on 
the Home screen and relaunch the app. 
You can open and edit any Auto Creation 
and instantly share it with your family 
and friends. 

Program Chooser
To the right of the home page are the 
icons for Organiser, Photo Editor and 
Video Editor. You can click on these to 
activate the relevant program. If you do 
not have the Adobe Premiere Elements 
video editor program for instance, it will 
ask you if you want to try if for free with 
the option to purchase later if you wish.

Recent Files
Any images you have been working on 
recently will be displayed here for quick 
access. Click on the image you want 
to continue working on and it will be 
opened within the relevant program.

Facebook Button
Click this button to go to the Adobe 
Photoshop Elements Facebook page.

Twitter Button
When you click this button, it will take 
you to the Photoshop Elements Twitter 
feed where you can view, reply to, 
retweet and like tweets.

Help Button
If you need further assistance, you can 
click this button to be directed to the 
Adobe Customer Support webpage.
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The File Menu
Although a number of file menu option 
will not be accessible, the main ones 
that you need will be available. All the 
Enhance options are there as well as the 
Filter Gallery presets.

Mode Selector
Here can you can exit the current mode 
and choose to enter the Guided or 
Expert modes.

The Open Button
This is a simple button to specify a new 
project to work on. Click it to create a 
new document at the size you want. 
When you click OK, the document will be 
created and can be worked on in either 
Quick mode or Expert mode.

The Toolbar
The Quick mode toolbar has a core set 
of tools to get your image looking great 
with minimal effort. You can make quick 
selections to specific areas of the photo, 
crop it, straighten the horizon, whiten 
teeth and fix eyes as well as adding text 
and a number of varied filters, textures 
and adjustments.

1

2

6

7

8

The Quick
Mode Workspace
For fast and simple edits, this is the mode to get you editing
quickly, with one-click results for better photos.

3
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One-click Power
Although this mode is designed to 
be quick and simple to use, it is still a 
powerful method to rapidly improve 
your photos with easy one-click  
presets that give you instant feedback 
on how your image will look with the 
new adjustments applied. There are 
many filters to choose from and many 
ways you can adjust your image to  
make it perfect, so you can share it  
with the world.

4

2

1

3

5
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4

Don't forget to check out the Create and Share 
options. Whether you want to share your creation 
online and on social media or make prints of your 
photos or even calendars, click the buttons to 
explore further.

Create and Share

THE QUICK MODE WORKSPACE

The Tool Options Bar
For every tool you activate in the toolbar, 
you have another panel called the Tool 
Options bar that gives you many more 
choices as to how that tool can be 
modified and controlled. There are also 
additional tools that can be accessed in 
the Tool Options bar.

The Taskbar
The taskbar is situated at the bottom 
of the workspace and contains all the 
most frequently used actions, which are 
displayed as buttons. Click each one 
and you can see all the images you are 
working on at that time, display or hide 
the Toolbar Options bar and Undo or 

redo any steps you have performed on 
your image. You also have the option 
to rotate the image and activate the 
Elements Organiser if you need to.

View Options
Clicking on this button reveals the View 
options. This is useful if you want to 
compare a before and after view of your 
currently active image, to see how much 
the image has changed from its original 
untouched state.

Active Image Area
The image you are working on is 
displayed in this area. It will either be as 
a single image or, if you have chosen a 

different view option, as two images that 
represent the before and after state of 
the photo.

Zoom Slider
This slider lets you quickly zoom your 
image from 1% all the way up to 3200%.

Create and Share
These two dropdown menus display 
options for creating slide shows, photo 
books, greetings cards, calendars, 
Facebook Covers and much more. You 
can also share your works of art on 
Facebook, Flickr and Twitter.

The Panel Bar
This panel changes content depending 
on what adjustment or effect you are 
using. If you are using the Adjustment 
tools, then they will be displayed in 
the right hand panel bar. Items such as 
Smart Fix, Exposure, Lighting and Colour 
will be available here and each can be 
clicked to reveal its available options. The 
Effects menu, Textures and Frames are 
also available to be accessed here.
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Black & White
This section has a number of effects 
centred around monochrome. Black and 
White, B&W Colour Pop, B&W Selection, 
High Key, Line Drawing and Low Key.

Fun Edits
You can find a lot more creative edits 
under this category. You have some 
diverse effects to try out such as Double 
Exposure, Effects Collage, Meme Maker, 
Multi-photo Text, Old Fashioned Photo, 
Out of Bounds, Painterly, Partial Sketch, 
Photo Text, Picture Stack, Pop Art, 
Puzzle Effect, Reflection, Shape Overlay 
Effect, Speed Effect, Speed Pan and 
Zoom Burst Effect.

Category Selector
Here can you can select which effect you 
want to apply to your image. There are 
six categories of effects to choose from. 

Basics
Contains the Basic effects Brightness 
and Contrast, Correct Skin Tone, Crop 
Photo, Levels, Lighten and Darken, Resize 
Your Photo, Rotate and Straighten, 
Sharpen and Vignette Effect.

Colour
This category contains Enhance Colour, 
Lomo Camera Effect, Remove Colour 
Cast and Saturated Film Effect.

1

The Guided
Mode Workspace
This mode is great for accomplishing a variety of effects, with 
a handy guide for each one you use.

3
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Special Edits
More specialised image manipulation 
effects are kept in this section of the 
Guided edit workspace. It contains 
Replace Background, Depth Of 
Field, Frame Creator, Orton Effect, 
Perfect Portrait, Recompose, Replace 
Background, Restore Old Photo, 
Scratches And Blemishes, Text 
and Border Overlay, Tilt-shift and 
Watercolour Effect.

Photomerge
The Photomerge section mainly 
concentrates on blending two or more 
photos or extracting and merging 
subjects from one shot into another. 
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THE GUIDED MODE WORKSPACE

There's Photomerge Compose, 
Photomerge Exposure, Photomerge 
Faces, Photomerge Group Shot, 
Photomerge Scene Cleaner and 
Photomerge Panorama.

Open
If you choose to select a new image from 
the Open menu during a guided edit, you 
will be asked if you want to discard the 
current guide, in order to start a new one 
with the image you are about to open.

Zoom Tool
Click the Zoom Tool icon or press Z to 
activate the zoom tool. You can magnify 
the image up to 3200%. Wherever you 
click with the mouse, the image will be 
magnified and the point you clicked will 
be placed in the centre of the workspace. 
Press the Alt key on your keyboard to 
decrease the magnification factor.

Hand Tool
Click the Hand Tool icon or press H to 
be able to move your magnified image 
around. With the Hand Tool active, click 
and drag your photo to move it around 
within the active image area.

View Options
Clicking on this button reveals the View 
options. This is useful if you want to 
compare a before and after view of your 
currently active image, to see how much 
the image has changed.

Photo Bin view
Where appropriate, this menu button 
displays options on how to view 
any currently active images that are 
contained in your Photo Bin.

The Taskbar
The taskbar is situated at the bottom of 
the workspace and contains all the most 
frequently used actions.

Active Image Area
This is where the image you are working 
on will be displayed.

Zoom Slider
This slider lets you quickly zoom your 
image from 1% all the way up to 3200%.

Guided Steps Panel
Whichever effect you choose to apply 
to your image, the steps required to 
complete it are displayed as numbered 
steps in the guidance panel on the 
right of the active image area. You can 
follow the steps, clicking the appropriate 
buttons and altering parameters until 
you are ready to commit the changes.

Next and Cancel
Click Next to commit the changes of the 
guided edit you have just applied or click 
Cancel to cancel the edit entirely and 
begin again.

Save
Once you have clicked Next, you can 
choose to save your image or save it 
under a new name and/or image format. 
You can also elect to continue working 
on the image in either Expert or Quick 
mode. You can also choose Share to 
upload it to Facebook, Twitter or Flickr.

Done
Simply returns you to the Guided 
category page. If you look in your 
Photo Bin, your image will have a small 
brush icon in its top right corner, which 
indicates it has edits applied. If you close 
the image and haven't saved it, you will 
be prompted to do so if you wish.
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The File Menu
Most of the File menu options will be 
made available to you in this particular 
workspace, since all the tools and 
effects parameters are there to be used 
manually with little or no guidance from 
the program.

The Open Button
Common to each workspace, click on 
the Open button to view any recently 
active images you have been working on 
or to create a new blank file ready to be 
worked on. 

The Tools Panel
This panel contains all the essential tools 
you are going to need for powerful and 
flexible image editing. It is broken down 
into View, Enhance, Draw, Modify and 
Colour sections.

Document Tab
Each image that is open will be marked 
by a document tab to identify each 
image. It will display the filename of the 
photos currently open.

Active Image Window
This displays the current image you are 
working on.

Document Info
You can choose what information about 
your active document is displayed here. 

Tool Options Panel
This panel is context sensitive and 
displays additional options and controls 
for each tool that you select from the 
tool panel.

1
2

4

6

7

The Expert
Mode Workspace
For those who have developed their skills to the point where they 
are comfortable getting more hands-on with their images.
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When you click on any of the Layers, Effects, 
Filters Styles and Graphics buttons, the main 
panel on the right of the screen will display the 
corresponding panel for each one you choose. Our 
example is currently displaying the Layers Panel.

Panels

Photo Bin
The Photo Bin panel displays thumbnails 
of all open photos currently being used 
by the program.

Undo/Redo
Clicking the Undo button allows you to 
step back through any actions you have 
performed on your image. Redo allows 
you to step forward.

10 Rotate Tools
Allows you to rotate your image in 45° 
steps either clockwise or anticlockwise.

Layout
If you have a number of documents 
open at one time, you can choose from a 
number of layout options to display them 
all at once within your active image area. 

Switch to Organiser
Clicking on this button will open up the 
Elements Organiser program where you 
can view and select images that you 
have imported and catalogued.

Home Screen
Click this button if you want to return to 
the Home screen.

Layers
One of the key aspects of more 
advanced image editing is to be able to 
work across multiple layers within your 
active document. 

Effects
This will display all the effects options 
currently installed. They range from 
rubber stamp effects to pencil sketch 
effects and colour tints, which can all be 
applied to your photos.

Filters
Ranging from artistic effects to brush 
strokes and distortion and pixelation 
options, clicking the Effects icon will 
display all the creative effects available 
to be applied to the image. 

Styles
There are a number of colour, texture 
and special effects that can be applied 
to any subject that is currently on a layer. 
They range from fibreglass textures to 
fire, chrome, bevelled edges and tints.

Graphics
These are background graphics that can 
be downloaded and used as backdrops 
in your compositions. 

More
A pop up menu where you can open 
more currently hidden panels.

Layer Options
This panel allows you to add new layers, 
group selected layers, adjustment layers 
and masks. 

Layers Panel
This is where layers are viewed and 
consists of the base background layer 
and any subsequent layer copies, brand 
new layers or layer adjustments.

Layer Properties
For each layer adjustment you add, you 
have the corresponding properties panel 
to control its effect.
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The Expert 
Mode Toolbar
All the main editing tools you need in Expert mode are accessible 
from the toolbar on the left of the workspace.

If you've used older versions of Elements 
or Photoshop, the main components 
of the toolbar will be familiar to you. 

There have been updates and additions 
to the tools available but most will be 
recognisable for what they are and you 
should be able to get to grips with the 
newest ones without too much issue. 
Although each tool has additional options 
displayed down in the Tools Options 
Panel, if you hold the Alt key and click on 
a toolbar icon, you can cycle though all 
variants of that particular tool to get to 
the one you want. Here is a breakdown of 
the toolset available in Adobe Photoshop 
Elements 2019.

When you click on any of the Layers, Effects, 
Filters, Styles and Graphics buttons, the main 
panel on the right of the screen will display 
the corresponding panel for each one you 
choose. Our example is currently displaying 
the Layers Panel.

The Tool Options bar

The Tool Options bar 
appears at the bottom of the 
Photoshop Elements window 
and it displays the options for 
any selected tool in Expert and 
Quick mode

1  Active Tool

The currently active tool is 
highlighted.

2  Related Tools

Any related tools associated 
with the main tool, selected 
from the toolbar, will be 
displayed here.

3  Additional Options

For any tool that you have 
selected and have active, there 
are a number of additional 
options that let you control 
various parameters relating to 
that particular tool.

1 2
3
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View Tools
The tools found in the View Tools section 
of the toolbar are designed for basic 
magnification: zooming in and out of 
your photo and moving it around the 
screen to view a portion of the zoomed 
image at your chosen magnification.

1 Zoom (Z)
2 Hand (H)

Select Tools
This section covers all the tools that 
allow you to select all or parts of your 
image for targeted editing, cutting out or 
duplication to new layers.

3 Move (V)
4 Rectangular Marquee (V)
5 Elliptical Marquee (V)
6 Lasso (L)
7 Polygon Lasso (L)
8 Magnetic Lasso (L)
9 Quick Selection (A)
10 Selection Brush (A)
11 Magic Wand (A)
12 Refined Selection (A)
13 Auto Selection (A)

Enhance Tools
The set of tools found in this section of 
the toolbar are for enhancing the image. 
You can heal, clone, blur, sharpen and 

use targeted contrast effects on your 
photos and much more.

14 Eye (Y)
15 Spot Healing Brush (J)
16 Healing Brush (J)
17 Smart Brush (F)
18 Detailed Smart Brush (F)
19 Clone Stamp (S)
20 Pattern Stamp (S)
21 Blur (R)
22 Sharpen (R)
23 Smudge (R)
24 Sponge (R)
25 Dodge (R)
26 Burn (R)

Draw Tools
The Draw section of the toolbar contains 
various elements that let you paint, draw, 
erase and sample colours in your photos. 
The text tools are also in this section.

27 Brush (B)
28 Impressionist Brush (B)
29 Colour Replacement Brush (B)
30 Eraser (E)
31 Magic Eraser (E)
32 Background Eraser (E)
33 Paint Bucket (K)
34 Gradient (G)
35 Eyedropper/Color Picker (I)
36 Custom Shape (U)
37 Rectangle Shape (U)
38 Rounded Rectangle Shape (U)

39 Ellipse Shape (U)
40 Polygon Shape (U)
41 Star Shape (U)
42 Line Shape (U)
43 Shape Select (U)
44 Horizontal Type (T)
45 Vertical Type (T)
46 Horizontal Type Mask (T)
47 Vertical Type Mask (T)
48 Text on Selection (T)
49 Text on Shape (T)
50 Text on Path (T)
51 Pencil (N)

Modify Tools
This set of tools is primarily concerned 
with how you can affect the crop and 
intelligently move items in the frame for 
different compositions.

52 Crop (C)
53 Cookie Cutter (C)
54 Perspective Crop (C)
55 Recompose (W)
56 Content-Aware Move (Q)
57 Straighten (P)

Colour Tools
Here you can set your foreground and 
background colours, swap them over if 
required, access the colour picker and 
set back to default as required.

58 Colour Tools

1 2 3 4 5 6 7 8 9 10 11 12

13 14 15 16 17 18 19 20 21 22 23 24

25 26 27 28 29 30 31 32 33 34 35 36

37 38 39 40 41 42 43 44 45 46 47 48

49 50 51 52 53 54 55 56 57 58

Key to Symbols
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The File 
Menu Layout
Get yourself familiar with the file menu system and you will see 
just how powerful the program can be.

STARTING WITH PHOTOSHOP ELEMENTS

Adobe Photoshop 
Elements has many one-
click solutions to make 

your photos look their best 
but over time you may find the 
need to dig deeper into the 
more advanced options that are 
on offer with the Photo Editor. 
Many options are presented in 
the taskbar at the bottom and 
the panel bar on the right. If 
you need them however, the 
File Menu is where you can find 
all the vital tools.

Adobe Photoshop Elements File Edit

From this menu you can see 
the About screen and manage 
any Plug-ins as well as update 
your Preferences and quit 
Photoshop Elements. You can 
also view any legal notices or 
hide the workspace.

One of the key menus you 
access at the start and end of 
a session. You can create new 
documents, open existing ones 
and save them. You can also 
import or print your documents 
and create contact sheets.

In many ways, Edit is quite 
similar to the options available 
on a word processor. You can 
copy, paste, delete or merge 
images. You can also fill 
selections, alter colour settings 
and undo actions.

Image

Here you can make many 
changes to your photos. You 
have various rotation and 
transformation options along 
with cropping and resizing. You 
can also convert the colour 
mode or profile of the image.
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THE FILE MENU LAYOUT

Enhance

Many of the main adjustment 
options are found here. They 
range from contrast, brightness 
tone, sharpness and colour. You 
can also access the Open Closed 
Eyes feature and much more.

Layer

A vital aspect of image 
manipulation is the ability to 
add layers of effects to your 
image. Here you can add new 
layers, fill layers and adjustment 
layers for non-destructive edits.

Select

Every time you make a 
selection of all or part of your 
image, you can modify its 
properties here. You can feather 
the edges, expand or contract 
it, invert it and save it.

Filter

This menu has all the creative 
and fun filters that can add 
new life to your photos. Add 
blur, sharpening, distortion 
and artistic effects at the 
click of a button.

View

Some of the basic zoom in 
and zoom out options are 
kept here including being able 
to view the print size of your 
image or turn the visibility of 
rulers, grids and selections on 
and off.

Window

This menu lets you control 
the visibility of certain tools 
and panels and turn them on 
and off as needed. The major 
adjustment panels, including 
Effects, Layers and Filters, can 
be controlled here.

Help

Should you need it, you can 
enter search parameters for 
any issues you encounter. There 
are also a number of options 
presented to you that can help 
you in certain situations should 
they arise.

When you explore the file menus on 
offer in Adobe Photoshop Elements, 
each menu and sub-menu will 
always display the keyboard short 
cut next to the action or tool. To 
speed up your work flow, it's always 
a good idea to become familiar with 
those short cuts.

Shortcuts

21



Guided Mode 
Categories
Here is a quick reference sheet of all the current guided tutorials 
available in Adobe Photoshop Elements 2019.

Easy-to-follow guides
Your Guide
At the time of writing, there are 
currently 53 guided edits available in 

Adobe Photoshop Elements 2019. 
They can be accessed from 

the Guided workspace 
page and are 

distributed under 
six categories. 

Each one 
has a small 

before and 
after slider 

that gives you a 
quick overview of 

what each effect is 
designed to achieve.

Just as the name 
suggests, the Guided 
mode is designed to help 
you produce a number 
of creative and artistic 
effects by taking you 
through the process in 
numbered steps. It is 
a semi-automatic edit 
where you click various 
available options and 
Elements does the 
rest for you. 
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This lets you adjust the brightness of your photo and 
control how much contrast is present. You can view the 

after image only or view both the before and after images either 
vertically or horizontally.

1

The Lighten and Darken option can be viewed as a more 
simplified version of the Levels adjustment option. You 

are given three sliders that affect the brightness of Shadows, 
Midtones and Highlights.

5 You can output for web and print and will be presented 
with a couple of options that control the final size of your 

image. You can specify width and height pixel dimensions and 
apply the result.

6

Brightness and Contrast

Your photos may suffer from a colour cast that can make 
your human subject's skin look a little off in terms of 

its colour tone. This guided edit can alter the tan, blush and 
lightness of skin.

2

Correct Skin Tone

A crop box will be drawn on your photo so you can resize 
that box to whatever size and proportion you like. You can 

restrict it to certain proportions and change the overlay to Grid 
or Rule of Thirds.

3

Crop Photo

This uses a levels adjustment whereby you can alter the 
shadows, highlights and middle tones brightness of your 

selected image. Any adjustments are made globally across the 
entire image.

4

Levels

Lighten and Darken Resize Your Photo
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You have the options to rotate your photo clockwise and 
anticlockwise and if you have a sloping image, you can use 

the Straighten Tool to bring it back to level.

7

This replicates the effect of the popular and cheap cameras 
that create a very specific look due to their low quality 

manufacture. You can also add a vignette to the photo.

11 A colour cast is an unwanted bias towards a tone that 
spoils the look of your photo. You can use the colour picker 

to find an area of pure grey, white or black to remove the cast.

12

Rotate and Straighten

You can use an Auto Fix sharpening effect or you can use 
the supplied slider to manually increase the amount of 

sharpening until you have it how you want it.

8

Sharpen Photo

This lets you add a soft dark or light border to your image. 
You can control its intensity and use sliders to change the 

softness of the vignette and its roundness.

9

Vignette Effect

You have an Auto Fix option to make a best-guess at 
the correct colour balance and contrast in the photo. 

Otherwise, you can use the Hue, Saturation and Lightness sliders 
to fine tune it.

10

Enhance Colours

Lomo Camera Effect Remove a Colour cast
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Applying this effect makes your photo look as though 
it was shot on old slide film for a much more saturated 

look. You can add the effect a number of times to increase the 
intensity of the effect.

13

High key images are characterised by their very bright 
appearance with very little shadow detail left in the photo. 

You can use a colour or black and white high key effect.

17 This effect mimics the look of a pencil drawing. Click to 
convert the photo into a pencil sketch and if you want to, 

you can add a small amount of colour back into the image and 
darken the lines.

18

Saturated Film Effect

This is a quick black and white conversion with four 
presets ranging from light to dark. If you want, you can 

add a diffuse glow to the image for a dreamy effect or increase 
the contrast.

14

Black and White

Select a preset colour or use the colour picker to keep one 
colour and turn the rest of the image to black and white. 

You can refine the effect and also increase the saturation of the 
remaining colour.

15

B&W Colour Pop

You can use a selection brush to selectively pick out 
the areas you want converted to black and white whilst 

retaining colour elsewhere. You also have the option to invert the 
effect if required.

16

B&W Selection

High Key Line Drawing
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Works in the opposite manner to a high key image. It is 
characterised by small amounts of highlight detail and is 

dominated by darker tones. You have the colour and black and 
white options.

19

You can create visual text using this guide, placing a 
different photo inside each letter. Add your text and then 

one by one, you can place a photo inside each letter. You can 
also add a new background and add effects to the text.

23 Converts your photo using one of three black and white 
presets; also lets you adjust the tone of the conversion and 

the tint colour of the image to create an old fashioned photo.

24

Low Key

You can combine and blend two images together for a 
more creative effect. You can use a preset image or one 

of your own photos and superimpose it over the subject in your 
main composition.

20

Double Exposure

With this effect, your chosen image is split into a number of 
sections chosen by you and then a number of effect styles 

are added to each section of the collage.

21

Effects Collage

Great for creating memes for social media. This tool guides 
you by letting you create a meme template, edit your text 

and resize the main subject's photo. You can apply new borders 
and add effects for a memorable look.

22

Meme Maker

Multi-Photo Text Old Fashioned Photo
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This effect can take your primary subject and make it look 
like it is escaping from the frame of the photo. You can add 

a frame and then select the area of the shot you want to extend 
outside the frame and add a shadow for more depth.

25

Turn your photo into a collage with the Picture Stack 
effect. Choose the number of pictures you want your photo 

divided into and then add a border to each element. Then you 
can add a solid or gradient background for the finishing touch.

29 Go psychedelic and turn your photo into some fun pop art. 
Choose from the styles available and then convert it into 

a monochrome or posterised version. You can also add a neon 
glow if you wish, or tint it a single colour.

30

Out of Bounds

Turn your photo into a painting with this artistic effect. It 
provides you with a number of preset brushes to paint onto 

your photo. Choose a canvas colour and texture and then add an 
optional effect to enhance the painterly feel.

26

Painterly

This gives you a choice of effects that you can apply to 
your photo. Then you can simply paint using a brush over 

your image where you want the chosen effect to appear. You 
can work with more detail if required and change the size and 
opacity of the brush you use.

27

Partial Sketch

Use your photo as the basis of creating some creative text 
effects. Choose your font and how you would like it to 

appear on your photo, then select the background style. You can 
also choose the intensity of bevel drop shadow and outline of 
your text.

28

Photo Text

Picture Stack Create Pop Art
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Your photo can be turned into a jigsaw puzzle with this 
effect. Choose the puzzle piece size you want to use. 

Extract pieces for a more creative effect and arrange them by 
moving them to another part of the design and rotate the pieces 
if needed.

31

Add motion blur to your backgrounds to give the 
impression of fast motion. Select your main subject using 

the selection tools and then add motion blur to the background, 
keeping your main subject sharp.

35 This mimics the effect of rapidly zooming your camera lens 
while you take the photo. You can crop your photo in order 

to put your primary subject in the centre of the shot and then 
add the zoom burst effect. Refine the area of focus and add an 
optional vignette.

36

Puzzle Effect

Add reflections to your photos for eye catching results. 
Simply add the reflection and then use the tools provided 

to colour the reflection, fill the background and then make the 
reflection look more like glass or water.

32

Create Reflections

Choose from a series of different shapes and then position 
it over your photo and scale it to the required size. Then 

you can add an effect to both the inside and outside of the 
shape's area, before cropping it to your preferred proportions.

33

Shape Overlay Effect

Add some great blurred speed lines for a little more zoom 
in your photos. Use a selection tool and choose an area of 

your image to apply the effect to. Then you can add the speed 
effect and then precisely refine the look of your finished effect.

34

Speed Effect

Speed Pan Zoom Burst Effect
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You can make your subject stand out in the photo by making 
the distracting background blurred as if photographed with 

very shallow depth of field. You can add simple blur or use more 
precise selections for more targeted effects.

37

This works much in the same way as Photoshop's content-
aware scale tool. This tool lets you scale an image but 

maintain the important content and detail in the photo. You also 
have the option to mask areas for greater control.

41 With this set of tools, you can select your primary subject 
using one of a number of selection tools and then remove 

their background. Select a new background or texture and 
then place it behind the original to match the colour tones for a 
convincing result.

42

Depth of Field

Use your own photos and graphics to create frame designs. 
Use the tools to select the areas you want to be your frame 

and then save that frame design so you can work on it further in 
Expert mode.

38

Frame Creator

Based on an old slide film technique pioneered by Michael 
Orton, you can add a soft and dream-like quality to your 

photos. Apply the Orton effect as many times as you wish and 
then use the sliders to enhance the effect even further.

39

Create Orton Effect

For great looking skin in your portrait photos use these 
tools to heal blemishes in skin, remove red eye and whiten 

teeth. For a glamorous look to your shots, you can also add a 
glow effect and even slim your subjects down if required.

40

Perfect Portrait

Recompose Replace Background
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If you have a number of old scanned photos that have many 
blemishes on them, then this tool can make them look new 

again. Using healing tools, blur tools and clone stamp copies, you 
can improve those old photos with ease.

43

A simple and effective way to turn your favourite photos 
into watercolour paintings. Choose an effect, add a 

watercolour paper overlay and a canvas texture. Then you can 
refine the effect and add captions in various text styles.

47 This allows you to select two photos you wish to work on 
and extract from one photo and place it on another to 

combine the two. You have selection tools to help you accurately 
extract your first subject, then you can place it, move and scale it 
on the second photo.

48

Restore Old Photo

For any small blemishes and flaws in a photo, use this tool 
to quickly fix those troublesome areas with the spot healing 

brushes. Larger areas will benefit from the application of the 
healing brush.

44

Scratches and Blemishes

Choose from a selection of border designs to frame your 
favourite photos. Choose its size and colour and then add 

a text overlay using the type tool. You can then specify the text's 
position and edit the text style used.

45

Text and Border Overlay

Turn your images into miniature effect photos using this 
specialised blur tool. It works best on photos taken from 

above your subject and from a distance. It mimics the effect of 
expensive tilt-shift lenses. Modify the focus area and add blur, 
contrast and saturation.

46

Tilt-shift

Watercolour Effect Photomerge Compose
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This is a form of high dynamic range photography. This tool 
lets you combine two or more different exposures of the 

same shot to create a much more exposed version. Use automatic 
or manual modes for the final result.

49

Great for creating super-wide panoramic shots. Combine 
a sequence of several photos that captures a very wide 

panoramic scene by merging them. Select your photos, choose 
your panorama layout and type of settings and the program 
does the rest for you.

53

Photomerge Exposure

Combine facial features from two different portrait photos 
for humorous results. Select two faces and open them. You 

can then use the alignment tool to pick out three distinct areas 
on each face and then blend them together.

50

Photomerge Faces

Use multiple group shot images to make sure everyone has 
their eyes open or is looking at the camera. Select two or 

similar group shots taken together. Set one as the final image 
and use additional photos to merge preferred elements into the 
final photo.

51

Photomerge Group Shot

If you have a series of photos of the same subject but there 
are distractions in each, you can combine two or more 

photos to clean up the scene. Use one base image and blend in 
the best parts of additional photos to create a finished result.

52

Photomerge Scene Cleaner

Photomerge Panorama

Don't forget to check out the 
inspirational news stories 
and guide information 
available on the Home 
screen. There is plenty 
to pique your interest.

Try This
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Most modern digital cameras allow you to shoot in a 
picture format known as Raw mode. Raw mode is a pure 
digital readout of the data captured by the sensor. This 
additional data offers amazing scope when it comes 
to getting the very best out of your photos. Step inside 
your very own digital darkroom and take control of the 
final look of your photos. More than that, see how you 
can integrate Adobe Camera Raw (ACR) and Photoshop 
Elements for a professional looking workflow solution.
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In the Raw
Adobe Photoshop Elements 2018 
comes with Adobe Camera Raw 
supplied. It is more usually referred 
to as ACR and lets you process Raw 
files from digital cameras as the first 
step of your digital photo processing 
workflow; but you don't have to stop 
there. You can process your Raw file 
and then continue to work with it in 
the Photo Editor in either the Quick 
or Expert editing modes. It is easy to 
get started. Let's take a look at the 
ACR interface, see what it has to offer, 
and also how it can integrate with the 
Elements Photo Editor to help you get 
more out of your favourite photos.

Zoom Tool
A standard zoom in and zoom out 
tool that lets you view your image 
at increasing or decreasing levels of 
magnification. Each time you click the 
zoom tool, the image will be enlarged 
to the next level of magnification. 
Wherever you click on your image, 
it will magnify and centre it in the 
workspace using that clicked point. If 
you press Alt on your keyboard, you 
can decrease the level of magnification 
and zoom out. Right-click the image to 
call up the context menu to display all 
the preset zoom levels available.

Hand Tool
The Hand Tool allows you to move your 
magnified image around the screen by 
clicking and dragging. 

The Camera
Raw Interface Part One

Let's take a look at the ACR interface, see what it has to offer and 
also how it can integrate with the Elements Photo Editor.
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Red Eye Removal Tool
If you happen to have a photo of a 
family member or friend whose eyes are 
coloured red because a camera flash 
illuminated the blood vessels at the back 
of their eyes causing the red-eye effect, 
you can remove the redness using this 
tool. Click and drag a marquee selection 
over each eye and the program will do 
the rest. 

Open Preferences
Opening this dialog box allows you to 
set some Camera Raw Preferences such 
as where your image settings are saved 
and whether you automatically sharpen 
all images. You can also set other auto 
functions such as tone adjustments and 
also specify how DNG files are handled.

Rotate Image
Lets you rotate your photo clockwise or 
anti-clockwise in 90° increments.

White Balance Tool
To help you remove colour cast from 
you photo, you can use the White 
Balance Tool to bring the image back 
to a more neutral colour cast. Click on 
the tool and then place the eyedropper 
cursor over an area of your picture that 
is either meant to be white, middle grey 
or solid black. It will use that reference 
point to neutralise any colour cast. 
Right-click the screen to call up the 
content menu to display all the white 
balance presets available to use.

Crop Tool
If you need to crop your image to 
different proportions, you can use the 

Crop Tool to drag a crop box over your 
image and using the control points on 
the box, scale and rotate it to get the 
perfect crop for your photo. Right-click 
on the cropped image to call up the 
context menu to view more proportional 
cropping options and to clear the crop if 
you need to start again.

Straighten Tool
This is particularly useful if you have 
strong vertical or horizontal elements in 
your photo that need to be levelled so 
they are perfectly vertical or horizontal. 
Click the Straighten Tool and then click 
and draw a line along the part of your 
photo that needs to be straightened out. 

Continue over the page and we delve into the 
control tabs, colour treatment options and profiles 
of the Adobe Camera Raw interface.

3

Control Tabs

THE CAMERA RAW INTERFACE
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Full Screen Mode
Clicking this button lets you toggle the 
full screen mode. When you do, no file 
menus will be visible until you toggle 
full screen off again.

Shadow Clipping
Shadow Clipping is there to warn you if 
any of the darkest tones in your photo 
become solid black. A blue highlight 
will appear to warn you which parts of 
the photo are clipped.

The Histogram
This is a graphical representation of the 
distribution of colour and tonal values 
throughout the image. The amount 
of tones in any given part of the tonal 
range are shown as peaks along the 
length of the histogram.

Highlight Clipping
This works in the same way as the 
Shadow Clipping warning. If any of 
the brightest highlights in the image 
are solid white, or get pushed to solid 
white as a result of editing, they will be 
displayed as red highlights. 

Information Panel
The left side of the panel shows the 
RGB values of the image at the cursor 
position. The right side of the panel 
displays the exposure information for 
the image such as aperture, shutter 
speed and ISO.

The Camera
Raw Interface Part Two

Our journey around the Adobe Camera Raw interface continues 
with more of the tools to bring the most out of your photos.
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Help and Save
Help accesses the Adobe help files for 
ACR processing, whilst the Save button 
allows you to save your current edits to 
DNG file format.

Depth
Choose from 8 Bits/Channel and 16 Bits/
Channel colour depth.

 
Done, Cancel, Open Image

Done Commits all edits and exits without 
opening the file. Cancel quits without 
accepting any changes and Open Image 
will apply changes and open the image 
in the Photo Editor.

Control Tabs
The ACR interface breaks down the 
workflow process into discreet sections. 
First is the Basic panel where the 
majority of your processing will be 
done. You can control all the basic 
exposure and colour adjustments 
here. The Detail tab reveals sliders 
for controlling Sharpening and Noise 
Reduction. The Camera Calibration tab 
lets you specify the calibration process 
you are using.

Treatment and Profile
Gives you the choice of processing your 
photos in the main colour workspace or 
in the Black and White workspace. The 

Profile menu allows you to choose from 
a number of preset colour profiles  and 
a series of artistic, modern and vintage 
effects too.

Zoom Levels
Instead of using the Zoom Tool, you can 
use the Zoom Level options.

View and Settings
The buttons let you cycle through the 
available before and after view options, 
swap the before and after settings, copy 
the current settings to the before image 
and toggle between the current settings 
and the default settings.

14

THE CAMERA RAW INTERFACE
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Click on the Profile Browser button and you can 
view all the standard and artistic colour presets 
you can use on your photo to alter its colour. There 
are a number of camera matching profiles as well 
as artistic, modern, black and white and vintage.

The Profile Browser
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Camera Raw 
Processing
ACR lets you process Raw files from digital cameras as the first step 
of your digital photo processing workflow; but you don't have to stop 
there. You can process your Raw file and then continue to work with it in 
the Photo Editor, in either the Quick or Expert editing modes.

BEFORE AFTER
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CAMERA RAW PROCESSING

To begin, you'll need to open Photoshop Elements 2019 
and from the home page click on the Photo Editor icon, this 

will activate the Photo Editor program. The default is to open in 
Expert mode. You can access Adobe Camera Raw (ACR) from 
either the Quick, Guided or Expert mode workspaces.

1 Go to File > Open in Camera Raw (Alt + Cmd + O) to open 
your file browser and navigate to the folder that contains 

the Raw file you wish to process. Once you have located it, 
double-click the file or highlight it and press Open at the bottom 
right of the browser window.

2

The Raw file, in this case a seascape shot in Cornwall, will 
open in the ACR workspace, as ACR runs in a separate 

window to the Elements Photo Editor. You can use the zoom 
tools to fill the active image area of the workspace; you can 
clearly see the effect your edits will have on the photo.

3 A good place to start with a landscape shot like this is 
to ensure a nice level horizon. If yours is sloping, use the 

Straighten Tool (A). Click on one side of your horizon line, then 
drag across to the other side and release the button to bring it 
back to level.

4
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Click on the Basic tab to make sure it is the active tab and 
you will see the range of adjustments available; you can use 

these to get the most out of your image. The photo is slightly 
underexposed, so a good place to start is to increase the value of 
the Exposure by moving the slider to the right.

5 If you turn on your Highlight clipping warning (O) and your 
Shadow clipping warning (U), you will be shown any areas 

of your image that are turning solid black or solid white. These 
areas will suffer a loss of detail so having the warnings turned on 
is useful to avoid degrading the image.

6

Now, as you move the slider and increase the exposure, 
any areas that are becoming too overexposed will now 

be highlighted in red. You can often get away with just a slight 
overexposure in your images but beware of pushing it too far and 
destroying the image.

7 An alternative to viewing the highlight clipping warning is 
to press and hold the Alt key while moving the Exposure, 

Highlights and Whites sliders to see just the affected highlight 
areas without the image itself being seen. It does give you the 
chance to fine tune the exposure without taking it too far.

8
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CAMERA RAW PROCESSING

If you are adjusting the Shadows and Blacks sliders, too 
much underexposure will be highlighted in blue by the 

Shadows clipping warning. Solid black areas are much like 
highlighted areas: you can have a small amount of solid black 
areas but beware of heavy underexposure.

9 Holding down the Alt key while making Shadows and 
Blacks adjustments, just the darkest areas turning solid 

black will be seen to warn you there is a potential Shadows 
clipping problem.

10

If you want ACR to do some of the heavy lifting for you, 
there is always the option to click the Auto button. When 

you do this, the program will attempt a set of best adjustments 
that it thinks will suit the image for optimal exposure. It is 
certainly a good baseline for you to continue editing.

11 Adjustments are a personal thing of course but we opted 
to increase the Exposure, reduce the Highlights to -75, to 

recapture detail in the lightest parts of the image, and pushed 
Shadows to +55 to make sure detail was kept in the darkest areas 
of the shot. Whites were also reduced slightly to help keep detail 
in the brightest parts of the scene.

12
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The Detail and Masking sliders control artefacts caused 
by over-sharpening. The Noise Reduction settings let you 

control image noise present in high ISO photos. Beware of very 
high noise reduction settings that can make your photo look 
muddy and lacking in detail.

15 The Calibration tab is best left at its most current version. 
For ACR in this form, Version 4 is the most up to date 

Process that offers the most recently improved tools and 
functions within ACR. Changing it to older versions will result in 
certain improvements not being possible.

16

To the far right of the adjustment panels, is a small icon 
comprised of four lines. When you click on this, you can call 

up your image's settings, Save New ACR defaults and reset to 
the standard default settings.

17 Once you have adjusted the image to your taste, one final 
option is to crop your image. Use the Crop Tool (C) to draw 

a crop box over your image to remove any unwanted area of the 
photo and create a more pleasing composition.

18

Next are the three sliders that affect midtone contrast 
and how vivid the colours are. Clarity is a refined version 

of global contrast, affecting the middle tones for more detail. 
Vibrance affects muted colours first and Saturation is a more 
general adjustment for much more vibrant colours.

13 Click on the Detail tab to control Sharpening and Noise 
Reduction in your photo. Sharpening is essentially an 

increase of contrast between the brightest and darkest edges of 
your image. 

14
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If you are happy with your photo and the edits you've made 
you can simply click the Done button and your adjustments 

will be saved in what is known as a Sidecar file with an XMP file 
extension. This file remembers the edits you've made and applies 
them non-destructively to your Raw file when opened.

19 You also have the option to click Open Image and continue 
to work on the photo in either of the Quick, Guided or 

Expert modes on offer in the Elements Photo Editor. You can 
then save the result as a PSD file or jpeg. We've decided the sky 
needs to be worked on so we're going to open it.

20

The image file will now open in the Elements Photo Editor. 
We're going to work on it in Expert mode because we will 

need a few extra adjustments and layers to achieve our goal of 
making the sky more dramatic.

21 The first thing you need to do is create a new adjustment 
layer. Click on the Create New Fill or Adjustment Layer 

icon to expand the dropdown menu and you will see a number 
of adjustment layer choices. Click on Levels to add a 'Levels 1' 
adjustment layer to the layer stack in the right hand panel.

22

The 'Levels 1' layer will appear above your base image 
which will be on a default locked layer called 'Background'. 

You will see that it is split into a layer thumbnail and a layer mask 
thumbnail. The layer thumbnail controls the levels properties and 
the layer mask controls masking properties.

23 When you create an adjustment layer, its properties are 
displayed in a panel that will appear when it is added to 

the layer stack. In the case of a levels adjustment, there are 
three sliders that control brightness of the shadows, middle 
tones and highlights.

24

CAMERA RAW PROCESSING
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Move the middle tone slider from the middle to the right; 
as you do so, the whole image will get darker. You can also 

drag the furthest right highlight slider to the left slightly to make 
the clouds a bit whiter. Concentrate on how the sky is looking 
and don't worry about the rest of the image for the moment. 

25 Once you have the sky looking darker and a bit more 
dramatic, you will see that the rest of the image is too 

dark. What you can do now is use the layer mask to only let 
the levels adjustment affect the sky and level the rest of the 
image unchanged.

26

To do this you must first make sure your Foreground 
Colour is set to Black. You can click the Switch 

Foreground icon or press X on your keyboard to swap the 
default foreground and background colours around so black is 
now the foreground colour.

27 Next you need to click on the Gradient Tool (G). When 
you do, the Tool Options Panel will display all Gradient 

Tool options. Click on the Edit button and make sure you have 
Foreground to Background set as the gradient. Then make sure 
the Linear Gradient button is clicked.

28
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Make sure the 'Levels 1' layer mask is clicked to make it 
active and then click and drag a line with your gradient tool 

that starts just below the horizon and ends just above the level of 
the lighthouse.

29 When you let go of the mouse, a gradient will be drawn 
on the layer mask that fades from black to white along the 

points you clicked with your mouse. Wherever masks are used 
remember that black conceals and white reveals.

30

If you look at your image now, the sky is darker at the top 
and transitions to normal at the horizon and the rest of the 

image is untouched. The mask you added only lets the 
adjustment you made affect the sky at the top and fades to 
zero effect where the layer mask is black.

31 It doesn't have to end there. You can add another Levels 
Adjustment layer and tweak the overall brightness of the 

image. You can then go back to the 'Levels 1' adjustment and 
make the sky even darker by sliding the middle tone tab even 
further to the right.

32

If you are happy with the image, you can go to File > Save 
As (Shift + Cmd + S) and save your composition as a 

Photoshop PSD file with the layers and adjustments intact, which 
allows you to return and adjust it still further if you wish.

33 Your ACR to Elements workflow example is complete. You 
have processed the original Raw file non-destructively, 

opened the resulting processed file in the Elements Photo Editor 
and made further targeted edits using adjustment layers.

34
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Elements Organiser 2019 is packed with powerful 
features designed to help you make the most of your 
photos and videos by organising them and creating 
albums and catalogues as efficiently as possible. Import 
and tag your photos with keywords, location data and 
ratings. If you want, Organiser can auto curate your 
photo collection, finding the best ones based on image 
quality, tags and ratings to quickly find your favourite 
photos. Let's look at what Organiser can do for you. 
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The File Menu
The File menu options appear in the 
top left of the menu bar. These are the 
basic methods for interacting with the 
program, managing your catalogues and 
finding, tagging and viewing all of your 
media files.

The Import Button
From the drop-down menu, you can 
choose to import photos from various 
files and folders on your computer, from 
your camera and card reader. Another 
option lets you search your hard drive. 

Albums and Folders
Click the Albums button to view any 
Photo Albums you may have created. 
Click on Folders to display a folder view 
of your files.

Folders View
Click a Folder name to display just the 
photos within that chosen folder. Click 
the All Media button at the top of the 
media browser window to display all 
images from all folders.

All Media and Sort By 
If you are viewing the content of one 
folder, you can click the All Media button 
to leave the selected folder and see all 
photos. Next to the All Media button is 
a Sort By drop-down list where you can 

2

6

The Organiser 
Workspace
Before you dive in and start using the Organiser and its tools, it's 
worth taking a look at the workspace and how its tools are arranged.

3

GETTING ORGANISED

Find it
Use Elements Organiser to organise and 
share your photos and media files. You 
can view thumbnails of all your favourite 
images and media you’ve imported. You 
can view a large thumbnail of a single 
media file or smaller thumbnails of 
many media files. You can fix the most 
common problems in the media files by 
using the tools in the Instant Fix tab of 
the Task panel.

4
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A media organiser is only as 
good as the tagging and 
keywords associated with 
your images. Spend 
some time tagging 
your images to 
reap the benefits 
when it comes 
to searching 
and retrieving 
them again.

Tagging and Keywords

THE ORGANISER WORKSPACE

sort according to Newest, Oldest, Name 
and Batches of photos.

Tool Options panel
The tools arranged on the left at the 
bottom of the screen represent the 
main tools for tagging and organising 
your photos. You can hide the Folders 
panel, Undo steps, Rotate your images, 
Add location data, Add an Event, use 
the Instant Fix feature, open the Photo 
Editor, create a slideshow or return to the 
Home screen.

Status Bar
This small bar displays information such 
as the number of items in the media 

browser, the date range of all media and 
the View Notifications button.

Category Tabs
At the top of the Organiser window are 
five clickable tabs. Media displays either 
a folder or the entire catalogue. Click 
this tab to view photos where you have 
identified faces. Click the Places tab to 
tag an image with a place on the map. 
Finally, you can click the Events tab to 
display photo tagged as Events.

Media Browser Window
The contents of your catalogue or a 
single folder will be displayed in the main 
browser window.

Search
Click this button to open the Search pane. 
You can enter a search parameter or click 
on any of the search types listed down the 
left hand side of the search panel.

Create and Share
These two buttons reveal drop-down lists 
where you can create slide shows, photo 
books, video collages and more. Note 
that certain creations require Adobe 
Premiere Elements to be installed for 
video-based tasks. The Share button lets 
you email and share your media on social 
media and image sharing sites.

Ratings and Auto Curate
Ratings lets you filter your search by 
any star ratings your images have 
been given. Auto Curate automatically 
chooses the best photos for you. You 
can specify how many are shortlisted, up 
to 500, and the results are displayed in 
the browser window.

Panel Bin
When you click the Keyword/Info 
button at the lower right of the 
workspace, a panel opens providing 
you with a number of different ways 
to add keywords and tag photos. An 
Information pane is provided where 
information about a selected photo can 
be displayed.

Zoom
You can adjust this slider to see your 
image thumbnails larger or smaller in the 
browser window.

Keyword/Info
Click this button to open the Panel Bin 
and choose options from the Tags or 
Information panel.
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Setting up
Elements Organiser

When you open Elements, you are presented with the 
Home Screen. Down in the lower right are the programs 

available to use or to try a free trial. Click on Organiser to activate 
it and follow any on-screen prompts.

1 There is usually a default catalogue created but you have 
the option to use the Catalogue Manager to create a 

custom location for your catalogues. Click the Custom Location 
and then Browse to the location where you would like to create 
your custom catalogue.

2

If you are creating a new folder, you can give it a bespoke 
name and then hit the Create button to make the folder 

into which your catalogue will be placed. Once you have done 
that, you can then give a name to your catalogue. We have called 
ours 'My Catalog 1'. Click OK to create it.

3 The Organiser workspace will open and you will see the 
main Media workspace displayed. If you are using it for the 

first time, it will prompt you to start importing images ready to 
be organised.

4

Elements Organiser 2019 gives you complete control over how you 
import, search, tag, organise and share your photos and videos. 
Organiser scans your files and analyses your photos and can even find 
faces ready for you to identify. 
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There are also screens giving you a brief overview of what 
each section of the Organiser program can do. The People 

section can identify faces for tagging. The Places section can 
geotag or let you manually add location data to your images and 
Events groups your images by date and time.

5 Start the process by clicking the Start Importing button 
and Organiser will ask you to add folders from which to 

import media and photos from. You can add and subtract as 
many folders as you wish. Click Add Folder to choose more, and 
even customise how much content from each is imported.

6

When you click Add Folder, browse to where your folder 
of images are kept and double-click it to add it to the 

import list. There is a small icon shaped like binoculars that when 
highlighted, informs you when new files are added to that folder. 
When you are ready, you can hit the Import button.

7 All the selected media you chose will be imported. If you 
have chosen a lot of images, you will see a progress bar 

listing the items as they are imported. When complete, Organiser 
will display a grid view of your images ready for you to start 
working on.

8

Click on the People section and it will start the process of 
scanning your photos looking for faces so you can organise 

images by people. The Places section will display images ready 
for you to add location data; unless they already have GPS data 
attached, whereby they will be pinned to the map.

9 The Events section displays all your photos in chronological 
order based on date and time. You can create new events 

and stack all images of that event within it. Now that you are 
organised, let's find a little more about the workspaces on offer.

10
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Tagging and 
Keywords

From the Home screen, click on the Elements Organiser 
icon to open the Organiser workspace. We worked in 

Folder view with the Media tab clicked and all media currently 
on display. We had some example images of Dartmoor in Devon 
that we wanted to tag for future reference.

1 We made a folder called 'Places' that contained a number 
of images but only a few of them were relevant to our 

particular requirement of moorland photos. The first thing we 
did was to press the Cmd key and left-click each of the required 
moorland photos. There were five shots in total.

2

Now that the images are selected, you can begin to tag 
them. The first and foremost requirement is to add a place 

tag. In the taskbar, click on the Add Location button. This calls 
up the Add a Location dialogue panel. Our shots were taken at a 
place called Haytor, so we entered 'Haytor' in the dialogue panel.

3 Press enter and the dialog panel will show you possible 
locations based on the name you entered. We knew ours 

was in the Dartmoor National Park, so clicked on that option 
and then the Apply button to add that location data to the five 
images we had selected.

4

If your photo library is large and scattered across many folders, it 
would help if they were tagged and had keywords added to make your 
searches more streamlined and efficient. Rather than trawling through 
folder after folder, why not tag them with keywords?  
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Now if you look over at the Places Tags section in the Tags 
panel bin, you will see that location data has been added 

as a tag, which may consist of several sub categories. If you click 
the top category, in this case United Kingdom, only the tagged 
images will now be seen in the browser window.

5 If you highlight all of the images again, you can add more 
tags to help you identify the photos at a later date. Under 

the Image Tags panel, you can add custom keywords; in this 
case, the keyword 'Sunrise' was used. Click Add to include the 
new keyword.

6

It is added to the Other category but you can click and 
drag to any of the other categories; or click the green plus 

symbol in the top right corner and click on the New Category 
option in the drop down menu that appears. When you do, the 
New Category window opens.

7 In the New Category window, you can choose a colour 
for your category icon as well as choosing the name you 

want the new category to be called, in this case 'Sunlght'. If you 
wish, you can even select an icon from the choices listed in the 
category Icon window. Then you can click OK to proceed.

8

The newly named category is added to the Keywords list. 
You can drag and drop the its Image Tag into this new 

folder. If you turn off the Places Tags visibility icon and then click 
on the new category's visibility icon, your images will still be 
displayed in the browser window.

9 As you can see, we had tagged the photos with a specific 
Places Tag and also with the new Sunlight category and 

Sunrise image tags. These various sets of tags mean that if we 
ever need to find a sunrise photo taken on Haytor, we can just 
search for those particular criteria and they will be displayed.

10
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Putting Names
to Faces

Click on the People tab to open the workspace for tagging 
faces. Just like the main Media view, you can view the 

contents of selected folders or click the All People button for a 
view of every face that has been found in your entire catalogue 
of images; this includes those in the UnNamed category.

1 The view you are presented with is a thumbnail portrait 
of each individual face that has been identified. Below 

the thumbnail are the words Add Name followed by a number. 
The number represents how many pictures of that person have 
been found.

2

If you hover your cursor over any given thumbnail, it 
displays two options. One shows all the complete photos 

of that person and the other just shows a small thumbnail of 
their face without any background context to distract from the 
process of identifying them.

3 To name a known person, Ursula Romanovich in this case, 
you can click on Add Name and type in their name. Next to 

the name is a small tick and cross icon. Click the cross to cancel 
inputing the name or click the tick to assign that name to the 
person. Doing this will move them to the Named category.

4

Now that you've tagged a few photos, let's move over to the People 
workspace. Your library was scanned for all faces present in the photos 
and then displayed here. Now you can tag these people and literally put 
names to faces to aid you in your search for friends and family.  
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If some photos of that person have been missed and are 
still available in the UnNamed category, you can click those 

thumbnails and click Add Name. If the facial match is close 
enough, the name will be displayed and you can simply click it 
and click the tick button to add those images to the list.

5 Sometimes a photo of a person that is very similar to 
another may be added by mistake. If that is the case, you 

can right-click the offending thumbnail and choose 'Not Ursula 
Romanovich' to remove them from the list.

6

On other occasions, if you name a person and then view 
their photos in the Named category, you may be shown 

a series of additional pictures and asked if they are also of that 
person. You can also multi-select those that are not the person 
you want and click the Not This Person in the taskbar.

7 As an example of grouping, here are five members of a rock 
band: it would be handy to group the members for easier 

searching later on. To do this, go to the small the green plus 
symbol in the All People panel to open the Add Group dialog box 
for you to create a new group for the members of the band.

8

Under Name, you can type the name of the group; we just 
called it 'Rock band'. The Group it appears in is None since 

we want to create this as a brand new Group category to appear 
in the All People panel bin. When you're ready, you can click OK 
to create the new group.

9 The new group called 'Rock Band' will appear in the All 
People panel bin. Now you can highlight all five members of 

the band and drag their thumbnails into the 'Rock Band' group. If 
you click on their group folder, only their faces will be displayed 
since the tag is relevant only to them.

10
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Tagging Photos 
with Location Data

Click on the Places tab to view the Places workspace. For 
the moment, you will need to be in the UnPinned category 

and view all the photos that have yet to have any location data 
added to them. If you click Group By Time, then they will be 
displayed in chronological order.

1 If you are using this view, then you can alter the Number Of 
Groups value displayed in the left hand panel.  Moving the 

slider left and right, increases the numbers of groups on view for 
more detailed scrutiny or reduces the number for a broader view 
of all the photos you are viewing.

2

We have opted to tag a specific group of shots taken at a 
location called Hound Tor. These shots are kept in a folder 

called 'photos', so we have used the folder view to find them. 
We haven't worried about viewing in chronological order in this 
instance. There are four images to tag.

3 On the right of your Places workspace is the map where 
you can view any pinned photos. If you know where you 

are looking on the map, you can zoom directly to that place, 
otherwise you can search for a location by putting a name in the 
search pane at the top of the map.

4

Tagging places is similar to the way you worked with People. There will 
be Unpinned modes and Pinned modes for those photos that have had 
their locations identified. We've already touched on adding Location tags 
briefly, but now we can explore the Places workspace in more detail.    

56

GETTING ORGANISED



In the media view panel on the left, press the Cmd key and 
multi-select the images for location tagging. Then enter 

your search destination in the Search panel above the map. Press 
enter and a list of matches will be displayed. Click the correct 
one and the selected media will be placed in that location.

5 Sometimes, you may find that the location of the images on 
the map is not that precise but it does give you the option 

to drag the pin to the correct place. If you are having trouble 
identifying the correct area, you can alter the map from Streets 
to Satellite for a better view of the land.

6

Now you can see the land better, you simply drag the pin 
the right spot and click the Place 4 Media Here? green 

tick to confirm placement. You can double-click the pin to view 
the images contained at that location. It will also appear in the 
Pinned category view now as well.

7 You can also navigate directly to a place you know on the 
map and then highlight the pictures you wish to place 

there. Once highlighted, the pictures can then be dragged and 
dropped directly onto the map at the location you navigated to. 
These will also appear in the Pinned category.

8

If you import any pictures that contain GPS data, they 
will be automatically replaced on the map in the Places 

workspace when the data they contain is analysed. Our 
example of some aerial photos taken on the Devon coast were 
accurately placed.

9 If the placement area is too broad, you can edit the location 
information by clicking on the pinned thumbnail and 

inputting more precise location options or dragging the pin to a 
new location.

10
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Adding Events 
Tags to Photos

We have an example folder full of various types of events 
such as weddings, parties and sporting events. When 

viewed in the Events workspace, they are listed by date order to 
help you find what you are looking for. They are listed with most 
recent dates and times first.

1 Much like the People and Places workspaces, the Events 
workspace has a Suggested category for untagged events 

yet to be identified and a Named category where any that are 
tagged as an event will finally be displayed.

2

Click the Number Of Groups slider and push it to the far 
right Max setting. The media browser will display more 

time and date options for you to focus in on. We are looking for 
a particular sporting event, Autocross, which was photographed 
back in 2017.

3 The event we are looking for happened in April - May 2017. 
Now you can use the Calendar panel on the far right to 

open the 2017 calendar and click on either April or May. Clicking 
on May 2017, reveals the photos from that motorsport event.

4

Having talked about who was in a photo and where was it taken, it seems 
only right to mention how you can search for images when you want to 
know when something was taken. Now you can tag and group them by 
the type of event it was and when that event happened.   
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The photos are spread out across the duration of the entire 
day but  are all there ready to be tagged. You can use the 

Number Of Groups slider again to break down the view into 
fewer groups or more groups of photos split across that day's 
worth of shooting.

5 Now that you have all the photos in once place, you can 
highlight them by pressing Cmd + A to select all, or by 

dragging a section around all the photos with your mouse. They 
will be highlighted in blue with a small tick box in their bottom 
right corner.

6

Down in the taskbar in the bottom centre of your screen 
is the Add Event button. If you click this it will call up the 

Add Event dialog box where you can begin to add details about 
the event itself such as Event Name, Start and End Date and a 
Description if required.

7 Start by giving it a name. We used 'Autocross Event' and 
kept the Start and End dates the same since it all occurred 

on May 13th 2017. Since no other Group names have been 
created, Group is kept as None. A short description is also added. 
Now you can click OK to proceed.

8

You will see that all our photos now have a small calendar 
icon in their top right corner to indicate they have an 

event tag called 'Autocross Event' added to them. If you look 
in the Named category now, you will see that event listed. Click 
on the small information icon to see the description you typed.

9 If you return to the main Media view, you will see that 
the Events Tags panel now contains the Autocross Event 

tag. If you are viewing all media and click the Autocross Event 
tag to make it visible, only the shots tagged will appear in the 
browser window.

10
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We hope that by now you feel like you've had a good 
introduction to what Adobe Photoshop Elements is 
all about. There's a lot more to come on the following 
pages but before we dive in further, we thought it 
would be great to show you a series of quick tutorials 
exploring the vast range of techniques and tools 
available. There's everything, from making a panorama 
from multiple images, to putting pictures inside text. 
Take a look and enjoy the Elements experience.
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The Elements Experience 1

Open Closed Eyes
Now you need not consign a photo to 
the trash just because your subjects eyes 
are shut. Thanks to the latest version of 
Elements, you can tackle the problem with 
ease. If you have another example of a 
face where the eyes are open and they are 
not too different in terms of their colour 
and lighting, you can swiftly replace those 
closed eyes for open ones. This works in 
both the Quick mode and Expert mode.

BEFORE

AFTER
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Open your photo by going to File > Open 
and navigating to where your primary 

photo is kept and either double-click the image 
or select it and press the Open button.

1 Go to Enhance > Open Closed Eyes and 
you will see the Open Closed Eyes dialog 

box. Here you can choose your Eye Source to 
open your subjects eyes with.

2

Just in case, there is a small selection 
that you can try straight away, with two 

female and two male sets of sample eyes, on 
your photo.

3 For best results, find a photo that roughly 
matches the lighting and colours of your 

original photo. You can select Choose from > 
Computer and locate a suitable image.

4

When you have found a likely candidate, 
double-click it to load it as an eye source 

and then click on its thumbnail to apply it to 
your main photo. Click OK when done.

5 The new eyes you found will be mapped 
over your existing image and blended as 

seamlessly as possible. If you like the result, you 
can save it under a new name.

6

63

OPEN CLOSED EYES



The Elements Experience 2

Partial Sketch
Guided edits are a simple, quick and 
fun way to add edits to your photos. 
Have you ever fancied yourself as a 
great sketch artist? Well, with the Partial 
Sketch guided edit, you can instantly 
turn any of your favourite photos into an 
artistic rendering with just a few clicks.  

BEFORE

AFTER
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Open the Elements Photo Editor, go to 
File > Open and choose a favourite photo; 

then go to the Guided workspace. The Partial 
Sketch effect is under Fun Edits.

1 You have four pencil sketch effects to 
choose from. Click one to activate the 

sketch brush. Select Add and use the slider to 
control its size.

2

Paint across your image to reveal areas 
you want to be converted to a sketch 

effect. You can always use the Subtract brush, 
to remove any sketch areas you don't want. 

3 If you want to, you can use the Detail 
Brush to more precisely paint the sketch 

effect on or off your photo, controlling the 
brush size and opacity.

4

An optional effect is to soften any hard 
edges or flip the effect. If you're happy, 

you can select Next and Save your image.

5 With the image still active, you can 
actually go to the Expert workspace and 

continue to work on your photo adding more 
contrast to the sketch layer.

6
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The Elements Experience 3

Replace Background
Hopefully it isn't an exaggeration to say 
that cutting one subject out of a photo 
and transplanting it into another is one of 
the core photo manipulation tasks that 
everyone has encountered or at least 
thought about when perusing their photo 
collection. Well, there is a great Guided edit 
to help you do just that.

BEFORE

AFTER
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In the Guided workspace, you will find 
the Replace Background edit under the 

Special Edits category. Put the photo you want 
to work on in the Photo Bin.

1 Choose from the available tools to select 
your subject. The Quick Selection tool 

should work well on our subject. Drag inside 
the edge of subject to select them.

2

Use the tool options to subtract areas 
that stray outside what is required. Then 

you can use the Refine tool to improve the 
quality of the selection. 

3 Now you can import a photo that will be 
the new background. It will be placed 

behind your main subject. Both subject and 
background can be moved if required.

4

Now you can make further refinements 
to the outline of your subject if you want. 

A soft brush can be used to feather the join 
between the foreground and background too.

5 Click Auto Match Colour Tone to make 
the colours of your subject match the 

background more closely. Now you can save 
the image as a PSD or jpeg.

6
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The Elements Experience 4

Photomerge Panorama
Sometimes, a view is too expansive to capture 
in one photo unless you have some specialist 
super wide-angle lens. Luckily, Elements has a 
Guided edit that can take a series of shots and 
stitch them seamlessly together to create a 
super-wide panorama that can stretch from 
horizon to horizon if needed.

AFTER

BEFORE
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In the Guided workspace, you will 
find Photomerge Panorama under the 

Photomerge category. Place the sequence of 
panoramic photos you want in the Photo Bin.

1 Make sure all your photos are selected 
and choose the type of setting you want. 

In nearly all cases, the Auto Panorama settings 
is fine for standard photos.

2

Make sure the Blend Images Together 
and Vignette Removal boxes are ticked. 

If you want to fill transparent areas then 
choose Content Aware Fill Transparent Areas. 

3 Now you can click the Create Panorama 
button and the stitching process will 

begin. Note that Expert mode is used to stitch 
your images.

4

Once Expert mode has stitched the 
images and filled any transparent areas, 

it returns you to the Guided page to save it or 
continue working on it in Expert mode.

5 In Expert mode you can flatten the image, 
make adjustments to the image and crop 

it if required. Then you can save the result as a 
PSD or other image format.

6
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The Elements Experience 5

Meme Maker
What is a meme, you may ask? A meme 
is an image, video or piece of text that is 
humorous in nature. It is copied and spread 
around the Internet and social media and 
often has slight variations added to it. The 
power of the meme has not gone unnoticed 
at Adobe, so they have introduced the 
Meme Maker as one of their Guided edits 
for you to have some fun with. 

BEFORE AFTER
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In the Guided workspace, the Meme 
Maker is under the Fun Edits category. 

Make sure you have a suitably worthy image 
open and ready to go.

1 We have a funny picture of a monkey 
sticking his tongue out. The first thing to 

do is to click the Create Meme Template button 
to add the basic frame and text.

2

You can type new text using the Type 
Tool and choose any font from the Tool 

Options panel in the lower left of the screen. 

3 Then you can zoom your photo if required 
and flip it horizontally or vertically. Then 

you can choose to add a new border from the 
options available.

4

You can also add more effects to the 
resulting image. You can choose from 

a pop art, black and white and several other 
options. Click on the effect you want to add.

5 Finally, when your meme is ready, you can 
save it, continue to work on it in Quick or 

Expert mode and Share it with the world on 
Flickr and Twitter.

6
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The Elements Experience 6

Multi-photo Text
Creating visual text with a photo inside 
each letter can be a laborious process, 
particularly if you are working with a long 
word. Once again, the Elements Guided 
workflow has a guided edit that can take 
the work out of the process, so you can 
enjoy what you are creating.  

AFTER

BEFORE
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The Multi-photo Text guide is in the 
Fun Edits section. With your chosen 

background photo open, you're ready to then 
click on the Multi-photo Text icon.

1 Use the Type Tool first to add your text, 
alter its style and size using the Tool 

Option panel. You can also specify how it fits 
your photo.

2

When you click the Create Frames 
button, each letter is converted to a 

frame ready for you to click and then select a 
photo to appear in it. 

3 Choose from your computer or your 
Photo Bin and place one image inside 

each letter. Double-click each frame to adjust 
the image size and position.

4

You can add a new background if you 
want by clicking the options available; or 

you can add outlines and drop shadows to the 
text to make it stand out more.

5 Save it there and then or open it in Expert 
mode to work on it further. We made the 

rabbit larger and more visible and then saved it.

6
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The Elements Experience 7

B&W Colour Pop
Converting a photo black and white is great 
for highlighting the text and composition in 
an image to make it more powerful. There is 
a slightly creative option to that, where by 
you convert it to black and white but leave 
a part of it in colour so the object really 
stands out and draws you eye. It is referred 
to as selective colour or in the case of our 
guided edit example, B&W Colour Pop. 

BEFORE

AFTER
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The B&W Color Pop edit is found in the 
Black & White section. Open a photo that 

you want to add the effect to and then click on 
the B&W Color Pop icon to proceed.

1 You can click on one of four presets or of 
you prefer, click on the Select Custom Color 

button and pick the most dominant colour you 
want to remain untouched in your photo.

2

Then, if you increase the Fuzziness 
value, more colours similar to the one 

chosen will become visible again while the rest 
remains in black and white. 

3 You can then use the Refine Effect 
buttons to bring back more areas to 

colour using the Add tool, or remove them 
using the Subtract tool.

4

The Size and Opacity sliders dictate size 
of the brush and how opaque the effect of 

adding colour or subtracting it appears. We're 
bringing colour back at full strength.

5 Paint over areas that you want to be 
coloured again, using a smaller brush for 

finer detailed areas. Finally, you can then click 
Increase Saturation for a more vivid image.

6
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The Elements Experience 8

Zoom Burst Effect
Sometimes you want to add motion to an 
image that is otherwise quite static-looking. 
Elements has a few Guided edits that can 
add a motion effect to your photos to give 
them a little extra punch. The Zoom Burst 
Effect is a digital version of an ages old 
photographic trick where the photographer 
very quickly zooms their lens as they take 
the shot to create streaks within the photo 
to emulate the feel of speed and action.

BEFORE

AFTER

76

THE ELEMENTS EXPERIENCE



The Zoom Burst Effect edit is found in the 
Fun Edits section. Open a photo that you 

want to add the effect to and then click on the 
Zoom Burst image to proceed.

1 The first step is to crop your image so the 
main subject is in the centre of the shot. 

The zoom effect will start from the centre so it 
makes sense to position the image centrally too.

2

Use the crop tool to drag a crop box 
around your main subject. Our example 

is of a motorcycle to which we want to add 
some motion to create a bit more drama.

3 You can then click the Add Zoom Burst 
button and the effect will be added to the 

shot. It mimics a photographic effect where the 
lens is quickly zoomed as the photo is taken.

4

At the moment, the entire image has the 
effect added to it, however, you can use 

the Add Focus Area tool to remove some of the 
effect in a chosen area.

5 We used the Add Focus Area tool to 
bring the rider back into focus to give 

the shot a point of interest. We also clicked the 
Apply Vignette button to darken the corners.

6
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The great thing about Adobe Photoshop Elements 
is that it can cater for all skill levels when it comes to 
image editing, digital manipulation and creating new 
works of art. Whether you are a complete novice who 
is starting out and wanting to learn the ropes or an 
experienced digital artist who needs more advanced 
tools to complete their project, Photoshop Elements 
has all the power and sophistication you need to get the 
most out of your photos.   
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Create New Layer
You can click the Create New Layer 
button at the top of the layer panel, use 
the key broad shortcut or go to the file 
menu and choose Layer > New > Layer 
to add a new layer to the stack. You will 
be prompted to name the new layer. You 
can rename it at any time.

Create New Group
Sometimes it may be necessary to take 
a number of layers and group them 
to make things more manageable, as 
the number of layers increases in your 
document. You can highlight each layer 

The use of layers has become the 
very core of image editing since its 
introduction in the early '90s. As 

you might imagine, layers are exactly 
what they sound like. You can have a 
number of separate elements, each 
on its own layer, that are stacked one 
on top of the other. When all viewed 
together, they create the final image. 

The advantage of using layers is clear. 
It means you can change an element 
on one layer only and not have an 
impact on the rest of the image. It also 
means that you can take an image 
and duplicate it on another layer and 
perform any edits you want on that one 
in the knowledge that the base image 

A Guide to
Using Layers
Layers are one of the fundamental aspects you can employ when it 
comes to non-destructive image editing.

YOUR GUIDE TO IMAGE EDITING

1

2

will remain untouched in case it doesn't 
turn out quite as you had hoped. Within 
Elements, there are four main types of 
layer. There is the basic pixel layer which 
contains the main photo elements of the 
project. There are text layers where you 
can type text and change the size and 
colour. Then there are fill/adjustment 
layers that are designed to affect the 
layer below it such as changing the 
saturation or brightness of the layer 
below, or just adding a colour to that 
layer. Finally there are vector layers that 
contain scalable graphical elements such 
as shapes and work paths. Each layer 
type can also have a mask added to it so 
only part of that layer can be seen. 
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you want and then press the Create 
New Group button to group them. 
Alternatively, you can go to the file menu 
and select Layer > New > Group

Fill or Adjustment Layer
Fills and Adjustments allows you to add 
colours, gradients and patterns to a layer. 
They also allow you to add adjustments 
such as Brightness and Contrast, Hue and 
Saturation and Levels. Adjustment layers 
affect the layers directly beneath them in 
the stack or they can be clipped to the 
one layer directly below them only.

Add Layer Mask
Each layer you use in a document can 
have a layer mask added to it. The mask 
is designed to let you hide or reveal 

specific parts of that layer only. Areas 
of the mask in white let the layer remain 
visible, while any areas of the mask in 
black hide that part of the layer. The 
rule of thumb is: white reveals pixels and 
black conceals them.

Lock all Pixels
Clicking this button locks the layer 
completely and no further edits can be 
made to it. You will also be unable to 
reposition the image on a locked layer.

Lock Transparent Pixels
If you click this button, any area of a 
layer that has no image pixels in it is 
considered transparent. An area that is 
transparent is then locked and no edits 
can be made so it remains transparent.

Delete Layer
The trashcan shaped button lets you 
delete any selected layers if you wish to 
remove them from the layer stack.

Panel Options
There are a number of menu options 
available here such as Rename Layer, 
Duplicate Layer, Delete Layer, Link 
Layers, Merge Visible and Merge Down.

Blend Modes
Blend Modes determine how the image 
colours on the layer interact with the 
layer below it. It can be changed for 
every layer individually or as part of a 
group for certain visual effects.

Visibility
The small eye icon on the left of each 
layer lets you turn that layer off so it is 
not visible. Any effects associated with 
that layer are also rendered invisible until 
the eye icon is clicked once more.

Link/Unlink Layers
This lets you link a number of layers 
so that any transformations and move 
commands you make are all applied to 
the linked layers at the same time.

Background
The Background layer is the default 
bottom layer. Whether it is an image 
you have opened or a new document, 
the Background layer is always partially 
locked until you choose to unlock it.

 
Standard Layer

A typical layer with pixel information 
displayed on it.

 
Adjustment Layer

An adjustment layer is designed to affect 
the layer below it. In this example, we 
have a Levels adjustment that alters the 
brightness and contrast of all the layers 
stacked below it.

Vector Layer
A vector layer contains scalable data 
such as shapes in the case of our 
example. A small icon in the lower right 
corner of the thumbnail indicates it is a 
scalable graphic.

Text Layer
The thumbnail of a Text layer displays a 
T to indicate the layer contains scalable 
text. The layer name also reflects 
whatever text is on that layer.

A GUIDE TO USING LAYERS
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Methods for 
Adjusting an Image

We start in the Quick mode workspace with a sunrise 
image of a pier that is in need of some work to make it 

look its best. The first thing to do is remove that large black spot 
in the top right corner: probably a bit of mud stuck to the lens, 
currently spoiling the shot.

1 To remove such a blemish, you can go to the toolbar and 
choose the Spot Healing Brush Tool (J). When you choose 

this tool, the Tool Option panel displays Spot Healing Brush 
options. You can choose Spot Healing Brush or Healing Brush to 
remove the spot.

2

The main difference between the two brushes is that the 
Spot Healing Brush lets you paint directly over the blemish 

and then works out what to fill it with by analysing the area 
around it. Proximity Match and Content Aware are the best 
options here for this kind of blemish.

3 The Healing Brush Tool asks you to select an area to be 
the clone source by clicking on a clean part of the image 

next to the blemish. This chosen area will then be cloned over 
the blemish when you paint over it. The cloned source will be 
blended in to be as seamless as possible.

4

When it comes to methods for adjusting your images in Elements, you 
are spoilt for choice. There are a number of methods to get an image 
looking great. We'll show you how each one works, with some examples, 
to help you choose which method suits you best.

Quick Mode
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You can alter the brush size by using the Size slider in 
the Tool Options panel or by pressing the left and right 

bracket keys. Pressing [ will reduce the size of the brush and 
pressing ] will increase the brush size. This lets you clone with 
greater accuracy and detail if you need it.

5 Now that the blemish is gone, we can look at making 
the image more vibrant and appealing. Layers are not 

available in Quick mode, so it comes down to choosing the 
right method for the best overall effect. The easiest way to see 
the effect you can have on the image is to choose Adjustments 
from the taskbar.

6

This calls up the Adjustments panel. You can choose 
Smart Fix and select from a number of options that make 

subtle changes to the image and recover detail in the highlights 
and shadows. Hover over each one to see a preview of the 
effect applied to your photo. Click the one you want to apply.

7 Next, you can go to the Exposure adjustment and 
choose to make the image brighter or darker. Again you 

can hover over a number of options and see a preview of the 
effect or use the slider to make more subtle adjustments to the 
brightness of the image.

8

The Lighting panel is the key to really controlling the 
brightness of your Highlights, Midtones and Shadows, 

each of which has its own tab for you to access. Choose from 
the options provided or use the sliders for more subtle control 
of each of the tonal options.

9 The vividness of your image can be controlled in the  
Colour panel. Increase the Saturation globally or use 

Vibrance to increase the most subdued colours first. Hue lets 
you shift the entire colour palette for a surreal colour effect if 
you require it.

10
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Under the Enhance menu are a number of Auto features to 
improve your image. These are quite broad in their effect 

and do lack a certain finesse, so you have no real control over the 
outcome. If you want some more input in the effect there are a 
couple with a bit more control worth looking at.

13 If you go to Enhance > Auto Smart Tone (Shift + Cmd + T) 
an interactive panel appears, where you can drag a cursor 

around a grid. Each corner of the grid shows a possible outcome 
that can be achieved by moving the cursor further in that 
direction. Move it around until you get the result you want.

14

If you go to Enhance > Adjust Colour > Adjust Colour 
Curves, you can adjust the Highlights, Midtones and 

Shadows of your image. There are a number of preset styles you 
can choose from to enhance the colour in your image as well as 
the option to manually adjust the tone sliders.

15 Another option, but one that needs a light touch, is the 
Haze Removal tool. Go to Enhance > Haze Removal (Shift + 

Cmd + Z). This can be quite a strong effect but there are sliders 
to adjust the strength of the Haze reduction applied and also the 
sensitivity of the haze detection.

16

Balance lets you shift the colour temperature from cold 
to warm and Tint allows you to add either an increasingly 

green colour cast or a magenta cast to help offset any colour 
inconsistency in your original image. 

11 Finally, you can go to the Sharpen panel and apply levels of 
sharpness to your image; but beware of overdoing it and 

creating artefacts and halos as the contrast increases and bright 
unwanted highlights appear around areas of high contrast in your 
photo. If you are happy, you can save the result.

12

Quick Mode Auto Modes
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Guided Mode is an alternative if you are happy to have less 
advanced adjustment options available but with more step-

by-step guidance to help you on your way to creating the final 
image. Make sure you have an image open in the Photo Bin ready 
to work on.

1 The great thing with Guided edits is that you don't have to 
apply just one edit. We are going to apply several to get 

the end result we are after. Start with Levels to get the overall 
brightness of the image dialled in first. Levels can be found in the 
Basic category.

2

You will be asked to create a Levels adjustment and a 
dialog panel will appear. Click OK. Since the image has a 

lot of underexposed dark areas in the foreground, sliding the 
Midtone slider to the left will brighten the photo in those darker 
areas. You can then click Next and then Done for this part.

3 Now, if you look in the Photo Bin, back at the main Guided 
Home screen, the photo will have a small icon in its top 

right corner that indicates it has edits applied. Then, you can go 
to the Colour category and choose Enhance Colours to add more 
vividness to the photo.

4

You can use the three sliders of Hue, Saturation and 
Lightness to make the image much more saturated and 

bring out the colours in the sea, sky and foreground. A boost of 
Saturation to 45 and Lightness to -2 is enough to bring more life 
into the photo. You can lick Next and Done once more.

5 Finally, back in the Basics category, click Lighten and Darken 
and use the three Shadows, Highlights and Midtones sliders 

to make final tweaks to the image. The Highlights have been 
reduced to bring more detail back into the brightest areas. At this 
point you can click Next and then save your image.   

6

Guided Mode
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We have opened another image that needs some fixing. It 
is a sunrise on the moors that is a little underexposed and 

needs some work to bring out the foreground, while keeping the 
sky relatively untouched, since that is quite well exposed. This is 
where the use of layers and masks will help us out.

1 First, the colour balance needs to be adjusted. The image 
is a little too magenta and warm, particularly if you look 

at the colour of the grass. This can be altered  by using a really 
simple trick that can be really effective and requires the use of 
layers to do it.

2

Press Cmd + J to copy the Background layer. Name the 
new layer 'remove cast'. Then go to Filter > Blur > Average. 

This will blur the duplicate of the scene and average out the 
colours it contains into one colour. In this case, it turns a muddy 
brown colour.

3 Make sure this layer is active then go to Filter > 
Adjustments > Invert (Cmd + I) to invert the muddy brown 

colour to a pale green hue instead. This colour, derived from 
the colour average of the original scene can be used to create a 
colour correction filter.

4

Using the Photo 
Editor Expert Mode
Don't be put off by the title of Expert. In this case, you get more tools to 
play with and you can actually be more involved in the editing process. 
You can switch out to another mode, but to truly unlock the power of the 
program, you will want to try out some image editing in this mode.
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Go to the Blend Mode button and from the dropdown 
menu that appears, choose Overlay as the blend mode for 

the 'remove cast' layer. This will blend the colour of that layer into 
the photo of the moors below it. You should see that the snow 
now looks a lot cleaner and whiter than it did.

5 Altering colour can be quite subjective and if you feel 
that the correction is too much, you can always go to 

the Opacity slider and adjust to about 80% to lessen its effect 
slightly if you wish. Now you can continue editing the image.

6

Now to make the image punchier, click the Create New 
Fill or Adjustment Layer button and choose Levels. Make 

sure 'Levels 1' is at the top of the layer stack. Adjust the Midtone 
slider so the sky is a bit darker. This will obviously make the entire 
image too dark but you can fix that next.

7 Choose the Brush Tool (B) from the toolbar, then set the 
foreground colour to black. You can press D to default 

the colours so black is the foreground  colour and white the 
background colour. Pressing X will swap those foreground and 
background colours over if you require.

8

When you choose the Brush Tool, the Tool Options panel 
will display parameters for the brushes. We need a large 

soft brush which can be chosen from the Brush Presets menu. 
Click on the Soft Round 200 pixels brush to make it active. Make 
sure the Levels 1 layer mask is active by clicking it. 

9 You can now use that soft black brush to paint on any areas 
of the mask where you do not want the adjustment to be 

visible. In this case, we only wanted the sky to be adjusted so we 
painted over the rocks and foreground.

10

87

USING THE PHOTO EDITOR EXPERT MODE



Just as you did with the 'Levels 1' layer mask, paint with 
your soft black brush on the 'Levels 2' layer mask over the 

sky area and horizon. You are now concealing areas of the 'Levels 
2' adjustment so the sky goes back to being darker again.

13 If you want, to blend the masks better, you can keep 
the 'Levels 2' layer mask active and go to Filter > Blur > 

Guassian Blur and choose a blur of about 125 pixels to help blend 
the two adjustments you've made seem more seamless.

14

There is no reason you can't add the same amount of blur 
to the 'Levels 1' layer mask as well. The softening of the two 

masks means there are no obvious joins betraying the fact that 
various adjustments have been made. Thanks to the use of layers, 
this has all been non-destructive editing.

15 Now that you have both the Levels Adjustments in place, 
you can revisit them at any time and tweak the settings to 

your heart's content. You can even go back into the layer masks 
for each and use your brush tools to refine those masks you 
applied in the first place.

16

When you paint over those areas, you are hiding the 
adjustment so they become their original brightness again. 

In fact, it would be nice to make the foreground rocks and snow 
brighter, so let's get another Levels Adjustment and add it to the 
layer stack. This will be 'Levels 2'.

11 Push the Highlights and Midtones sliders of the 'levels 2' 
adjustment to the left; as you do this, you will see the entire 

image become lighter. Concentrate on the foreground rocks and 
snow and adjust the sliders until they look nice and bright. The 
sky might be too bright but not to worry.

12
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The image has now been colour balanced and two sets of 
adjustments have brought some sparkle to the snow in the 

foreground and kept the sky dramatic in the background while 
the rocks now have some nice detail showing in them as well.

17 Now let's turn up the vividness of the image. Click on the 
Create New Fill or Adjustment Layer button and choose 

Hue/Saturation from the list that appears. A 'Hue/Saturation 1' 
layer will be added to your existing layer stack. Make sure it is the 
topmost layer.

18

How much Saturation you add is a matter of personal taste 
but to capture the glorious colours of that sunrise, it's been 

pushed to +36. You will notice however that the grass could do 
with a little push to make it more vibrant.

19 Click the Channel button and you will see how you can 
affect the saturation of the component colours. Select 

Yellows and dial up the saturation and push the Hue slider to 
about +23 to really bring out the vibrant green of the grass.

20

At this point, you may want to perform more edits to the 
image. It is always good housekeeping to create a snapshot 

of the work done thus far. To do this, press Shift + Alt + Cmd + E. 
This creates a new layer which is a merged version of all visible 
layers. Name this layer 'merged'.

21 You can now perform edits directly to the pixel data of the 
'merged' layer, safe in the knowledge that if anything goes 

wrong, you still have all the original work on the layers below 
which you can use to create another merged version. You can 
also save your document as a PSD file when complete.

22
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This tool lets you make selections of square or rectangular 
areas of your image. In addition to making the selection, 

you can add to it, subtract from it and intersect with it. You can 
make selections of a fixed size, fixed ratio or normal aspects. You 
can also feather and refine the edge.

1 The Elliptical Marquee tool behaves in the same way as the 
Rectangular Marquee tool and has the same tool options 

available. You can make circular and elliptical selections of any 
size or proportion. If you hold the Alt key, you can centre your 
ellipse over the cursor position.

2

The Lasso tool can be used to make area selections from 
your image or active layer. The shapes you select with the 

Lasso tool can be completely irregular and hand drawn. When 
you join the lasso back up to the point where you started, the 
selection is closed.

3 This tool uses edge detection to adhere to the edge of the 
subject you are attempting to select in the image. You can 

alter its parameters for more accurate detection in order to make 
it snap to the edge of your subject. Areas of high contrast work 
best with this tool.

4

Selection
Tools
Some aspects of image editing will require you to select certain areas of 
a photo so you can either place it on another layer or edit it in isolation 
from the rest of the image. With Elements, you have a number of options 
for being able to achieve this and we cover them next.

Rectangular Marquee Elliptical Marquee

Lasso Magnetic Lasso
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The Polygonal Lasso allows you to draw point-to-point 
straight lines around your subject. This is good for 

geometric and straight-edged subjects where a perfectly straight 
line is required. Like the Lasso Tool, when you join back up with 
your start point, the selection is closed.

5 The Quick Selection tool lets you paint a selection as if it 
were a brush. It uses edge detection to attempt to match 

your selection to the nearest edge in the image. You can alter 
brush size and settings and it works best on high contrast 
subjects that are in sharp focus.

6

The Selection Brush is more of a freeform brush that lets 
you choose a brush type of certain size and hardness 

and paint a selection around your chosen subject. You can also 
choose to make it a mask instead. You can add or subtract from 
your selections in the usual fashion.

7 This tool is useful for the selection of image areas that 
are the same colour and brightness. You can adjust its 

sensitivity, refine its edge and also choose whether it will globally 
select all areas of a chosen colour or just its nearest neighbours.

8

The Refine Selection Brush lets you make targeted 
adjustments to an existing active selection. In additional to 

adding or subtracting from the selection you can actually push the 
selection edge and smooth it by applying the refinement brush.

9 This works in a similar way to Quick Selection except that 
you use Rectangular and Elliptical Marquees and the Lasso 

and Polygonal shapes to enclose an area for edge detection to 
work within. It works best with well-defined shapes that have 
good contrast.

10

Polygonal Lasso Quick Selection

Selection Brush Magic Wand

Refine Selection Brush Auto Selection
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Red-eye is caused by light from the flash of a camera 
reflecting off the blood vessels at the back of the eye when 

the pupil is wide open. If you happen to find a favourite photo 
where your subject has red-eye, then it is a simple process to 
remove it.

1 Click the Eye Tool (Y) and simply click your cursor over the 
offending redness in the eyes of your subject. The tool will 

remove the redness and you can alter Pupil Radius and Darken 
values to make sure the red has been completely removed. It can 
also be set for Pet Eye as well.

2

Another great function available in the options panel is the 
function to open closed eyes. Click the Open Closed Eyes 

button to activate the dialog. The image will scan for closed eyes 
and circle possible candidates. Choose the one you want. You 
can then choose a set of open eyes to merge into the shot.

1 Eyes that closely resemble your subject will work best or if 
you have another image where the eyes are open, you can 

load that and the program will automatically apply those open 
eyes to your current image.

2

Cloning, Healing
and Enhancing
Even with modern digital cameras, a lot of photos may have 
imperfections in them; for instance with dust contamination. This will 
be displayed as a black smudge on the final photo. Removing these 
blemishes is quite easy. The technology can also do much more. 

Eye Tool

Closed Eye Correction
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The Spot Healing Brush is great at removing dust spots 
from photos and  is also great for removing spots from 

humans too. If you have a portrait and the subject has some 
unwanted blemishes, you can use the Spot Healing Brush to click 
on the spot and it will use nearby pixels to fill the area.

1 You can choose between Proximity match, Create Texture 
and Content Aware. For most of your subjects, you may 

find that you are switching between Proximity Match and 
Content Aware. You can adjust the brush size for smaller spots. 
With care, most blemishes and wrinkles can be removed easily.

2

The Healing Brush is an older version of the Spot Healing 
Brush. It requires you to specify a sample point of a similar 

clean texture which is then cloned over your chosen area much 
like a Clone stamp when you click on the target blemish or 
wrinkle you wish to remove.

3 When it comes to Healing Brush techniques, you will find 
that subtlety is the key. Spot Healing is not perfect and may 

require several attempts to get it right. Avoiding too many repeat 
patterns is important to avoid creating a texture that doesn't look 
like it has been cloned.

4

The Smart Brush uses edge-detection to allow you to brush 
areas of your photo and apply different effects to those 

areas. When you select the Smart Brush Tool (F) the options 
panel has an effects picker to let you choose which effect you 
want to apply to your photo.

1 Choose an effect such as a pencil sketch effect and begin 
to drag your brush over the image, where you want the 

effect to be seen. You can change brush size and settings such as 
hardness and roundness and subtract from the current selection. 
Choose the Detail Smart Brush for more refined selections.

2

Spot Healing Brush Tool

Smart Brush
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Here is a wildlife photo from which we want to remove the 
distracting blades of grass that are sticking up to the right 

of the rabbit. This is a good example of how cloning can quickly 
remove elements from your photos with minimal effort.

3 Press the Alt key and select an area right next to the tip 
of the grass as the source of your cloned pixels. Now you 

can clone that area over the blades of grass. If the colours don't 
match, you can reselect an area that more closely matches and 
doesn't stand out as cloned.

4

Work you way down the grass stem, you can change the 
size of the brush at any point by pressing the left and right 

bracket keys on your keyboard. Take your time and don't be 
afraid to keep selecting new clone source points so the colours 
match the background when you clone out more of the grass.

5 One thing that really gives cloning away is a repeating 
pattern. If you see a pattern building up, you can press 

undo (Cmd + Z) to step backward though your last performed 
actions and change your clone source again to avoid the 
repetition of that pattern.

6

After the Healing Brush Tool, the Clone Stamp Tool (S) 
will seem quite familiar. It copies pixels from one area onto 

another to remove things from your photos. Despite recent 
advances with the Content Aware and Spot Healing Tools, it 
remains one of the best ways to remove things from a photo.

1 Select the Clone Stamp Tool (S). In the options panel, you 
will have a number of paramaters to choose from such as 

Size, Opacity and Blend Mode. The Aligned button, when ticked, 
links to and moves your source point as you move your cursor. 
Unticked, it uses the same source point each time.

2

Clone Stamp Tool
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In the options panel, you also have the Pattern Stamp 
available. As the name suggests, you can use this tool to 

apply a preset pattern to your image. Click on the pattern picker 
and choose the pattern you want to apply to your photo.

7 You can change the Pattern Stamp's Size and Opacity as 
well as the Blend Mode. Choosing Soft Light, for instance, 

allows a softer blend of the pattern into the image. Click 
Impressionist to turn the patterns into paint dabs for a more 
artistic effect.

8

The Blur Tool (R) is a fairly self-explanatory tool for adding 
blur to specific areas of a photo. You can choose a brush 

type and alter its Size and Strength values for a subtle or intense 
blurring of your subject.

1 The Sharpen Tool (R) uses a brush tool to apply sharpening 
to your image. Like the Blur Tool, it is a more targeted 

method of adding sharpness to a photo. Choose your brush type 
and alter the Size and Strength values to get the desired effect.

2

Approach sharpening with caution since it is very easy to 
overdo it and ruin an image with over sharpening. Make 

sure the Protect Detail button is ticked and begin to apply the 
sharpening effect. 

3 The Smudge Tool (R) can be used to smear the pixels of 
your photo across the screen for a creative effect. Just 

like Sharpen and Blur, you can alter the brush type and set the 
Size and Strength of the effect. The Finger Painting button adds 
colour to the smudged pixels.

4

Blur, Sharpen and Smudge
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Click and drag the Sponge Tool over the areas you 
selectively wish to Saturate or Desaturate. Continue to 

brush the areas to increase the amount of the effect you are 
applying. In this example, brushing using the Desaturate option 
eventually turns the affected areas to grey.

3 The Dodge and Burn Tools are named after the 
techniques that were originally used in traditional film 

processing darkrooms. Dodging refers to selectively making 
areas lighter in an image and Burning is the opposite effect of 
making images darker.

4

The Sponge Tool (O) has two Mode settings of Saturate 
and Desaturate. You can control the Size settings as well as 

the Flow of the effect you are adding to your image. You can also 
set the type of brush you want to use to apply the effect.

1 It's a simple tool for adding targeted saturation or 
desaturation to the photo. It is recommended to set the 

Flow of these brushes to about 10%. Then gradually build up the 
application of colour saturation, the removal of colour entirely or 
just lessen the vibrance of areas in the photo.

2

Sponge, Dodge and Burn
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The Burn Tool will selectively make parts of your photo 
darker. You can darken the Highlights, Midtones and 

Shadows by clicking the Range button again and adjusting 
the Size and Exposure settings of the brush. Subtlety is key to 
making it work, so Exposure settings of 10% are a good start.

7 Now you can brush over areas that you want to be darker 
and create more contrast. Since this particular method is 

a destructive one, in that you are altering pixels, duplicating the 
base layer and working on a copy is a good way to avoid losing 
the original.

8

The Dodge Tool can be used to lighten images. Use the 
Range button to determine if you are affecting just the 

Highlights, Midtones or Shadows in your photo for greater 
control of the final result. Again, using very low Exposure settings 
around 10% is recommended.

5 You can selectively brighten areas of the image that you  
want to make lighter. These tools work better for images  

that start with lower amounts of contrast to begin with. High  
contrast images will have less need for these kinds of adjustments.

6
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The Brush Tool (B) is one of the most often used tools 
in the photo editor's arsenal. Whether you are painting 

directly over a photo, or adding brush strokes to a layer, the 
Brush Tool is designed to behave like its real world counterpart 
but with more powerful features built in.

1 When you click on the Brush Tool, the options available are 
quite varied. You can control brushes with your mouse or if 

you use a tablet, you can control it as if it were an airbrush with 
pressure sensitive effects for more artistic flair. 

2

You can choose any number of brush types from the brush 
picker and alter the Size and Opacity values. You can also 

load new brushes that can be purchased and downloaded from a 
large number of vendors specialising in photo editing tools.

3 You can choose the colours you  brush with and also use 
the Brush Settings sliders to change how much the colours 

fade and alter with each brush stroke. You can also tell the brush 
how much Scatter or Spacing to use with each brush stroke you 
apply. Tablet settings are also available.

4

Draw, Fill,  
Shapes and Text

Brush Tool

The Draw section of the toolbar contains various elements to let you 
paint, draw, erase and sample colours in your images. There are also a 
number of text options available for adding text effects to your photos 
and making masks in the shape of any text that you type.
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Next to the standard brush is the Impressionist Brush Tool 
(B). Using its various Brush Settings you can turn your 

photo into a painting much in the style of the old impressionist 
painters whose works were rendered as a series of dots, strokes 
and swirls.

5 When you paint with this brush, the image beneath the 
cursor is turned into a series of loose curls, swirls and 

daubs. The larger the brush size you use, the more abstract the 
image becomes. Using a brush that is too large will render the 
photo unrecognisable.

6

The next brush is the Colour Replacement Tool (B). Select a 
foreground colour in the toolbar to use as the replacement 

colour. Once again, you have a number of tool options available 
including Size, Tolerance and Limits.

7 Our example picture is of an owl set against a green 
background. The colour of the background can be replaced 

fairly easily since the owl itself contains no strong green colours 
that match the background too closely.

8

The Colour Replacement Tool works by continuously 
sampling the colour directly under the cursor position. The 

colour beneath the cursor will then be replaced with whatever 
you have chosen as the foreground colour. You can select the 
Blend Mode used to effect how the replacement colour is applied.

9 In the case of the owl image, dragging the Colour 
Replacement Tool over the green areas next to the owl 

replaces that colour; but the owl remains untouched since it is not 
the same colour as the colour beneath the crosshair of the tool.

10
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The Background Eraser Tool (E) is a useful one for targeted 
removal of certain parts of an image. It behaves a little like 

the Colour Replacement Tool but in this case, any pixel colour 
beneath the cursor is erased, leaving the area transparent when 
it's on a layer.

3 You can alter the Size and Tolerance of the brush, as well as 
the softness and spacing of the brush you use. Tolerance 

is key to setting the sensitivity of the brush to changes in colour. 
High Tolerance will mean more varied colours are removed under 
the cursor position.

4

In our example, the blue can be removed sky from the 
photo by placing the cursor over the blue areas to be 

removed. As you click and drag the mouse, any blue that falls 
under the cursor position will be removed, but the white clouds 
remain untouched since they are not blue.

5 The Magic Eraser (E) is a more global erasing tool. Set your 
Tolerance higher for more colours to be included or lower 

to pick out less shades of the target colour at the cursor position. 
When you click on the blue sky, large swathes of that colour will 
be removed with each click of the mouse.

6

Much like its real world counterpart, the Eraser Tool (E) 
removes pixels from your image. Whatever colour you have 

chosen as the background will be used to erase pixel data from 
the photo as if it were a solid coloured brush. You can also set 
the Size and Opacity of the eraser. 

1 If the photo is on a layer, then erasing pixels will reveal 
transparent areas instead. Again, if you alter the Size and 

Opacity of the Eraser Tool, those transparent areas can either 
be fully transparent or partially transparent, depending on brush 
opacity settings.

2

Eraser Tool
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The Paint Bucket Tool (K) allows you to fill areas with solid 
colours. You can set Opacity, Tolerance and Blend Mode. 

High or low Tolerance settings mean it will use edge detection to 
decide which areas can be filled or ignored.

1 You can fill and entire layer, or it can be used to fill specific 
areas based on what edges it encounters. Our example 

has a cartoon character on a white background. His outline is 
quite well-defined so clicking with the paint bucket means the 
background can easily be filled with a colour.

2

You will notice there is an option for Contiguous fill. If it is 
ticked, only the nearest neighbouring colours will be filled. If 

the Contiguous button is unchecked, then all matching colours in 
the image will be filled, no matter where they are in the photo.

3 In addition to the Paint Bucket, you also have the Pattern 
Fill option. Once again you have Tolerance settings and 

Opacity values to alter. Choose a pattern and use that to fill an 
entire layer or in the case of our cartoon, the blank background 
can be filled with texture.

4

The Gradient Tool (G) lets you fill areas of your image or 
entire layers with colours that fade from one to another or 

can fade from one colour to transparent. The Gradient Tool does 
not use edge detection. If you need a filled shape, it needs to be 
defined by a selection.

1 You can pick the kind of gradient you want to use by 
clicking on the Gradient Picker and choosing a preset from 

the list. They range from Foreground to Transparent to multiple 
colour gradients all at the click of a button.

2

Paint Bucket Tool

Gradient Tool

101

DRAW, FILL, SHAPES AND TEXT



If you want to make your own gradient, you can click on 
the Gradient Editor and add what are known as Colour 

Stops to a basic gradient, change their colour and define if they 
are solid or transparent. Any custom made gradients can be 
saved as a preset.

3 Our example of a camera on a white background could 
use some colour. The background has an active selection 

around it to enclose the gradient when it is added. You can click 
and drag your cursor to draw out a start point and an end point 
for the gradient to follow.

4

When you let go of your mouse, the current gradient will 
be applied and fills the active selection around the camera. 

The default Gradient Type is linear, meaning that the gradient 
travels in a straight path from start colour to end colour.

5 If required, you can change the type of gradient you are 
using from its default. You can also use Radial gradients, 

Angle, Reflected and Diamond gradients. They can all have their 
Blend Mode altered as well as Opacity. They can be reversed and 
Transparency and Dither turned off.

6

The Colour Picker (I) does as the name suggests. When you 
choose this tool, it gives you a small eyedropper cursor that 

when clicked on a photo, picks the colour beneath the cursor 
position and makes it the active foreground colour.

1 You can choose whether it samples a single pixel or a 3 x 
3 average or a 5 x 5 pixel area to create an average. The 

colour it samples can be across all layers or a single layer.

2

Colour Picker
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Choose from a number of predefined shapes and add them 
as vector shapes on a new layer. Choose their colour and 

Layer Style from the Style picker. You can also choose whether 
they are of fixed size or unconstrained and if you add to a shape 
or subtract from it.

1 Once you have chosen your settings, you can draw out 
the shape on your photo. You can click and drag from the 

corner outwards or choose From Centre to draw the shape out 
from the cursor position. The shape will fill with your chosen 
colour when you let the mouse button go.

2

The Horizontal Type Tool (T) gives you a multitude of text 
options. Choose your font, its colour and size. You can then 

type on your document and a new text layer will be added above 
your photo. The text can be manipulated and bent into a curve or 
other shapes for creative effects.

3 You also have vertical text options, text for masking and 
the ability to fit typed text to a shape or path. Our example 

shows a butterfly's outline with sample text following the outline 
of that shape.

4

The Pencil Tool (N) is designed to act like a real world pencil 
and is a hard-edged tool that has a number of preset pencil 

tip shapes to draw with. You can choose the Size, Opacity and 
Blend Mode for your pencil strokes along with its colour.

1 You are then free to use your mouse or tablet, to sketch and 
draw with your pencil as you see fit. You can draw directly 

over your existing image or create a new layer and draw on that 
so as to preserve your original image. 

2

Custom Shape Tool

Pencil Tool

Horizontal Type Tool
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The Crop Tool (C) is the most common method of cutting 
areas of your photo off in order to change the composition 

and proportions. When you click the tool, the options panel will 
display some suggestions for you as to how it thinks the image 
can be cropped. You can use those or make your own crop.

1 You can use set proportions to crop or you can go it alone 
with no restrictions and make your own crop. Simply click 

and drag your mouse across the area of the scene that you want 
to be cropped and a gridded box will show you the current crop. 
You can click the green commit arrow to proceed.

2

Within the crop tool options you also have the Cookie 
Cutter Tool (C), which lets you cut out images using a 

number of preset shapes. You can choose from all the available 
shapes such as butterflies, snowflakes, graphic symbols and 
much more.

3 With your shape chosen, you can drag it over your image 
and scale it to cover the area of the photo you want to 

crop. If you tick the From Centre button in the optional panel, the 
shape will be drawn outward from your cursor position. You have 
the option to feather the crop if you want.

4

Modify, Crop, Move 
and Recompose

Crop Tool

The Modify section of the toolbar contains a set of tools that give you the 
ability to crop in a number of ways and to scale your images but protect 
certain parts from being affected during the scale. You can also move the 
subject of your photo from one part of the scene to another.
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If you hold the Shift key as you drag, you can keep the 
shape's proportions locked. When you let go of the mouse, 

the image will be cropped in your chosen shape. You then have 
options available that let you Rotate, Scale and Skew the shape 
until you have it how you want it.

5 The Perspective Crop Tool (C) lets you draw a crop box 
around a specific part of your photo that is distorted and 

gives you a chance to crop and remove the distortion at the 
same time. You start by drawing a crop box around the area you 
want to crop.

6

You can then begin to manipulate the crop box to match 
the perspective of the object you are cropping. Use the 

control points around the crop box to drag the box out to match 
the subject. In our example, the road sign gives us some helpful 
straight lines to match the perspective.

7 When you click on the green commit button shaped like a 
tick, the Perspective Crop Tool will crop and stretch out the 

image, removing the distortion. It may take a couple of attempts 
but it can help you rescue some tricky, distorted images.

8

The Recompose Tool (W) uses content aware scaling 
technology to let you scale images to a different 

proportion, but only scale areas with no detail. You can also 
select areas to remain untouched by the scaling process for a 
much better final result.

1 Here is an example of a rally car with a lot of empty space 
to the right. It could be cropped but this image provides 

a good excuse to try the Recompose Tool. The options panel 
displays a number of tools to help you with the scaling process.

2

Recompose Tool
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You can use the Mark For Protection brush to highlight 
areas that you want kept intact and untouched during 

the scaling process. Similarly, you can also make areas that you 
want removed. You can adjust brush Size and Threshold and 
any scaling restrictions you wish to apply.

3 Once you have marked out your image and have either 
selected areas to protect and areas to remove, you can 

click and drag on the control points around the perimeter of the 
image. In this case, we are going to drag the right middle control 
point inwards.

4

You can begin to drag the control point inwards and as 
you do, all the areas that are unprotected will concertina 

together and the program will attempt to blend that pixel data 
together. The areas that are selected to be protected will not be 
crushed together.

5 The control point can be dragged all the way across the 
image. All the dirt and dust on the right of the image has 

been merged into the space that remains now the image is half 
the width it was originally, but the car is unchanged.

6

the Content Aware Move Tool (Q) uses similar technology 
to the Recompose Tool but in this case it lets you move 

an object in your photo and place it elsewhere in the shot and 
blends it back in and fills the original gap left by the subject.

1 The options panel gives you some simple tool parameters. 
You will need to draw a selection around the object in 

the photo you wish to move. You can add or subtract from the 
selection you've made by using the New, Add, Subtract and 
Intersect options provided.

2

Content Aware Move Tool
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With the tool active, you can draw around the subject 
that is going to be moved. Be aware that areas with 

complex content can be a challenge and the area you move 
your subject to needs to be of a similar texture and colour for it 
to work properly.

3 Enclose your subject in a selection and then drag it to its 
new location. The Healing slider controls how aggressively 

it tries to blend the image into the new location and also fill the 
gap it leaves behind. The Mode can be altered from Move to 
Extend to stretch your selection if required.

4

The Content Aware Move Tool will blend the image 
together. It can be a hit and miss process and may require 

the settings to be tweaked. You can also try selecting more of 
the area around your subject for more blend data to be used.

5 We tried the sailboat image and also a simple object on 
grass. The grass image yielded better results after a few 

attempts but it still needed some cleaning up with the Clone 
Stamp Tool to remove some obvious artefacts and blend in some 
untouched grass.

6

The Straighten Tool (P) will easily take care of wonky  
landscape photos and get them level again. You have a  

number of options as to how the image is handled once  
straightened. The canvas can grow as required when rotated,  
stay the same size or be cropped to remove the background.

1 Simply click and draw along a slanted horizon line that 
needs to be level. When you let go of the button the 

horizon will be levelled. There is an option to Autofill Edges. 
When the image is rotated, any blank areas will be filled with 
nearby similar textures.

2

Straighten Tool
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Now that you've experienced what Elements has to 
offer and how the major tools work, it's time to try out 
some more involved projects to help you hone your 
skills. The Quick and Guided workspaces are all well 
and good but if you really want to understand more 
about digital manipulation, then it's time to fire up the 
Expert workspace and dive in. There's an old saying: 
'the best way to learn, is to do'. With that in mind, let's 
do it!
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Sky
Replacement

Blue skies are wonderful. They mean we are having a lovely sunny day. This is particularly 
meaningful if you live in the UK, which is often the butt of jokes about its horrible weather. 

No better time then to get out and take some photographs. The only problem you may find if 
you’re anything like us, is that landscapes shot on days like this can look a little dull. The light is 
great, but the sky is lacking in any drama and it’s just a big, blue, empty canvas. Sometimes the 
sky is lovely but it’s in the wrong part of the image in relation to the landscape you were trying 
to shoot. Well, there is an answer to your woes with sky swapping. It requires your primary photo 
and a photo of a cloudy sky.

BEFORE AFTER
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To begin you will need your primary photograph. Go to File 
> Open (Cmd + O) and use the file browser to navigate to 

the location your photo is stored. You can double-click the image 
to open it or highlight it and then click on the Open button in the 
lower right of the browser window.

1 Our example is a shoreline image taken on a beautiful blue 
sky day. Unfortunately, that blue sky just looks a bit empty 

and is in need of a little attention to make it more appealing. 
All the trees and rock details below make the image look a bit 
bottom-heavy. Some clouds should help.

2

The first thing that will need your attention though is the 
horizon. In the case of this shot, the camera was tilted 

slightly and it means the horizon is not on the level. Luckily, there 
is a tool that can help us sort this out with just a few clicks.

3 Go to the toolbar and in the Modify section and then click 
on the Straighten Tool (P) to make it active. When you do 

this, the options panel at the bottom of the screen will display 
all of the available parameters and options available for that 
particular chosen tool.

4

When the image is straightened, you can choose how the 
crop is dealt with once the photo is rotated. You don't want 

to lose too much of the photo so choose the Grow or Shrink 
Canvas to Fit option. This way, it won't matter how much the 
image rotates, it will not be cropped.

5 Since rotating the mage will create blank areas at the 
edges of the photo, you can also select the Autofill Edges 

option. This uses the Content Aware Fill technology to analyse 
the nearest textures at the edges and fill in the blanks using 
cloned texture.

6
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Now you can actually straighten that horizon out. Take the 
Straighten Tool and click and drag a line across a tilted 

area that you know has to be level. In the back of this photo is a 
shoreline which can be used as a guide. Drag along it from left 
to right.

7 When you let go of the mouse, the Straighten Tool rotates 
the image enough to level out the shoreline. The entire 

image rotated about 6°, which has created blank areas as the 
canvas expanded to make sure the photo was not cropped.

8

When you choose to Autofill the edges, the blank areas are 
now analysed and then filled with similar textures. Because 

of the random fractal nature of the trees, rocks and sea, the filled 
areas match very well, with no obvious cloning errors to be seen.

9 If you click on the layer thumbnail for the photo, you can 
rename it. We called ours 'shore'. Now the image is ready 

for its blue sky makeover. Go to File > Open (Cmd + O) once 
again and navigate to the folder where your cloud replacement 
photo is kept.

10

Our example clouds were chosen because they are lit in a 
similar way to the primary photo at roughly the same time 

of day. This is an important consideration since you want the 
clouds to look as if they belong in the shot; otherwise the effect 
is going to look very odd.

11 Double-click the 'clouds' image to open it. Since you only 
need the clouds, you can selectively choose just that area 

to add to the primary photo. Go to the toolbar and choose the 
Rectangular Marquee Tool (M). You can use this tool to drag a 
selection box from the top left corner to the right horizon.

12
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When you let go of the mouse the selection you drew 
will become active with black and white dashes known 

as 'marching ants'. With the selection active, go to Edit > Copy 
(Cmd + C) to copy the selected sky area to the clipboard ready 
to use in your photo.

13 Click on the document tab of your primary photo to make 
it active and go to Edit > Paste (Cmd + V) to paste the 

copied clouds onto the current photo. It will automatically appear 
centred on its own layer so as not to destroy the shoreline photo 
below it. By default the new layer is called 'Layer 1'.

14

Go to the toolbar and choose the Move Tool (V). You can 
use this to physically click and drag the clouds into the top 

left corner of the photo and set about making it the right size to 
match the dimensions of the primary photo.

15 You will see that an active layer element will have control 
points around its perimeter. You can click and drag these 

control points in order to scale the clouds to fit the new photo. 
In this example, clicking and dragging the far right centre control 
point to the edge of the photo.

16

You can rename 'Layer 1' as 'clouds'. Now click on the little 
eye icon to the left of the 'clouds' layer thumbnail. This will 

make it invisible for the moment. You need to work on the 'shore' 
layer, so click its thumbnail to make it active.

17 Go to the toolbar and choose the Quick Selection Tool 
(A). You need to use it to make a selection of the sky area. 

With the Quick Selection Tool active, you will see various options 
available in the tool options panel at the bottom of the screen. 
Choose a brush size of about 50 pixels.

18
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Use the Quick Selection Tool to start selecting just the blue 
sky. Drag the cursor over all blue areas, avoiding all others, 

and it will automatically select as you go. Because the tree line 
is of a different colour and hard-edged, the selection tool has no 
real difficulty in choosing just the sky.

19 With all of the sky selected, you can now use the Refine 
Edge tool to make the selection even more accurate. Click 

the refine Edge button in the tool options panel to open the 
Refine Edge dialog panel. In this case, the default Edge Detection 
and Adjust Edge settings will be fine.

20

Simply start to brush over the areas where the sky meets 
the horizon line and trees. The Refine Edge tool will make 

more accurate, targeted refinements, particularly around the tree 
areas. If you are happy that the selection is as good as it can be, 
you can click OK to proceed.

21 The selection edge will be refined, ready for the next step. 
Click the 'clouds' layer visibility icon to make it visible 

again and you will see the selection, denoted by 'marching ants', 
overlaid on the clouds. Keep the selection active and make sure 
the 'clouds' layer is also active.

22

Click on the Add Layer Mask button in the layer options 
panel and a layer mask will automatically be added to the 

'clouds' layer in the shape of the active selection. Anything inside 
the selection is white, anything outside the selection is black.

23 When you Alt + left-click on the layer mask thumbnail, you 
can view the mask on its own in black and white. You can 

see how the Refine Edge Tool has quite accurately masked the 
trees and horizon. You can Alt + left-click the layer mask again to 
return to the normal view.

24
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With masks, the rule of thumb to keep in mind is that white 
reveals part of a masked image, whereas black will conceal 

areas of your photo. In this case, the clouds are allowed to be 
visible but anything below the trees is hidden by the black areas 
of the mask. 

25 It would be good if the sky was just a little darker to match 
the exposure of the primary photo. Keep the 'clouds' layer 

active and click the Create New Fill or Adjustment Layer. Select 
Levels from the menu that appears. A 'Levels 1' adjustment layer 
will be added above the 'clouds' layer.

26

Right-click the 'Levels 1' adjustment layer and choose 
Create Clipping Mask from the context menu that appears. 

This will clip the adjustment layer to the 'clouds' layer which is 
directly below it in the stack. Any adjustments made will only 
affect the 'clouds' layer and nothing else.

27 A small box with an arrow will appear to the left of the 
adjustment layer thumbnail to indicate it has been clipped 

to the layer below. A Levels dialog panel will open automatically, 
ready for you to make adjustments to the clouds.

28

The sliders in the Levels panel allow you to darken and 
lighten the Shadows, Midtones and Highlight areas of the 

photo. Dragging the Midtones slider to the right slightly will 
darken the sky. You can experiment with all the sliders until you 
have something you like.

29 With that, your sky replacement is complete; you can go to 
File > Save As and save your layered document as a PSD 

file. This will keep all your edits intact should you ever want to 
revisit this image and make more amends to it.

30
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Frequency 
Separation

Thanks to digital technology you can be a makeup artist and control exactly how you want 
your subject to look. Naturally, there are numerous ways you can go about retouching 

skin. Some techniques are very simple but do not give natural results. Some people take it to 
extremes and end up with their models looking like mannequins. All we are looking to do is 
make our model’s skin look as healthy and glowing as possible. We are going to use a technique 
called frequency separation. Simply put, you break the base image down into two components. 
One layer carries just colour and tonal information, the other layer holds detail and texture. This 
means you can work on one, without affecting the other. It’s a simple and effective method.

BEFORE AFTER
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Our example is from a portrait shoot of a young girl called 
Courtney. Open the photo in Elements as a new document. 

Courtney has some makeup applied but she had some spots that 
the makeup couldn't obscure so we are going to improve her 
complexion by removing the blemishes from her forehead. 

1 Click the 'Background' layer to make sure it is active; it will 
highlight in blue to let you know it is selected. Then press 

Cmd + J to create a duplicate layer. Name this layer 'colour'. 
Highlight the 'colour' layer then press Cmd + J once more to 
create yet another layer which you can name 'texture'.

2

Make sure the 'texture' layer is now highlighted and press 
Cmd + J one more time to create a layer that will be called 

'texture copy'. These are all the layers you need to begin creating 
your two main layers of texture and colour to edit.

3 Make 'texture copy' and 'texture' invisible for the moment 
by clicking on their visibility icons to hide them. Make the 

'colour' layer active. What you are going to do is turn this layer 
into colour data only. To do that you need to blur this layer to 
remove any obvious detail.

4
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Go to Filter > Blur > Gaussian Blur to call up the blur dialog 
panel. Set the blur Radius to about 10 pixels. You have to 

apply just enough blur to remove any hard details but leave the 
general shape and colour intact. Do not over blur the image and 
merge colours together too much.

5 Make all the other layers visible again and make the 'texture 
copy' layer at the top of the layer stack active. You need to 

apply the same blur amount to this layer. Go to Filter and the top 
menu item will be the last effect you applied. You can also press 
Cmd + F to apply the last filter you used.

6

The 'texture copy' layer is blurred to the same degree as 
the 'colour' layer. You can use this layer and the un-blurred 

'texture' layer below it to create the second component needed 
for the skin retouch. To do this, go to Filter > Adjustments > 
Invert (Cmd + I) to invert the 'texture copy' layer colours.

7 All the colours of the 'texture copy' layer will be inverted 
like a colour negative. With the 'texture copy' layer still 

active, move the Opacity slider down to 50%. What you see now 
is a combination of the 'texture' layer below and the current layer 
at 50% opacity. These two layers need to be merged.

8
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Hold the Shift key and click on the 'texture' and 'texture 
copy' layers to select them both, then right-click them to 

call up the context menu. Choose Merge Layers to merge them 
into one layer. You can rename this layer 'texture' now that it is 
ready to use.

9 Next, keeping the new 'texture' layer active, go to the Blend 
Mode button and choose Linear Light from the dropdown 

list that appears. This will blend the 'texture' layer into the 'colour' 
layer below and the result of the two should look identical to the 
original image.

10

You now have your two components. The top 'texture layer 
is detail only with no colour data and the 'colour' layer is 

only colour information with no real detail. This is the process 
of frequency separation in action. Editing is much simpler now 
colour and detail are separated from each other.

11 Click on the 'texture' layer to make it active. Texture will be 
your first stop for cleaning up the skin. Go to the toolbar 

and choose the Clone Stamp Tool (S). When you click on it, 
you will see various options become available down in the tool 
options panel.

12
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Go to the brush picker and choose a hard round brush. You 
can alter its size later. Hard brushes generally work better 

for the kind of cloning of skin we are about to do. You can use 
the Size slider to set a brush of about 25 pixels. To begin with, 
keep the Aligned box unchecked and Mode kept as Normal.

13 Now the process of cleaning the skin can start. Place your 
cursor over an area of skin that is clean and unblemished 

close to the first area you wish to start retouching. Press the Alt 
key and a small target cursor will appear. Left-click the cursor 
over the clean skin to set that as your clone source.

14

Now you can move your cursor over the nearest area of 
blemished skin you want to retouch. You should see a 

realtime representation of the clone source at the cursor position. 
When you click over a blemish, the clean source area will be 
'stamped' over the blemish.

15 Now you can carefully begin to clone clean skin over the 
blemishes on her face. You can always press Alt and choose 

a new area of clean skin as your clone source if the texture 
changes too much and needs to be updated. Remember that all 
these edits are only happening on the 'texture' layer.

16

Take you time with this part of the process. Keep changing 
your clone source to avoid the build up of repeating 

patterns that give the game away as to the use of cloning. You 
can use the Size slider to make the brush larger or smaller if 
needed as well.

17 Once you are happy that her forehead is done, you can 
make amends to any other areas of her face and neck that 

might cleaning up. You can remove wrinkles in exactly the same 
way by cloning clean skin over them. Stray hairs can also be 
cleaned up as well.

18
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Now that the 'texture' layer is completed and her skin is 
looking flawless, you can turn your attention to the 'colour' 

layer and even out any mottling that may be present. This is 
an optional step, but it does give the portrait that extra level of 
professionalism and is very flattering.

19 Make the 'texture' layer invisible and make the 'colour' layer 
active. Go to the toolbar and choose the Lasso Tool (L). The 

Lasso optional panel will show you various options available for 
this tool. Go to the Feather slider and set it to about 35 pixels to 
soften the selection you are about to make.

20

There is a small amount of mottling visible on her forehead 
which we want to remove, as well as softening the shadows 

around her left cheek, nose and chin. Draw around the areas you 
want to soften with the Lasso Tool. Join up to your start point 
and the selection will be closed and softened by 35 pixels.

21 Press the Shift key or click the Add button in the options 
panel to add more selections. An area around her left cheek 

has also been included and again, softened by 35 pixels to avoid 
any hard edges to the colour. Keep this selection active for the 
next part.

22

Go to the menu and choose Filter > Blur > Guassian Blur to 
call up the blur dialog panel. Set the Blur ratio to about 30 

pixels or however much you feel is needed to blur those areas a 
sufficient amount, to remove any mottling from her face. Click 
OK to blur the selected parts of the image.

23 If you want, you can also do the same to the highlighted 
areas of her right cheek to give more of a matt finish to her 

skin. It behaves a bit like adding more digital makeup foundation 
to her skin. When you are happy, you can go to File > Save As 
(Shift + Cmd + S) to save your finished result. 

24
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Composite
Images

Compositing is the combining of visual elements from separate sources into single images, 
often to create the illusion that all those elements are part of the same scene. In this tutorial 

we will be looking at a fairly typical approach for the two main elements of the image which is 
the grey/neutral background compositing technique. Shooting your main subject against a grey 
screen gives them a well defined edge that makes the process of blending them into another 
environment all the easier. Grey screen compositing is the choice of many graphics professionals 
and is easier to do than you might think. We have a scenario in which we have a photo of a cellist 
and want to put them into a much grander environment than just a grey background. 

BEFORE AFTER
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Go to File > Open and navigate to where the components 
for the scene are stored. In this example, we have our cellist 

image and a rendered scene to put her into. Highlight your  
images and click Open to create two new documents in Elements.

1 We have 'cello.jpg' and room.jpg'. You will see that the 
cellist is on a grey background. All the lighting gear 

and extraneous items present in the shot have been cloned 
out leaving just her and a plain grey background. The grey 
background is a key part of this process.

2

The other image we will be working with is a 3D render of 
a baroque ballroom. There is a perfect spot upon which the 

cellist can be placed. Now, you have the two images that will be 
combined. You wil see that it is not done in the conventional way 
that you might imagine but is very effective nonetheless.

3 For the moment, return to the 'cello' document and click on 
the layer lock icon next to the layer thumbnail to unlock the 

layer. Go to the 'room' image and do the same. Press Cmd + A to 
select all pixels on that layer and then press Cmd + C to copy the 
'room' image, or go to Edit > Copy.

4
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Go to the 'cello' document and go to Edit > Paste or press 
Cmd + V to paste the copied room image into the 'cello' 

document. It will appear on its own layer above the 'cello' layer. 
You can name this new layer 'room'. For the moment, click the 
visibility icon of the 'room' layer to make it invisible.

5 Click the 'cello' layer to make it active. You need to make 
a selection of her outline to start the compositing process. 

Go to the toolbar and select the Magic Wand Tool (A). Although 
the Magic Wand is a fairly simplistic selection method, it actually 
works really well in these situations.

6

Set the Magic Wand Tolerance to about 35 and make sure 
the Contiguous button is checked. Position the cursor over 

the grey background surrounding the cellist and left-click. The 
Magic Wand will select as much grey as the Tolerance setting 
dictates. Now we need to add the parts it missed.

7 Click the Add To Selection button and a small plus symbol 
will appear on your cursor to indicate anything selected will 

be added to the currently active selection. Now you can click and 
add more grey areas until all the grey is selected.

8
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Make the 'room' layer visible and active again. You will see 
the selection you just made overlaid on the image as a 

series of black and white dashes known as 'marching ants'. This 
selection can be used to create a mask in the next step.

9 Go to the layer options panel and click on the Add Layer 
Mask button. When you do, a mask in the shape of the 

selection will be added to the 'room' layer. Anything within the 
bounds of the selection will be white and anything outside the 
bounds will be black. White reveals and black conceals.

10

You might notice that the cellist looks a little too much 
like a cut out figure. You can remedy that by changing 

the Blend Mode of the 'room' layer to Overlay. This blends the 
pixels of the 'room' layer into the 'cello' layer. Only the cellist is 
unaffected by the blend because of the mask on the layer above.

11 Any area of the neutral grey 'cello' background that is 
blended with the 'room' layer makes no visual difference 

but any parts of the grey background darker than about 50% 
grey show up. This is great since the cellist's shadow now 
appears on the ground.

12
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Now we can begin to make the whole image more 
cohesive. With the 'room' layer active go to the layers 

palette and click on the Create New Layer button. Call this new 
layer 'mist'. We are going to add a subtle atmosphere behind the 
figure which is a popular thing to do in images like this.

13 Keep the 'mist' layer active and go to the toolbar and 
choose the Brush Tool (B). In the tool options panel at the 

bottom of the screen, choose a large soft brush of about 700 
pixels. Keep its opacity at 100%. Make sure the foreground colour 
is white.

14

Take the brush and paint white on the 'mist' layer around 
the upper part of the cellist's outline. You will be painting 

over your foreground figure of course but we can actually use 
the mask on the 'room' layer below to help us remedy the issue.

15 Right-click the 'mist' layer and choose the Create Clipping 
Mask option from the dropdown menu that appears. When 

you clip the 'mist' layer to the 'room' layer, it inherits the mask 
as well. Suddenly, the mist is appearing behind the cellist even 
though it is on the layer above.

16
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The 'mist' layer will now have small arrow icon next to its 
thumbnail to indicate it is clipped to the layer below. At the 

moment the white brush strokes look way over the top. Reduce 
the Opacity to about 40% and add Gaussian Blur to the mist to 
soften it if you want as well.

17 Next you can add some subtle lighting effects to the 
candles and windows for a moody feel. Create a new layer 

and name it 'candles'. Make sure it is at the top of layer stack and 
active. Go to the toolbar and choose the Brush Tool (B) again if 
not still selected.

18

In the tool options panel, chose a soft brush, click on the 
Brush Settings button and change the Roundness setting 

to 50% and the Angle to -90°. This will make the brush oval 
rather than circular. Set the Size to about 400 pixels and ensure 
that the foreground colour is still white.

19 Start to dab your white oval brush over each candle flame 
in the scene. You can use the Size slider to alter the size 

to match the candle sizes that are dotted around the scene. 
Although the brush strokes are currently white, you can use 
Blend Modes to get a nice glow on those candles.

20
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With the 'candles' layer still active go to the blend Mode 
button and choose Linear Light from the dropdown list that 

appears. There will be no apparent change at the moment but 
the next step will create a cosy glow for the candle flames.

21 Go to Enhance > Adjust Colour > Adjust Hue/Saturation 
(Cmd + U) to call up the Hue/Saturation dialog panel. First, 

make sure the Colorize button is checked. Then set Hue to 15, 
Saturation to 49 and Lightness to -20. This colours the white 
brush strokes orange and blends them into the layers below.

22

You can do a similar technique with the windows. Create a 
new layer called 'windows' and use your oval white brush 

to paint large dabs of white on the three main windows. You can 
use the Size slider again to adjust brush size to match the size of 
each window.

23 Now set the Blend Mode of the 'windows' layer to Overlay, 
then go to Enhance > Adjust Colour > Adjust Hue/

Saturation (Cmd + U) again and click the Colorize button so it is 
checked. Make Hue 40, Saturation 70 and Lightness -20 to add a 
warm glow to the windows.

24

Now, you can add colour effects to tie the foreground and 
background elements together. Go to the layer options 

panel and click the Create New Fill Or Adjustment Layer button. 
Choose Hue/Saturation from the dropdown list that appears.

25 A 'Hue/Saturation 1' adjustment layer will be added to the 
top of the layer stack. All the layers below it will be affected 

by what adjustments are made. A dialog panel will open and go 
to Saturation and choose a value of about -30 to desaturate the 
whole image slightly.

26
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Next, go to the layer options panel again and choose 
Create New Fill or Adjustment Layer again and this time 

select Photo Filter from the list. 'Photo Filter 1' will be added to 
the top of the stack. You are going to add a colour cast to tie the 
various elements together a bit more.

27 The Photo Filter dialogue panel will open when you add 
the adjustment layer. Set Filter to Warming Filter (85), 

Density to 100% and make sure the Preserve Luminosity button 
is not checked. The whole image will look dark orange now but 
not to worry.

28

Set the blend Mode for the 'Photo Filter 1' layer to Overlay. 
This makes the image very contrasty but if you set the 

layer's Opacity to about 20%, the effect is much more subtle. 
You can deepen the colour effect even more. Press Cmd + J to 
duplicate the 'Photo Filter 1' layer. Rename it 'Photo Filter 2'.

29 Change its parameters by choosing Deep Emerald as the 
Filter type. Density is 100% and now check the Preserve 

Luminosity box to maintain image brightness. Set this new layer 
to 20% Opacity as well to create a moody image where all the 
colours look more harmonious.

30

You can adjust the brightness by adding another 
adjustment. Use a Levels adjustment layer and adjust the 

Midtone and Highlight sliders to brighten the middle tones and 
highlights a little. You can also alter the Shadow Output Levels to 
about 12 to change the darkest colours to slightly lighter ones.

31 Your composite is complete. You can now go to File > Save 
As (Shift + Cmd + S) and save it as a named PSD file. This 

saves the layered document so you can return to it at any time 
and make amendments to the image.

32
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Dodging 
and Burning

BEFORE AFTER

Dodging and burning have their roots in the days of analogue photography, long before 
digital cameras and computers were in use. Dodging refers to the technique of lightening an 

image at the darkroom stage by reducing the exposure of a photographic print in specific areas. 
Burning is the opposite, where parts of the image are exposed for longer onto the print, making 
those areas darker. With the advent of digital technology the process is done on a computer but 
the basic principle and its terminology remain the same. In our example we had a basic image 
that was lacking in contrast; using the dodge and burn techniques, brightness and contrast was 
selectively added to produce a much stronger image.
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Begin by opening a relevant image to work on. Go to File > 
Open (Cmd + O) and navigate to the location of the image 

you wish to work on. Our example is a portrait named 'dodge 
and burn.jpg'. Double-click it to open or select it and press Open 
at the bottom of the browser window.

1 The image were are using as our example is a moody 
portrait but it is quite low in contrast. You could use levels 

adjustments or brightness and contrast, but they are quite global 
amends. Using Dodge and Burn Tools you can be much more 
selective in your approach.

2

It's good procedure to work on a duplicate of your image 
rather than your original. You never know when you might 

need to call upon it. It's better to have it and not need it, than 
need it and not have it.

3 Right-click your 'Background' base layer and choose 
Duplicate Layer from the menu that appears. The Duplicate 

Layer dialog panel opens and you can choose a name for your 
new layer and then click OK at the top right of the panel. A new 
duplicate layer called 'base' is created for you.

4

You can use a great little non-destructive method, as we 
did, for applying Dodge and Burn effects to your image 

without altering its pixel data. Make sure the 'base' layer is active 
and then go to the layer options panel and click the Create A 
New Layer button. Name this new layer 'dodge'.

5 Go to Edit > Fill Layer to open the Fill Layer panel. Rather 
than selecting the dual options of Foreground Colour or 

Background Colour, choose 50% Grey as the fill option. The 
reason for this will become apparent in the following steps. The 
'dodge' layer is filled grey, obscuring the portrait for the moment.

6
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Keep the 'dodge' layer active and go to the Blend Mode 
button and choose Overlay as the blend. Because the grey 

is 50% neutral it will not be visible using Overlay as the blending 
mode. Anything lighter or darker will have an effect on the layer 
below. This is key to the non-destructive method.

7 We needed a second layer just like the 'dodge' layer and 
could have just pressed Cmd + J to duplicate it but we 

wanted to show you another method of creating the 50% grey 
layer with the blend mode applied and ready to go.

8

Go to Layer > New > Layer (Shift + Cmd + N). The New 
Layer panel will open. Under Name, call the layer 'burn'. 

Keep Colour as None and under the Mode button, choose 
Overlay as the Blend Mode. Then make sure the Fill with Overlay-
Neutral colour button is checked.

9 A new layer called 'burn' will be created for you that is 
already filled with 50% grey and set to the Overlay Blend 

Mode. You now have the two layers needed to start Dodging, 
to make the picture lighter and Burning, to make areas of the 
picture darker.

10

Begin by making the 'dodge' layer active. It will highlight in 
blue to confirm it is active. Go to the toolbar and choose 

the Dodge Tool (O). The tool options panel will show you the 
available parameters you can apply to the Dodge Tool.

11 Under Range, choose the Midtones Painting Mode and 
under the Brush picker, choose a soft brush of about 200 

pixels. You can use the Size slider at any time to alter the brush 
size if required and also use the bracket keys [ and ] to scale the 
brush. Set the brush Exposure to 10% or less.

12
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You can now begin to lighten specific parts of the portrait. 
It will be a subjective thing depending on your preferences 

but areas that are currently the lightest can be made lighter to 
begin to increase contrast. Start brushing over areas like the 
forehead, cheeks and nose.

13 With each individual stroke of the brush, those light areas 
will be made lighter and lighter. Using an Exposure of 10% 

or less means that you can be a bit more subtle and build up the 
lightening effect gradually rather than applying it all at once.

14

Continue to build up the brightness with your brush strokes 
on the 'dodge' layer. Work around the beard, hair and 

eyebrows to increase the brightness. If you feel you've applied 
too many brush strokes in one area, you can always press Cmd + 
Z to undo a number of steps and try again.

15 If you press Alt and click the 'dodge' layer thumbnail, you 
can see exactly what is happening on that layer. Any part of 

the image that is lighter than 50% grey has its brightness added 
to the layer below because of the blending method used. Alt + 
click again to return to the normal view.

16

Once an area of the layer is dodged to pure white, it cannot 
get any brighter. However, if you feel the effect still isn't 

strong enough, you can always duplicate the layer for a more 
intense effect and adjust the layer opacity if required.

17 If you compare the dodged version of the portrait to the 
original you can see how the brightness has been focussed 

on, making the face more three dimensional with the addition 
of those brightened skin areas. If you are happy with the dodge 
effects so far, you can turn your attention to the 'burn' layer.

18
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Click the 'burn' layer to make it active and swap from 
the Dodge Tool to the Burn Tool by either pressing O 

until the Burn Tool is highlighted or click on its icon in the tool 
options panel.

19 Just as with the Dodge Tool, choose Midtones as the 
Painting Mode by clicking on the Range button. Keep the 

brush as a large soft one and Exposure at 10% or lower.

20

Start to add brush strokes on the 'burn' layer to the darker 
areas of the photo. We started around the eyes and 

darkened the sides of his forehead, under the nose and the sides 
of the cheeks. Again, apply the brush strokes singly and build up 
the darker areas until you have it as you want it.

21 If you Alt and click the 'burn' layer, you can view that layer 
in isolation. Now, any dodged area that is darker than 50% 

grey is added to the layers below, darkening the portrait. Alt + 
click again to return to the normal view.

22

Because you are working on separate layers, you can 
return to the 'dodge' layer if you want, swap the Burn Tool 

for the Dodge Tool again and continue to brighten areas of the 
image to your taste. In the case of this image, we went back and 
brightened the eyes themselves.

23 If it looks like the 'burn' layer effect is too strong, you can 
always click on the layer Opacity slider and reduce that 

layer's opacity to about 70%. we also duplicated the 'dodge' layer 
and set the second layer to 25% opacity for little extra contrast 
to the brightest areas.

24
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The next few steps are optional and down to personal taste. 
Go to the layer options panel and click on the Create New 

Fill or Adjustment Layer button. Select Hue/Saturation from the 
menu that appears to set it as an adjustment layer above the 
layers already created.

25 We wanted to reduce the saturation of the image a little. 
When you add an adjustment  layer to the layer stack the 

properties panel for that layer will be displayed automatically. We 
used the Saturation slider to reduce saturation to about -35.

26

One additional tweak was to add a Levels adjustment and 
push the Highlights and Midtones sliders to the left; this 

helped boost contrast a little more and highlighted all the work 
already done with the Dodge and Burn Tools.

27 A side by side comparison now shows how much the image 
has been transformed with the use of targeted brightening 

of midtones and also selective darkening of certain areas to 
increase the overall contrast of the image that wasn't present in 
the original.

28

With that your Dodge and Burn project is completed. You 
have applied some very focussed brightness and contrast 

adjustments to bring out more detail and create a more dramatic 
looking image.

29 You can choose to flatten the image, by going to File > 
Save As (Shift + Cmd + S) to create a new file under a new 

name, or save the document in its layered form as a Photoshop 
compatible PSD file.

30
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How to Add 
Rain to a Photo

Rain is great, as long as you’re not caught out in it without your umbrella. It is certainly a 
favourite of cinema to add a more brooding feel to a shot. If you’ve ever seen films like Seven 

and the Ridley Scott sci-fi classic Blade Runner, you can see that rain is treated almost like a 
character in its own right. In this tutorial we are going to show you how you can make your own 
rain and take your images to a different level. We have an example shot of a dog looking very 
unimpressed by being out in wet conditions. The photo was taken during a lull in the rain, but 
perhaps the rain can be started up again, to make the dog even more grumpy.

BEFORE AFTER
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The process starts, as ever, by going to File > Open and 
navigating to where your image is kept. Highlight your 

image and press Open or double-click it to open it in Elements. 
Our example dog image opens up ready for a good downpour.

1 You will be creating two layers of rain. One will contain 
smaller drops which will appear to be further from the 

viewer. The second layer will be much closer to the viewer and 
be blurred. To begin, go to the layer options panel and click on 
Create A New Layer.

2

A new layer will be added above the main image on the 
'Background' layer. Name this new layer 'sharp'. You can 

use this layer to add the first of the rain effects by creating small, 
sharp, drops. Make sure the 'sharp' layer is active.

3 Go to Edit > Fill Layer to open the fill option panel. In the 
Use section, choose Black as the fill colour. Make sure 

Blending Mode is Normal, Opacity is 100% and that the Preserve 
Transparency box is unticked. The 'sharp' layer will be filled solid 
black, obscuring the dog for a moment.

4
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Now you need to create some raindrops. Go to Filter > 
Noise > Add Noise to open the Add Noise panel. You have 

a couple of options to adjust to give you the correct kind of rain 
elements. First, you need to make the Amount 400%, which is 
the maximum Amount you can add.

5 By default, the Distribution value is set at Uniform. You need 
something a bit more random, so click the Gaussian button 

instead. You might notice that the noise has a lot of colour in it. 
We need to remove that by checking the Monochromatic button 
at the bottom of the panel. Click OK to proceed.

6

In order to create the rain particles, the noise on the 'sharp' 
layer needs to be blurred slightly. Go to Filter > Blur > Blur 

More. This adds a small, predefined amount of blur to the noise 
to soften it slightly.

7 The noise doesn't look very much like rain at the moment 
but if you go to the layer options panel and click on the 

Create New Fill Or Adjustment Layer and select Levels, you 
can adjust the contrast to make something that looks more like 
individual drops.

8
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A 'Levels 1' adjustment layer will be added. To make sure 
the adjustment only affects the 'sharp' layer, right click 

'levels 1' and choose Create Clipping Mask from the menu. This 
means the adjustment will only affect the layer below to which it 
is now clipped.

9 The Levels dialog panel will open when the layer is created. 
If you push the Shadows and Highlights sliders closer to 

each other, you will see the effect you're having on the noise in 
the 'sharp' layer. You need to adjust the sliders so the blurred 
noise separates out into small particles.

10

When you have the adjustment as you like it, click on the 
'sharp' layer to make it active and then go to the Blend 

Mode options button and choose Screen as the blend. When you 
do this, only areas that are brighter than 50% grey will be seen in 
the image.

11 You can continue to make further adjustments to the levels 
and when you are ready, press the shift key and click both 

the 'Levels 1' layer and the 'sharp' layer in order to select them 
both at once. Both layers should be highlighted in blue.

12
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Right-click on these selected layers and choose Merge 
Layers from the menu to merge them into one layer. When 

combined, the layer will default back to a Normal Blend Mode so 
you will need to go back in and change that back to the Screen 
Blend Mode again.

13 At the moment, the rain particles look a little small. You 
need to make them quite prominent so you can scale the 

contents of the 'sharp' layer. Go to Image > Transform > Free 
Transform (Cmd + T). This tool gives you various options for the 
scaling of the layer contents.

14

In the tool options panel, you will see the transform options. 
You just want to be able to scale it from its centre. Make 

sure the centre point of the Reference Point Location is clicked 
and in the width and height boxes enter a value of 200%. Press 
the green tick to commit the changes.

15 This will scale the contents of the 'sharp' layer by 200%, 
making the raindrops much more visible. At the moment 

though, they look like they are frozen in place. You need to be 
able to add a little movement to suggest actual rainfall.

16
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Go to Filter > Blur > Motion Blur to call up the dialog panel. 
Rather than the rain falling vertically, make the Angle about 

-56° and the Distance about 40 pixels. Smaller numbers mean 
the rain looks quite light and larger numbers give the impression 
of heavy rain falling quickly. Click OK when ready.

17 Keep the 'sharp' layer active and go to the layer options 
panel and choose Add Layer Mask to do just that. Click on 

the layer mask thumbnail (it will highlight with a blue border) and 
then go to Filter > Render > Clouds.

18

A mottled cloud-like pattern will be added to the layer 
mask. It is randomly comprised of black and white clouds. 

This random mask makes the rain appear a little more random 
too, since various areas are being concealed or revealed in 
differing intensities.

19 Keep the layer mask active and go to the toolbar and chose 
the Brush Tool (B). Set the foreground colour to black and 

the Size to about 800 pixels. Start to paint black on the layer 
mask over the dog and the immediate foreground to give the 
illusion that the rain is behind the dog.

20
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Now, you need the blurred rain for the foreground. 
With the 'sharp' layer active press Cmd + J to create a 

duplicate of that layer. Rename it 'blurred'. Right-click the layer 
mask and choose Delete Layer Mask as you won't need it for 
this layer.

21 Since this layer will need to appear even closer to the 
viewer, it needs to be scaled. Use the method you used 

with the first layer ands scale it another 200% from its centre and 
press the green tick to commit those changes when ready.

22

Make sure the 'blurred' layer is now active and go to Filter 
> Blur > Gaussian Blur to open the blur panel. You want to 

make the foreground rain look blurred like it is very close to the 
camera. Entering a Radius of about 7 pixels will blur just enough 
to create a sense of depth.

23 If the foreground rain looks a little too intrusive, you can 
always go to the Opacity slider and make its opacity about 

75% to lessen its visual impact. Now the dog really looks like he 
has something to be grumpy about. You could call that done but 
there's one little extra thing to do.

24
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We wanted to make the puddle directly under the dog look 
a little more like there was rain falling in it and used another 

image to help with that. After going to File > Open, we navigated 
to where a puddle image with ripples was stored and opened it 
in a document of its own.

25 Press Cmd + A to select all pixels of the ripples image and 
then press Cmd + C to copy it. Then go back to the main 

document and press Cmd + V to paste the copied pixels onto a 
new layer of its own.

26

You can press Cmd + T to use the Free Transform Tool to 
drag the puddles image control point around to make it fit 

over the puddle beneath the dog. You can compress the image 
vertically to help match the ripples to the perspective of the main 
image. Press the green tick to commit the changes.

27 At the moment the ripples of the second puddle image 
look very out of place. Go to the layer options panel and 

click Add Layer Mask to add a mask to the puddle image. Now 
go to the Blend Mode button and choose Screen from the menu. 
This blends the rippled puddle image into the layers below.

28

You can rename this new layer 'puddle'. Make sure the layer 
mask is active. Choose a large soft black brush and start to 

paint out areas where the rippled puddle should not be seen. The 
end result of the masking should look like the example shown.

29 If this additional effect looks a little too much for the 
image, you can always reduce the Opacity setting to about 

70%. Now the grumpy dog looks like he has been caught in the 
middle of a downpour and probably wants to get home to a 
nice warm fire.
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Active layer
The layer currently selected in the 
Layers panel.

Adjustment layer
A layer that lets you apply colour 
and tonal adjustments to your 
image without permanently 
changing pixel values. Use 
adjustment layers to experiment 
with colour and colour tones. You 
can think of an adjustment layer as 
a veil through which the underlying 
layers are seen.

Adobe Bridge
Bridge is a browser application 
produced by Adobe Systems as 
part of the Creative Suite and 
is usually installed alongside 
Photoshop. Its main function is as 
the file management hub of the 
Creative Suite. It can be used to 
open, manage, rate and rename 
files as well as edit their metadata.

Adobe RGB
The RGB colour space profile by 
Adobe Systems, Incorporated. It 
provides a large gamut of colours.

Aliasing
The jagged effect seen at the 
edges of diagonal lines, arcs and so 
on, caused by pixels lining up in a 
sawtooth pattern.

Alpha channels
These are masks which let you 
manipulate, isolate and protect 
specific parts of your images.

Anti-aliasing
The smoothing of jagged edges 
in digital images by averaging the 
colours of the pixels at a boundary.

Artefact
Any unexpected and undesired 
change to a digital image caused 
by incorrect settings or faulty 
processing. Examples include 
blooming, moire, sharpening and 
noise.

Aspect ratio
The ratio of an image’s width to its 
height. It is used to determine how 
an image fits on a page or monitor.

Background layer
The bottommost layer in an image, 
usually containing the image data. 
The Background layer is always 
locked. If you want to change its 
stacking order, blending mode or 
opacity, you must first convert it to 
a regular layer.

Backlight
Light coming from a source behind 
the photographed subject.

Batch processing
Performing one or more automated 
tasks to a selected group of files at 
the same time.

Glossary
For your reference, we have listed many of the terms you'll encounter 
as you become more experienced with photo editing.

Bit depth
The number of colours used to 
represent a pixel in an image. A 
1-bit image is black and white, an 
8-bit image can have 256 colours 
or shades of grey and a 16-bit 
image can have 65,536 colours.

Bitmap image
An image consisting of rows and 
columns of pixels in computer 
memory; also called a raster image. 
Bitmap file formats include BMP, 
GIF, JPEG, PSD, PICT and TIFF.

Bits per channel
Determines how many tones each 
colour channel can contain.

Black Point
In image editing, the black point 
is a tonal adjustment that sets the 
point at which the deepest shadow 
detail in the histogram is clipped 
to black.

Blending mode
A feature that controls how pixels 
in an image are affected by a 
painting or editing tool. The blend 
colour is applied to the base colour 
to produce a new colour, the result 
colour. When applied to layers, a 
blending mode determines how the 
pixels in a layer blend with pixels in 
layers beneath it.

Brush preset
A brush with preset settings 
for size, thickness and so on. 
Photoshop includes several brush 
presets for you to choose from and 
you can create a large number of 
your own presets as well.

Burning
The selective darkening of part of 
an image.

Camera raw format
A format describing data exactly as 
it is captured by a camera sensor, 
with no in-camera processing 
applied.

Canvas
The workspace around an existing 
image, within the image window. 
Layer data may lie outside the 
canvas but it will be clipped to the 
canvas when the image is flattened. 
You can change the size and colour 
of the canvas.

Channel
A term for describing the colour 
data in an image. A black and white 
greyscale image has one channel, 
an RGB image has three and a 
CMYK image has four. Ordinarily, 
a channel describes either red, 
green or blue, which are blended to 
create all colours.

Clarity
Found in Adobe Camera Raw. It 
behaves like an intelligent version 

of Contrast and only alters contrast 
within the middle tones of your 
image.

Clipboard
The temporary holding area for 
data stored with the Cut or Copy 
commands.

Clipping
The loss of either highlight 
or shadow details when tone 
information is forced to pure white 
or black. 

Clone
To paint with the Clone Stamp tool. 
You must set a sampling point on 
the active layer before you paint with 
the Clone Stamp tool.

CMYK
Cyan, magenta, yellow and black 
are the inks most printers use to 
produce colour images. Photoshop 
includes full support for CMYK 
mode.

Colour cast
An unwanted or unexpected colour 
shift in a photo. For example, a 
photo taken indoors without a 
camera flash may have too much 
yellow.

Colour channels
The component colours from which 
all colours in an image are created. 
Usually refers to red, green and blue 
(RGB).

Colour depth
Measures how much colour 
information is available to display or 
print each pixel in an image. Greater 
colour depth means more available 
colours and more accurate colour 
representation in the digital image.

Colour management
A system used to achieve consistent 
colour as an image travels from one 
device to another; for example, from 
camera to computer or computer to 
printer.

Colour temperature
The degree of heat, in degrees 
Kelvin, that an object would have to 
absorb before it glowed in a certain 
colour. Each colour is associated 
with a colour temperature, as are 
various kinds of light.

Compression
A technique that reduces the file size 
of bitmap images.

Cropping
Trimming a portion of an image to 
improve its composition or to create 
a frame around it.

Dithering
The approximation of an unavailable 
colour through the use of two or 
more available colours. 

DNG (Digital Negative)
An open standard file format 
developed by Adobe Systems that 
provides an alternative to proprietary 
camera raw files. 

Dodging
The selective lightening of any part 
of an image.

Dots per inch (dpi)
A measure of printer resolution. High 
dpi settings produce prints with fine 
detail. Used for monitors too.

Duotone
A two colour greyscale file that uses 
two custom inks.

EPS
Encapsulated PostScript. A file 
format used to save images that 
will be used in illustration and page 
layout programs.

EXIF
Exchangeable Image File Format. 
A standard for simplifying the 
exchange of data between cameras 
and software. The data may include 
camera model, date and time the 
photo was taken, camera settings, 
shutter speed and so on.

Exposure
A measure of the amount of 
light in which a photo was taken. 
Underexposed digital photos are too 
dark, overexposed ones, too light.

Feathering
The softening of an edge of a 
selection.

File Format
The structure of how information 
is encoded in a computer file. File 
formats are designed to store 
specific types of information, such as 
JPEG and TIFF for image or raster 
data, AI for vector data and PDF for 
document exchange.

Fill layer
A type of layer that contains a solid 
colour, a pattern or a gradient as an 
interchangeable attribute.

Filters
Use filters to clean up or retouch 
your photos and apply special 
art effects that give your image a 
different appearance

Flattening
Merging of all visible layers into the 
Background layer to reduce file size.

Font
A set of letters, numbers

Gamut
The range of colour that a device 
can reproduce.

Gaussian blur
A softening effect applied through 
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a bell-shaped distribution of tones 
and colours.

Gradient
Any of several methods for 
achieving a smooth transition 
between two adjacent colours, 
which also include black and white.

Greyscale
A single channel image that 
includes only black, white and 
shades of grey. Depending on the 
bit depth, greyscale images can 
reproduce a number of shades of 
grey.

Halftone
A monochrome image made up of 
variably sized dots simulating the 
shades of grey in a photograph. It is 
used for reproducing photographs 
on PostScript printers and printing 
presses.

HDR (High Dynamic Range)
A process that combines multiple 
exposure variations of an image to 
achieve a dynamic range exceeding 
that of a single exposure. 

Highlight and shadow
The lightest and darkest colours in 
an image.

Histogram
A bar chart showing the 
distribution of the pixel values in a 
digital image. The horizontal axis 
represents levels from 0 (darkest) 
to lightest (255) and the vertical 
axis represents the numbers of 
pixels at each level.

Hue
The colour reflected from or 
transmitted through an object. 
In common use, hue is the 
property that allows a colour to be 
distinguished as red, blue, yellow 
and so on.

ICC
International Colour Consortium. 
ICC device profiles are the industry 
standard for reproducing colours 
accurately across devices such as 
scanners, monitors and printers.

Image cache
A section of hard disk space used 
as virtual memory. The image cache 
speeds the on-screen redraw of 
high-resolution images.

Image mode
The colour mode of an image, such 
as Greyscale or RGB.

Indexed colour
A colour that is rendered by using a 
pixel value as an index to a panel of 
256 or fewer colours.

JPEG
Joint Photographic Experts 
Group. A committee of experts 
that develop algorithms for 
compressing computer image files. 
Can be any graphic file to which a 
JPEG algorithm is applied. JPEG is 
the format generally used to share 
photographs over the web.

JPEG compression
A lossy compression technique that 
reduces image data and file size.

Layer
A mechanism for overlaying and 
combining multiple images. Layers 
are like transparent sheets of glass 
that you can stack and rearrange. 
In addition to ordinary image layers, 
there are special kinds of layers.

Layer group
A collection of layers saved with a 
Photoshop image.

Layer mask
A protected area in an adjustment 
layer. Areas below the mask cannot 
be edited.

Levels
Functionality for adjusting colour 
and tone. With a Levels adjustment, 
you can set shadow and highlight 
values to use a full tonal range, 
adjust middle tones only, correct 
colour casts, and so on.

Locked layer
A layer in the Layers panel that has 
the lock icon applied. No changes 
can be made to a locked layer. A 
Background layer is always locked.

Megapixel
A term used to describe digital 
camera resolution, 1 megapixel 
equals one million pixels.

Midtone
An area that falls between the 
brightest highlight and the darkest 
shadow.

Moire
A wavy striped pattern in an image, 
resembling the pattern of watered 
silk. Moire can be an artefact caused 
by a camera’s inability to capture the 
detail in an image.

Noise
An artefact caused by interference 
or camera error. Noise is often seen 
as stray pixels of unexpected colour 
or a generally “grainy” appearance. 
Certain compression techniques can 
amplify noise.

Opacity
The amount something blocks 
light. You can change the opacity 
of layers, filters and effects so that 
more (or less) of the underlying 
image shows through.

Overexposure
An overexposed image results from 
too much light being allowed to fall 
onto the camera sensor.

Panorama
A broad view of a subject, usually 
a landscape, made by overlapping 
individual shots as they are taken 
and then merging them to form one 
wide image.

Perspective
The angle or level from which a 
photograph is taken, the camera-eye 
view.

Pixel
The basic, rectangular unit of data 
that a digital image consists of. 
The edges of pixels can produce a 
sawtooth pattern unless anti-aliasing 
is used.

Pixel dimensions
The number of pixels along the 
width and height of an image. This is 
a measure of the amount of image 
data in the photo, not its physical 
size when printed or displayed on a 
monitor.

Pixels per inch (ppi)
A measure of image resolution 
stored in a camera or computer 
file. High ppi settings produce 
photographs with fine detail and 
large file size.

Plug-in
A software application or module 
that provides extended and specific 
functionality from within a larger 
host application.

PostScript
A language by Adobe that describes 
the appearance of text, graphic 

shapes and sampled images on 
printed or displayed pages.

Preset
A preset is an action that can be 
applied to an image or group of 
images. You save a group of editing 
settings such as colour balance, 
brightness, contrast and saturation, 
which can then be applied to your 
selected photos.

PSD
The native uncompressed file format 
of Adobe Photoshop and Photoshop 
Elements, based on the TIFF 
standard.

Quick mask
A mask channel created in Quick 
Mask mode in Photoshop

Raw Files
A Raw file is the unprocessed data 
captured by a digital camera sensor. 
In most cases, cameras write Raw 
files using a proprietary file format. 
Raw files give the photographer 
the advantage of managing image 
processing during post-production 
rather than letting the camera make 
the processing decisions, as happens 
when shooting in JPEG format.

Red eye
The reflection of the camera flash 
from the retina of a photographed 
subject, resulting in a red dot in the 
subject’s eye. You can eliminate 
it automatically when you import 
images or by using the Red Eye 
Removal tool.

Resample
To change the resolution of an image 
by changing its pixel dimensions. 
Downsampling decreases the 
number of pixels and upsampling 
increases the number of pixels.

Resolution
A measure of the clarity and 
sharpness of an image. In digital 
images, it is measured in pixels per 
inch.

RGB
A model for representing colours on 
a computer display. Red, green, and 
blue (RGB) are combined in different 
proportions to represent any colour.

Rule of Thirds
If you divide an image into three 
equal sections both vertically and 
horizontally, where the lines intersect 
is commonly regarded as good 
placement for the subjects in your 
photos.

Sample
To select a colour with the 
eyedropper in order to use it with a 
drawing or painting tool.

Saturation
The purity, or strength, of a colour. 
A fully saturated colour contains no 
grey at all. 

Selection
A part of an image selected for 
manipulation of any kind, duplication 
in a layer, colour correction, deletion, 
rotation and so on. 

Shadow Detail
Refers to the amount of detail that 
can be seen in the darkest areas of a 
photograph.

Sharpening
In photo-editing programs, any 
functionality that enhances the 
details at the edges of photographed 
objects and people. 

Skewing
Deviation of the content of an image 

from a vertical or horizontal axis. 
Skewing can be a camera effect or 
an intentionally applied effect.

Smoothing
A technique for averaging the values 
of neighbouring pixels to reduce 
contrast and create a soft, blurry 
effect.

Split Toning
This option lets you alter the colour 
of the shadow and highlight areas of 
your images. For example, you can 
add a blue colour cast to the darkest 
areas of your photo but make the 
brightest areas of the same image 
more orange.

Stroke
An outline round an image or part 
of an image, or the characteristics 
of the lines created with one of the 
painting or drawing tools, especially 
brushes.

Swatches
Preset colours that you can choose 
from in the Colour Swatches panel.

Thumbnail Image
A small, low resolution image 
preview used on the web to link to a 
high resolution version of the file. 

TIFF
Tagged Image File Format. A digital 
image format widely used for images 
that are to be printed or published. 
TIFF images can be compressed 
losslessly.

Transform
To scale, shrink, enlarge, skew, 
distort, rotate or change the 
perspective of a layer, selection or 
shape.

Transparency
In digital photography, the 
functionality that supports 
transparent areas in an image or 
image layer. Certain image formats 
do not support transparency.

Underexposure
An underexposed image results from 
too little light being allowed to fall 
onto the camera sensor.

Unsharp mask
A technique that sharpens details in 
an image by increasing the contrast 
between light and dark areas. The 
name originates from traditional 
photography, where contrast is 
increased by adding a slightly 
blurred negative over the original.

Vibrance
Vibrance is a form of intelligent 
Saturation. As you increase the 
Vibrance in an image, only the 
middle tones of your image are 
altered first.

Vignetting
An effect where the edges of an 
image fade out.

Warping
A distortion of an image, often text, 
to conform to a variety of shapes. 
For instance, a line of text can be 
warped in the shape of an arc or 
wave.

White balance
A function that compensates for 
the different rendering of identical 
colours under different sources of 
light: incandescent, fluorescent, 
sunlight and so on.

White point
A reference point used to represent 
white. This reference point is used 
to calculate all other colours in the 
image.
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